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New: 8600 support

FTP File Setting — refer to Appendix VI Creating a Script File

1.4 Color Properties (8600 only) added

2.4 Color Properties (8600 only) added

6.2 Font Properties — table and pictures added

6.3 Color Properties (8600 only) added

7.3 MobileLink removed

Appendix | Scan Engine and RFID Tag Supported tables updated
Appendix V Command Line Syntax — AG_Load added

Appendix IV Creating a Script File added

Modified: 3.3.1 — Description for “Show message when data is
matched” added

Modified: 7.3.7 — screenshot & related descriptions for “Add
Delimiter” and “Date Style” Ul items updated

Modified: Appendix V Command Line Syntax — Data_Read
arguments appended

Modified: Chapter 1 - Form1 screenshot updated
Modified: 1.2.4 Enable MSQL - screenshots updated
Modified: 1.3 Font Size — Font Size table updated
Modified: 1.8 Data Type — screenshot updated
Modified: 1.8.6 Real — screenshot updated

Modified: Chapter 2 — Menul screenshot updated
Modified: Chapter 6 — screenshot updated

Modified: 6.2 Font Properties — descriptions revised
Modified: 7.2.1 Data_Read — screenshot updated

New: “Appendix 111 LR/ZELR LASER SCAN ENGINE” — Symbology
Settings Table (8700) added

Modified: “Appendix 1V 2D Scan Engine” — “Convert UPC-A to
EAN-13” included in “1D Symbologies Table”

New: 1.8.20 Serial — “Data Type” added with “Serial” option
New: 1.14.1 Field Data — “Compare” checkbox added

New: 1.14 More — “Decimal symbol” pull-down menu added

New: 7.2.1 Data Read — pull-down menus for file selection added

Modified: 7.3 MobileLink — launching MobileLink as a Windows
service

Modified: FTP File Settings — Lookup file settings

New: Introduction | Using FTP Server to Transfer Files | WLAN
Security Settings — WPA/WPA2: If entered passphrase falls shorter
than 8 characters, a warning dialog pops up when OK button is hit to



3.10

3.01

3.00

2.28
2.27

2.26

2.25

Apr. 24, 2012

Feb. 07, 2012

Dec. 16, 2011

Jul. 19, 2011
Jun. 03, 2011

May 17, 2011

Mar. 21, 2011

submit changes.

New: 1.2.4. Enable MSQI — “TRACK” input screen can be removed
by adjusting key field properties.

New: 7.3.7. Change Data File Settings — File-naming rule with
new “separator” feature and file extension customization

MobileLink supports more communicative interfaces. Updates involved

are:
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Modified: Introduction | MobileLink Data Connection.
Modified: 7.3. MobileLink.

Modified: Section 2.5: The option “Save the collected data for each
form to separate data files” renamed to “Separate Each Data File
and Edit Form Name” on Menu property page.

Related update: Chapter 2 “Menu” property page screenshot

Modified: Section 5.2 “Function Key Setting”: Data collecting forms
aren’t supported by keypad shortcuts.

New: 8700 support

New: Introduction | Getting Started | Localization: Bundled font files
New: Introduction | “Title Bar”

New: “Data Type” supports date/time info. Updates involved are:
1.5 “Date & Time Stamp” updated

1.8.18 “Date” newly inserted.

1.8.19 “Time” newly inserted.

Modified: 5.1.5 “Upload Method”

8000, 8200, 8300 & 8400: The interface “Bluetooth SPP” is deleted
and replaced by “Bluetooth SPP_Master” and “Bluetooth SPP_Slave”.

Modified: 5.1.6 “Download Method”

8000, 8200, 8300 & 8400: The interface “Bluetooth SPP” is deleted
and replaced by “Bluetooth SPP_Master” and “Bluetooth SPP_Slave”.

Modified: 7.2.1 Data_Read.exe screenshot updated.
Modified: 7.2.1 [Options] updated.

Modified: 7.2.1 [Auto upload and delete Data and Lookup files]
updated.

Modified: 7.2.1 Data_Read — update screenshot and settings
Modified: add “Convert to 8200” feature for AG8300
Modified: 5.1.5 Upload Method — add “USB VCOM_CDC” for AG8200

Modified: 5.1.6 Download Method — add “USB VCOM_CDC” for
AG8200

Modified: Appendix IV — change Code 11 and MSI to “Disable” by
default

New: support 8200
Modified: Using FTP Server to Transfer Files — update screenshots
Modified: 7.3.7 Change Data File Settings — add log file settings

Modified: 7.3.8 Manage Devices & 7.3.9 Manage Your Rules —
update screenshots

Modified: Appendix I—~Il — support UPC-E1 for CCD/Laser

Modified: Appendix I—1l — support Coop 25 for CCD/Laser (8000/
8200/8300/8400)
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Modified: Appendix Il — add Aiming Duration (8000/8200/8300/
8400)

Modified: Appendix Ill — add Scan Mode options (8300 Only) and
Time-out

Modified: Appendix II—-1V — change Time-out range to 0—255 sec.

Modified: Appendix IlII—-IV — change Aiming Duration range to
1—-255 sec.

Modified: Appendix IV — change Codabar, Code 93 and MSI to
“Enable” by default

Modified: 1.8.16 Large Data — for collecting data via 2D scan engine
Modified: 1.8.17 Read from 2D

Modified: 7.1.3 ProgLoad — add support for command line

New: Appendix V Command Line Syntax (for utilities)

New: Introduction — add System Requirements

Modified: Introduction — Getting Started, add “Using MobileLink to
Transfer Files over Network”

Modified: 5.3 Security Setting
New: 7.3.8 Manage Devices
New: 7.3.9 Manage Rules

Modified: Introduction — Getting Started, add “Using FTP Server to
Transfer Files”

Modified: Introduction — Menu Bar, add “FTP Communication
Settings”, “WLAN Communication Settings” and “FTP File Settings”

Modified: 1.8.15 Counter

Modified: 7.3 Mobile Link — update screenshots
Modified: 7.3.3 View Link Status — 8000/8300 supports Auto Upload
Modified: 7.3.7 Change Data File Settings — update Auto File Name

Modified: Appendix Il — change Negative Barcode to “Enable” by
default

Modified: Getting Started, Upload Data — describe icons indicating
support of auto upload

Modified: 3.2.4 DBF File Location (8400 Only)

Modified: 3.8 Action When the Format of Record Is Wrong

New: 7 Utilities

Modified: 7.4 SD DBF Converter (8400 Only)

Modified: Appendix I—-1V — add more GS1 DataBar symbologies
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Jun. 26, 2008

Nov. 06, 2007
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Modified: Introduction — Getting Started, Menu Bar, Toolbar and
Menu Tree

Modified: Installing FORGE Application Generator — DATA_READ
utility also synchronizes date/time on every host connection.

Modified: Getting Started — (1) add Upload Application Template (2)
Download Lookup Files (file path changed to “\AG\DBF” for lookup
files)

Modified: Menu Bar — (1) DBF Converter (file path changed to
“NAG\DBF” for lookup files) (2) DATA_READ utility also synchronizes
date/time on every host connection.

Modified: 1.14.1 Field Data — Decimal Places
Modified: 1.2.4 Enable MSQI
Modified: 3.3.3 Trim Space When Lookup Data Can Be Uploaded

Modified: 5.1.6 Download Method — AG8400 (file path changed to
“NAG\DBF” for lookup files)

Modified: 5.2 Function Key Setting — update screenshot, etc.
Modified: 5.3.1 Upload .AGX — change 6-digit password to 5-digit
Modified: Appendix IV 2D Scan Engine — update

New: support 8400-2D

Modified: 5.1.5 Upload & Download Settings — Buzzer Volume
changed to LARGE_VOL

Modified: Appendix IV — Chinese 25, Matrix 25, Picklist Mode, 1D
Inverse, 2D Inverse, UPU FICS Postal and USPS 4CB/One Code/
Intelligent Mail

Modified: 3.2.4 “DBF File Location” and section 6.3.3 “DAT File
Location” features are added.

Modified: 5.1.5 — add DBF Converter, download and upload
information

Modified: “Convert to 8300” and other 8400 supported features are
added.

Modified: 8400 supported features are added.
Applied new GUI screen shots and modified the relative contents.

Modified: 6.3 — add “Use Large Font for Data Browsing” for AG8000
and AG8300

Modified: Appendix Il1—I11l support replacement of EAN-128 field
separator for all scan engines

Modified: 1.6 Record — add “remove from lookup” and “save &
remove” options

Modified: 3.11 Action When the Input Data Has No Match — add
“remove from lookup” and “save & remove” options

Modified: 4.1.2 RFID Reader — Automatically enabled after
initialization (checkbox removed from Ul)

New: Long Range Laser option available for 8300

Modified: 4.1.2 RFID Reader — RFID tags in proximity will be read
automatically by 8300/8500 when RFID reader is enabled

Modified: Features

New Word template applied

Company name changed to CIPHERLAB CO., LTD. since April 2006
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Modified:
Modified:
Modified:
Modified:

5.3 Barcode & Parameters

1.2.2 — Font_12x12 not supported
51&5.2.6

6.2,6.4&6.5

2.05 Apr. 10, 2006  AG for CPT-8500 is included
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INTRODUCTION

Easy-to-use and quick-to-apply, FORGE Batch Application Generator designed for
CipherLab 8-Series Mobile Computers (8000/8200/8300/8400/8500/8600/8700) enables
users to develop the custom templates that work with the AG runtime preloaded on the
mobile computers. Users are in the position to define their own application templates on
any desktop computer without writing any program code.

FORGE Batch Application Generator develops the templates for various applications such
as the following:

Receiving in Retail

Price Check

Product labeling & Tracking
Shelf Product Replenishment
Mobile Point of Sale (POS)
Mobile Inventory Management
Order Picking & Staging
Work-In-Process Tracking
Material Flow Control
Transportation & Distribution
Warehousing

VvV VvV VvV VvV VvV VvV VvV VvV VvV VvV v v

Asset Management

FORGE Batch Application Generator simulates the program’s running sequences on the
actual mobile computer and allows you to design a new application template on your
personal computer in minutes. Offload the application template you have designed and
your lookup file(s) to the mobile computer so the data collection can commence
immediately.

This manual provides users with a comprehensive guide to FORGE Batch AG for 8-Series
Mobile Computers by relating the approaches while interspersing the examples for
various applications. We recommend that you read the document thoroughly before use
and keep it at hand for quick reference.

Thank you for choosing CipherLab products!
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SYSTEM REQUIREMENTS

To run the program, one of the Windows operating systems is required:

Windows 2000
Windows XP
Windows Vista
Windows 7

v v v Vv

INTENDED PURPOSE

Data collection mainly consists of three elements: input (scanning or key-in), data
processing, and output (or updating database). FORGE Batch Application Generator for
8000/8200/8300/8400/8500/8600/8700 Series Mobile Computers is specifically designed
to deal with the sequences of data processing inside the mobile computers.

The Batch AG program and runtime package can be working with a wireless mobile
computer even if you don’t want to use its wireless connectivity. In particular, when you
use a Bluetooth mobile computer, say 8062 or 8330, you will be able to use Bluetooth
SPP for download and upload by selecting “RS-232/1rDA/USB VCOM”.

FEATURES

Definition of program flow

Editing of screens and data

Managing barcode reader and RFID reader

Font size options and program localization

Simple program simulation for debugging

Password-protected user settings to prevent unauthorized user intervention
Hot key selection for tasks or user settings’ menus

Definition of system initial settings for a quick start

Easy cloning by downloading the template file

Integrated interface for downloading lookup files and uploading data

VvV VvV VvV VvV VvV VvV VvV VvV VvV v Vv

FTP client configuration for wireless mobile computers, as well as for 8200/8400 used
with Ethernet Cradle
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INSTALLING FORGE BATCH AG

Install FORGE Batch AG for 8000/8200/8300/8400/8500/8600/8700 Series Mobile
Computers from the Product CD. The Batch AG will be installed to the prompted
“C:\CipherLab\Forge\Batch\” directory if you don’t change the path to somewhere else.

B Ac_Load
B aci Read
E Data_Read
B Dlockup

@ Application Generator 3 Progload
s Simulator
B3 pEF_Converter

I Remote Console

M Uilties 3

3 Series Batch AG User Guide

All Programs B R Cipherlab

R EBatch » 5_5 Uninstall Forge & Series Batch AG

» Shortcuts to the AG program is created and placed in Start | All Programs |
CipherLab | Forge | Batch | Application Generator.

» Shortcuts to the Remote Console utility is created and placed in Start | All
Programs | CipherLab | Forge | Batch | Remote Console. Refer to the Remote

Console user guide.

Shortcuts to the utilities are created and placed in Start | All Programs |
CipherLab | Forge | Batch | Utilities. Refer to Utilities.

Shortcut Name of Utility

Program Name

Usage

Remote Console

AG_Load

AGX_Read

Data_Read

DLookup

Prog_Load

Simulator

DBF_Converter

RemoteConsole.exe

AG_Load.exe

AGX_Read.exe

Data_Read.exe

DLookup.exe

ProgLoad.exe

Simulator.exe

DBF_Converter.exe

To receive data from the mobile computer
via Remote Console utility.

To download the current application
template to the mobile computer.

To upload the current application template
from the mobile computer.

To receive data via Data_Read utility. It
also synchronizes date/time on every host
connection.

To download associated lookup file(s) to
the mobile computer

To download the AG runtime or font file
(.SHX) to the mobile computer.

To launch the simulator.

To convert text file into DBF file.
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GETTING STARTED

The 8 series mobile computer have to be preloaded with files as follows to commence
data collection:

» an AG runtime (U8*.SHX)

» an application template (*.AGX)

» some other files such as lookup files

The 8 Series Batch Application Generator enables the data exchange between a mobile
computer and a host computer such as your PC. The aforesaid files the mobile computer

required are deliverable through such Batch AG. Please follow the instructions below to
proceed.

) Run the 8 Series Batch AG program on your PC.

The work area appears as the picture shown below:

B8 Forge AG 8000 [ New File | =10l x|
File Transfer Toole Language Help Menu Bar

JQ% r Toolbar
CEEEEE ) E B OB OB OB O

B[ Settings Startup Settings Symbology Menu Lookup Form
""" = Symbology
E Menu
E Lookup

M-E Fom

Tree Menu

DOWNLOAD AG RUNTIME

2) On the mobile computer, press [7] + [9] + [Power] simultaneously to enter System
Menu. Select Load Program and then select the transmission interface to receive
the AG runtime program from your computer.

3) On your PC, click Transfer | Send Program on the Batch AG menu bar to bring up
the [Program download] dialog box. Configure the communication settings that are
consistent with the settings on the mobile computer. Select the AG runtime program
(U8*.SHX) corresponding to the specific model to send.
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Note: If you have installed the Batch AG to the default directory prompted by the
installation wizard, the AG runtime programs for 8 series models can be accessed
in the “C:\CipherLab\Forge\Batch\8 Series\RunTime\” directory. If not, browse to
where you have installed the Batch AG.

4) Click the OK button and then your PC starts sending the selected U8*.SHX file.

Note: To send a font file to the mobile computer, see Localization.

DOWNLOAD APPLICATION TEMPLATES

After the downloaded runtime (U8*.SHX) is set up in the mobile computer, a user’s
application template (*.AGX) is further needed to enable the mobile computer to collect
data. Such template carrying application menus and data collecting forms makes it
possible for users to collect data and edit/manage data.

In order to have an “application template” for the mobile computer, you need to
customize/design one by the Batch AG on your PC.

DESIGN APPLICATION TEMPLATES

5) From the menu bar of the Batch AG, click File | New or File | Open to open a new
or an existing application template. An application template is composed of six groups
of properties.

6) In the left pane of the Batch AG, click on the plus sign of the “Application

Template” to see the drop-downs. From the drop-downs, click EEETE (o start
your customization of a new or a lately edited application template.

Warning: The reader type information is essential for sending the template file to the
mobile computer. Select Settings -> Initial -> Reader Option, and then click the
Reader Type drop-down menu to specify the barcode reader type that is consistent with
the reader actually integrated with the mobile computer; otherwise you will be alerted
with the "wrong reader type" message.

E B B E EH =EH

E Settings Startup Settings Symbalogy b enu Loakup Farm
“[E Symbology

El Menu
E Laokup
-1 Form
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Property Groups Descriptions

Startup Configures the program sequences and customizes the user
interface that are to be presented on the mobile computer.

Settings Configures system settings so that they work when the mobile
computer is initializing.

Symbology Configures reader settings, symbologies and barcode parameters.

Menu Customizes the hierarchical menus to be accessed under the main

menu of the user’s application, e.g. 1. Collect Data | Menu 1 |
(Menu 2) | Form 1.

Lookup Configures the data structures for the lookup files to be referred to
by user’s applications. Up to 3 lookup files are supported.

Form A data collecting form covers multiple input fields that accept the
data input by the user. It may be arranged following up a menu. For
example: 1. Collect Data | (Menu 1) | Form 1.

7) When completing template customization, click File | Save or File | Save As to save
the currently edited template to an .AGX file. You may run program simulation by
selecting Tools | Simulator from the menu bar to verify if the program sequences
meet your requirements. Refer to 7.4 Program Simulation.

PROCEED TO DOWNLOAD

With the application template file created, follow steps below to send it to the mobile
computer:

8) Establish a proper connection between the mobile computer and the host computer
such as your PC.

9) Power on the mobile computer to have the user application main menu show up.

10) On the mobile computer, select the appropriate download interface by 3. Utilities | 1.
Program Settings | 2. Download Program Interface. Press the Enter key to
confirm.

1) Go back to the previous menu, and then select 3. Utilities | 6. Load Application.
The mobile computer will enter connecting mode.

12) On your PC, run Batch AG. Select Transfer | Send Application from the menu bar.
A [Download AG] dialogue box displays. Configure the transmission interface that is
consistent with the download interface set on the mobile computer. Click the OK
button and then the Batch AG will proceed to send the template file (*.AGX) to the
mobile computer.

I3) When the mobile computer finishes the download, the main menu of the new user
application will display on the screen of the mobile computer.
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Note: (1) As the template file includes the settings of the mobile computer’s
upload/download interface, those on the mobile computer will be overwritten after
the template file is sent to the mobile computer.

(2) SD Card option is provided from which the 8200/8400/8600/8700 mobile
computers can download template files (.LAGX). The default import directory is
“N\AG\IMPORT”, which is created on SD card automatically.

(3) When your Batch AG is a version of 1.00.0005 or later, you are able to retrieve
the template file from the mobile computer. Refer to Upload Application Template
and 5.3.2 Upload .AGX.

DOWNLOAD LOOKUP FILES

If you have assigned a lookup file to which the application template will refer, the mobile
computer needs to have that lookup file (Refer to 1.5 Lookup (File) and Chapter 3.
Lookup). Follow steps below for the mobile computer to download lookup files from your
PC:

I4) On the mobile computer, select 3. Utilities | 8. Load Lookup File. The mobile
computer enters download lookup mode.

Note: If an application template doesn’t refer to any lookup file, the command 8. Load
Lookup File is absent from the 3. Utilities submenu.

I5) Run Batch AG on your PC, click Transfer | Send Lookup (or run the “DLookup.exe”
utility). You can send up to three lookup files to the mobile computer.

16) Upon the completion of download, the main menu displays.

Note: (1) Users need to resend their lookup files every time they renew the application
templates even if the lookup files are the same.
(2) Lookup files can be stored on the SD Card of 8200/8400/8700 mobile
computers. The default directory is “\AG\DBF”, which is automatically created on
the SD card. Refer to 7.3 SD DBF Converter (8200/8400/8600/8700 Only).
(3) Use the DBF Converter tool to convert lookup files to DBF format (.DBO) before
sending them to the mobile computer. Run DBF converter by selecting Tools |
DBF Converter from the menu bar of the Batch AG. In the DBF converter tool
window, you can select to copy the converted lookup files either to the SRAM of
the mobile computer or the directory “\AG\DBF” on the SD card inserted in the
mobile computer.

COLLECT & EDIT DATA

I7) To collect data with the mobile computer, select 1. Collect Data from user’s
application main menu on the mobile computer.

I18) To edit the collected data, select the following submenus from user’s application main
menu on the mobile computer —

3. Utilities | 2. Browse Data
3. Utilities | 3. Delete Data (Refer to_5.1.1 Data Manipulation.)
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UPLOAD DATA

To upload the data collected by the mobile computer to your PC:

19) On the mobile computer, select 2. Upload Data. The following options will be
presented when lookup files are used.

» Data file(s)

» Lookup file(s), if any in use

» All (one by one)

» All (append), that is, all-in-one

20) On your PC, from the menu bar of the Batch AG, select Transfer | Direct-Link Data
Transfer or Transfer | Remote Console Data Transfer.

See 7.2.1 Data Read for Direct-Link Data Transfer.

Refer to the Remote Console user guide for Remote Console Data Transfer.

Note: (1) Batch AG supports automatically uploading data to a host computer when the
upload interface is properly configured. Once the mobile computer is seated in the
cradle or connected via the RS-232 or USB Virtual COM cable, a running dot or a
hourglass icon displays on the upper-right corner of the screen indicating the
mobile computer is ready for auto upload. Refer to 7.2.1 Data_Read.

(2) SD Card option is provided for 8200/8400/8600/8700 to store DAT files and
DBF files in the SD card. The files will be saved to the default directory
“NAG\EXPORT” on the SD card that is created automatically.

UPLOAD APPLICATION TEMPLATES

To output the mobile computer’s application template to a host computer such as your
PC:

) Establish a connection between your mobile computer and your PC.

2) For the transmission interface, make consistent settings on both your PC and the
mobile computer. On the mobile computer, go by 3. Utilities | 1. Program Settings
| 1. Upload Interface to configure the interface.

3) On your PC, run Batch AG. Select Transfer | Receive Application from the menu
bar. The [AGX_Read] dialog box displays. Make related settings in this dialog box and
fetch the application template from the mobile computer.

Note: In the [AGX_Read] dialogue box, type in the password that is previously set up
when the template file is created by Batch AG (version 1.00.0005 or later) on a
host computer. Refer to 5.3.2 Upload .AGX

4) Once the OK button is clicked, your PC will start to receive the template file (*.AGX)
from the mobile computer.

5) If your Batch AG is a version of 1.00.0005 or later, you are able to retrieve the
template file from the mobile computer. Refer to 5.3.2 Upload .AGX.
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LOCALIZATION

If you feel the need to localize the entire application of the mobile computer, you must: 1)
translate the text on the Ul of Batch AG, 2) translate the menu prompts/messages of the
application template, 3) Send a font file (*.SHX) to the mobile computer.

I) to localize the user’s interface of the Batch AG

I. Go to the directory where the Batch AG is installed on your PC. Find the language
folder.

2. If you haven't selected an alternative directory when installing the Batch AG, the
language folder can be found inside C:\CipherLab\Forge\Batch\8 Series.

3. In [Language] folder, save the original language file (.Ing) as a new file. Open the
newly saved language file with a text editor, and translate the text (the text of
Batch AG’s user interface) from English into another language.

4. Run Batch AG on your PC. From the menu bar of the Batch AG, select Language
to drop down the commands that present the available languages. You will see the
newly saved language included in the submenu.

5. Select the new language. The user’s interface of the Batch AG shifts to the new
language.

2) to re-define/translate the menu (prompts and messages) of the template file
I. The template can only be re-defined / translated in the Bath AG.

2. Run the Batch AG on your PC. In the left pane, unfold [Application Template]. Find
Startup property page among the drop-downs.

3. On Startup property page, re-define or translate the menu prompts/messages of
the template file.

4. Send the re-defined / translated template file (*.AGX) to the mobile computer.
See Download Application Templates > Proceed to Download to send the template
file to your mobile computer.

5. Restart the mobile computer to apply the new application template.
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Note:

For 8000/8300, to apply double-byte characters such as Japanese, Chinese, etc.,
the menu prompts/messages of template file need to be re-defined / translated in
the Form and Menu property pages by Batch AG, so that characters can display
properly on the screen of the mobile computers. And note, for an input field, the
elements other than menu prompts and messages can only display in
alphanumeric characters.

3) Send a font file (*.SHX) to the mobile computer.

A set of font files are bundled with the Batch AG to support a few languages on 8000,
8200, 8300, 8400, 8500, 8600 and 8700 models. If you haven't selected an
alternative directory when installing the Batch AG, these font files are accessible in
the “C:\CipherLab\Forge\Batch\8 Series\Font Files” directory.

To send a copy of the desired font file to the mobile computer:

Note:

10

On the mobile computer, press [7], [9] and [Power] simultaneously to boot the
mobile computer into System Menu. Select 6. Load Program. And select a
download interface.

Run Batch AG on your PC. From the menu bar, select Transfer | Send Program
to send a desired font file (.SHX) to the mobile computer.

Be sure to make consistent settings for the transmission interface on both your PC
and the mobile computer.
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USING FTP SERVER TO TRANSFER FILES

Creating template files by the Batch AG version 1.00.0008 or newer, a remote FTP server
is readily available to which the mobile computer is allowed to log in and transfer files
whether wirelessly through Wi-Fi or wired by Ethernet Cradle.

FTP stands for File Transfer Protocol and is built on a client-server architecture. The
mobile computer accesses an FTP server to carry out the following:

» Update the script file
» Upload or download lookup files (featuring version control)
» Upload data files

Note: If you don’t make FTP communication settings in the template file, you can still do
it later on the mobile computer’s user application main menu. Select 3. Utilities | 1.
Program Settings | 10. FTP Settings.

FTP COMMUNICATION SETTINGS

Run Batch AG on your PC. Select Transfer | FTP Communication Setting from the
menu bar to have the [FTP Communication Setting] dialogue box:

FTP Communication Setting x|

—FTP Settings
Server IP or Mame: ID-D-D.D
Poart: 21 =
User Mame: I Mazimur charackers: 64
Password; I Mazimur charackers: 64
FTP Communication Interface; I'u'u'L.ﬁ.N j

Cancel |

In this dialog box, make the settings one by one as detailed below:

Server IP or Name

Specify the IP address or the name of the FTP server.

Port

Specify the port number of the remote FTP server.

» By default, TCP port 21 is used on the server for the control connection.

11
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User Name

Specify the user name for logging onto the remote FTP server. (64 characters maximum)

Password

Specify the password for logging onto the FTP server. (64 characters maximum)

FTP Communication Interface

Among 8-Series mobile computers, their communication with FTP servers are supported through
the following interfaces:

Ethernet Cradle

Options 8071 |8200 |8230 |8330 [8370 |8400 (8470 (8630 (8770 |8790
WLAN v x v v v x v v v 4
x v v x x v v x x x

12
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FTP FILE SETTINGS

After completing the configuration of an FTP server, you need to configure which files
should be copied to and from the mobile computer.

From the menu bar of the Batch AG, select Transfer | FTP File Setting to bring up the
[FTP File Setting] dialogue box. This dialogue box features the following settings:

FTP File Settings X
FTP File Settings
[Joownload Script file
Create a Script File(FTP. dak)
Script file Folder: |C:'l,CipherLab'l,Forge'l,Batch'l,B SeriesiUkilities | Erowse, .,
Data file Settings Lookup file Settings
Upload file name SRAM
Data file 1 |D.C'.T.0.F1 |
| |
| |
| |
| |
| |
S0 Card
| |
| |
| |
| |
I oK l [ Cancel ]

Download Script File

Tick this checkbox to enable the mobile computer to download, from the FTP server, any update to
the script file “FTP.dat”.

Create a Script File (FTP.dat)

Tick this checkbox to create a script file “FTP.dat” on your PC and save the other FTP-related
settings into this file.

> The file name “FTP.dat” is reserved for the script file. The file name must be uppercase while
the file extension is lowercase.

Please refer to Appendix VI Creating a Script File on how to create a script file for further details.

13
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Data File Settings

In this group box, select which data files will be uploaded to the FTP server. Instead of using the
default file name “DATAF1~DATAF10”, you may change it if necessary.

4

The length of the file name plus the full directory path on the FTP server is maximum 255
characters.

When no directory path is specified, the data file will be uploaded to the root directory of the
FTP server.

Lookup File Settings

Select if to download or upload any lookup files.

»

14

When a “Download” checkbox is ticked for a particular lookup file, the “Upload” checkbox is
then ticked automatically. You can remove the tick if necessary. Note that there is only one set
of Download and Version Control boxes for SRAM lookup file settings.

When the “Download” checkbox is selected for a particular lookup file, you may apply version
control by ticking the “Version Control” checkbox if necessary. The system will show a message
dialog box to prompt you whether to check the lookup file only when the lookup file is
downloaded to the terminal for the first time.

The uploads will be saved in the root directory of the FTP server with file names of
“DBF1.txt—DBF3.txt” respectively.

The downloads will be saved to the SRAM or SD Card in DBF format, depending on the Lookup
settings.
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WLAN COMMUNICATION SETTINGS

Some of CipherLab’s 8-Series models support Wi-Fi networking. The configuration of
Wi-Fi connection is necessary for the mobile computer to log in to a WLAN network.

Run Batch AG on your PC. Select Transfer | WLAN Communication Setting from the
menu bar. A [WLAN Communication Setting] dialogue box displays:

WLAN Communication Setting |

—IP

Subret Mask: I oo, o 1] 1]
Gateway: I o .0 1] n
DMS Server: I o .o .0 .0
Terminal IF: I o, o0 .0 .0
5510: I Maximurm characters: 32

Security

K I Zancel

In this dialogue box, make the following settings:

Enable DHCP

DHCP server is enabled by default and all settings can be obtained from it. If DHCP server is
disabled, you must provide the following information —

» Subnet Mask

) Gateway
» DNS Server
14

Terminal IP

SSID

“SSID” refers to “Service Set Identifier”, which is the name of a wireless local network (WLAN) to
uniquely identify a group of wireless network devices used in a given “Service Set”. For example,
you need to specify the SSID being used by the access points so that the mobile computer can
associate to the access points.

» SSID can be made up of 32 characters maximum.

Security

Authentication and encryption help provide data protection on the 802.11b/g network. Refer to
WLAN Security Settings.

15
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WLAN SECURITY SETTINGS

In order to prevent information theft, IEEE 802.11 standard has defined two
authentication processes to provide Wi-Fi security. They are “Open System
Authentication” (OSA) and “Shared Key Authentication (SKA)”. Make valid security
settings here to enable the mobile computer to access a WLAN network.

Click the Security button in the [WLAN Communication Setting] dialogue box. The
[WLAN Security Setting] dialogue box displays. Make the following settings:

WLAN Security Setting x|
— Securiky

Suthentication: ¥ Open System

[ Eap Identiky; I- Mazximum characters: 32
Password; I- Maccimumm charackers: 32

[~ wep Key Length: |123 Bits(13 bytes) =] Active
ey 1: I 0
Key 2 I '
Key 3 I '
Key 4 I i

[ wpa [~ weaz Fassphrase: I Characters:d to 63

2, I Cancel
Authentication

Selects between Open System and Shared Key.

Setting Remark

Open System | By “Open System Authentication”, any wireless device can access any WEP
network and receive files that are not encrypted. When a client computer
attempts to connect to a WLAN AP, it sends out an authentication request to
that AP. The AP authenticates the request and the client gets to connect to the
network.

> “Open System Authentication” allows any device network access. If no
encryption is enabled on the network, any device that has the SSID of the
access point can gain access to the network.

Shared Key By “Shared Key Authentication”, when a client computer attempts to connect to
a WLAN AP, it sends out an authentication request to that AP. Then a

16
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challenge-response handshake by encrypting/decrypting a challenge text using
the pre-configured WEP keys takes place between the client computer and the
AP. If the AP finally justifies the challenge text it decrypts, it will send back a
positive response to the client computer. Then the client gets to connect to the
network.

> “Shared Key Authentication” requires a static WEP key configured in the
mobile computer. The mobile computer’s access request can only be
granted when it passed the challenge based authentication of the access
point.

Note: For “Shared Key Authentication”, the active WEP key is used for authentication.

EAP

Select it to activate the authentication of Extensible Authentication Protocol (EAP). It requires user
name and password so that the mobile computer can be identified when connecting Cisco® access
points.

Setting Remark

ldentity Specify a user name. (32 characters maximum)

Password Specify a password. (32 characters maximum)
WEP Key

Select it to apply Wired Equivalent Privacy or Wireless Encryption Protocol (WEP) for the mobile
computer’s data encryption.

Setting Remark

Key Length Encryption type can be 64 bits (5 bytes) or 128 bits (13 bytes).
» Using 64-bit encryption, the password phrase can be 5 characters long.
» For 128-bit encryption, the password phrase can be 13 characters long.

Key 1~ 4 Up to four WEP keys can be configured. Up to 5/13 characters (ASCII codes) for
the WEP key can be specified in a particular key field depending the key length
you selected.

Active Only one key (the active one) can be used at a time.

Note: Make the consistent settings as configured on the devices of the wireless network
that the mobile computer is connecting to, e.g. the access points.

WPA-PSK/WPA2-PSK Passphrase

WPA-PSK supports to enhance security over wireless networks. It is a Pre-Shared key for
authentication that requires a passphrase to access the network. The passphrase must be 8 to 63
characters (ASCII codes) to auto-generate a WEP key. If entered passphrase falls shorter than 8
characters, a warning dialog pops up when OK button is clicked to submit changes.

> For 8200/8400/8600/8700, WPA2-PSK is also supported.
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REMOTE CONSOLE DATA TRANSFER

Remote Console harnesses a Windows-based PC (host) to one or more mobile
computers (clients) so the host is able to retrieve data files from the client(s) and
exchange lookup files with them. Please see the Remote Console user guide for more
details.

Remote Console is capable of data connection through various interfaces, especially
Local Area Network (TCP/IP).

REMOTE CONSOLE SETTINGS

To be able to launch Remote Console, make the following settings in Batch AG:
) From Batch AG menu bar, select Transfer | Remote Console Setting.

A Remote Console Settings dialog opens.

Remote Console Settings E|

Enable Remate Console Data Transfer

Enable Auto Update

[ Ok l ’ Cancel ]

2) Make suitable settings by referencing the following:

Setting Description

Enable Remote Console Data Transfer Tick to make Remote Console available.

Enable Auto Update Tick to make client mobile computer(s) auto-start
outputting data to host computer once connection is
up.

» This item is selected by default.

» To offload a lookup file to the client(s), assign the
lookup file by RemoteConsole | menu bar |
System | Rule Maintenance. Refer to the
Remote Console user guide.

Server IP or Name Specify the destination Server IP or Name (8630
only)
Port Specify the port number (8630 only)

18
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TITLE BAR

The latest release of Batch AG supports two pieces of info on Title Bar. They are:

) the version info of the software, and

2) the version info of the application template file the Batch AG opens.

Update the Batch AG to the latest available version on your PC to have this new support.
SOFTWARE VERSION INFO

When Batch AG is launched without opening any application template file, Title Bar shows
information with Batch AG’s name and the software version. Delivers the

software’s
) Forge AG BOOO ¥1.00.0023 [Mew File] version info.

File Transfer Tools Language Help

€ AII VS

=EREA Application Template H
5

= Startup
= Settings

tartup Settingz Syrmbology b L

Without any application template opened, the software version delivered on the Title Bar
agrees with the info given by clicking Help from menu bar. See also Menu Bar.

The software’s
version info

Forge Batch Application Generator

delivered by
Q Forge Batch AG Yersion 1.00.0023 _ the Help
(]
Copyright [c] All right reserved. Menu.

APPLICATION TEMPLATE’S VERSION INFO

After the Batch AG opens an application template file (*.AGX), the Title Bar shows the
version info about the Batch AG that created the application template file.

The screenshot below displaying an 8000 application template file created by a previous
version of Batch AG software is now opened by the Batch AG.
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Delivers the version of the Batch AG
that created the currently opened
application template file.

B8 Forge AG BOOD V1.00.0022 [ E:\temp\123.AGX ]

File Transfer Tools Language Help

€@H AATI VYV

=REAN Application Template

E Startup — — — —

= Settings Startup Settings Symbology ternu

Note when the opened application template file is too dated to carry the creator’s version
info, the Title Bar shows the software’s version info.
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MENU BAR

The Menu Bar contains a number of menus that specify which task you want the system
to perform. Each menu contains a list of commands and sometimes sub-menus. For the
provided tools, refer to Utilities.

B8 Forge AG B0ODO [ New File |

File Tranzfer Toole Language Help

Menu Command Action...
File New Creates a new application template by selecting model
name.
Open Opens an existing template file. Browse where the file

locates on the local disk.

Save Saves the currently edited template file.

Save As Saves the currently edited template file to a new one.

Preference Configures how the Batch AG will act whenever it is
used.

Refer to Preference.

Convert to 8xxx Converts the currently edited template file to another
8-series model.

Refer to AGX Template Conversion.
Recent File List Opens the recently opened template files.

Refer to Recent File List.

Exit Quits the Batch AG.
Transfer Send Program Sends an AG runtime or font file (.SHX) to the mobile
computer.
Send Application Sends the currently opened template file to the mobile
computer.
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Tools

22

Receive Application

Send Lookup

Direct-Link Data Transfer

Remote Console Data
Transfer

FTP Communication
Settings

WLAN Communications
Settings

Remote Console Settings

FTP File Settings

Simulator

DBF Converter

Fetches the application template flies from the mobile
computer. A password needs to be provided.

Refer to Upload Application Template and

5.3.2 Upload .AGX.

Sends associated lookup file(s) to the mobile computer.

Fetches data via Data_Read utility. It also synchronizes
date/time on every host connection.

Fetches data from the mobile computer via the Remote
Console utility.

Assigns the IP and port number of a remote FTP server
as well as the username and password for the mobile
computer to log in.

Refer to FTP Communication Settings.

Specifies the wireless networking settings for 8071,
8230, 8330/8370, 8470 or 8770/8790.

Refer to

WLAN Communication Settings.

Specifies if to enable Remote Console Data Transfer and
if to enable auto update.

Specifies the files to be copied to and from the mobile
computer.

Refer to FTP File Settings.

Launches the simulator of the mobile computer.

Converts text file to DBF format that is used on the SD
card on 8200/8400/8600/8700.
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Language Selects a preferred language for the Batch AG’s user’s
interface.

Refer to Language.

Help About Forge Batch AG Shows the information about the Batch AG.

FILE MENU

Batch AG’s File menu contains the commands relating to the handling of files, such as
open, save, save as, etc. It also includes a list of recently opened files and the Exit
command to quit the Batch AG.

The File menu and its commands are detailed in the following content of this section.
PREFERENCE

Select File | Preference from the menu bar to pop up the [Preference] dialog box,
which configures how the Batch AG acts each time it is launched. The featured selections
are detailed as follows. Make the settings that meet your needs.

B8 Forge AG 8000 [ New File ]

File Tranzfer Toole Language Help

MNew ]

Open
Save

Save As Preference x|

Convert to 8300 [! [T Auto predoad the last editing file

1: DAAG testi5.AGX
2. DAAG testid AGX [~ Always on top
3: DAAG testi3.AGK

4 DIAG testi2 AGK Cancel |

Exit

Auto pre-load the last editing file

Select this item to load the last edited template file as soon as the Batch AG is run.

Always on top

Select this item to have the Batch AG (ForgeAG.exe) and the utilities remain on the top of any
other windows opened.
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AGX TEMPLATE CONVERSION

This command converts the currently edited template file to a template for another
8-series model. Select File | Convert to 8xxx from the menu bar of the Batch AG to
achieve the conversion.

B8 Forg: AG 8000 [ New File ]
File Transfer Tool: Langmage Help

Cipen
Wew L4

Bave
Cipen Save Lz
3
SEWE i Preference

i Convert to 8000

Preference Convert to 8400
Convert to 8300 wvert to 3200
1. DAAG festhS AGH 1 DA testhS AGH
2 DAAG festhd AGFE 2 DAL testd AGH
3 DAAG fesths AGEH 3 DALG tesths MGG
4: DALG festhd AGE 4: DALG testhd A5
Exit Bzt

The template conversion involves the change of these 2 elements of a template:

» The changes of upload/download interface.
» The changes of the prompts & messages.

The following table gives an account of the upload/download interface conversion
between 8-series models. The table only lists models when the target device doesn’t
have the same upload/download interface as the original one.
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Conversion between Devices

Upload Interface

Download Interface

Original Target Original Target Original Target
8200 8700 Modem RS232 Modem RS232
Ethernet Cradle
8300 8000 Direct-RS232 Cradle IR Direct-RS232 |Cradle IR
Keyboard
Wedge
8400 Direct-RS232 RS232 Direct-RS232 |RS232
Cradle IR Cradle IR
IrDA IrDA
Keyboard USB HID
Wedge
8200 Direct-RS232 RS232 Direct-RS232 |RS232
Cradle IR Cradle IR
IrDA IrDA
Keyboard USB HID
Wedge
8600 Direct-RS232 RS232 Direct-RS232 |RS232
Cradle IR Cradle IR
IrDA IrDA
Keyboard USB HID
Wedge
8330/8370 8071 Direct-RS232 Cradle IR Direct-RS232 |Cradle IR
Keyboard
Wedge
8470 Direct-RS232 RS232 Direct-RS232 |RS232
Cradle IR Cradle IR
IrDA IrDA
Keyboard USB HID
Wedge
8630 Direct-RS232 RS232 Direct-RS232 |RS232
Cradle IR Cradle IR
IrDA IrDA
Keyboard USB HID
Wedge
8400 8700 Modem RS232 Modem RS232

Ethernet Cradle
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Conversion between Devices

Upload Interface

Download Interface

Original Target Original Target Original Target
8400 8600 Modem RS232 Modem RS232
Ethernet Cradle
8500 8200 Cradle IR RS232 Cradle IR RS232
IrDA IrDA
8400 Cradle IR RS232 Cradle IR RS232
IrDA IrDA
8700 Cradle-IR RS232 Cradle-IR RS232
IrDA IrDA
Modem Modem
Ethernet Cradle
8700 8400 USB VCOM_CDC |RS232 usB RS232
VCOM_CDC
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The prompts/messages conversion between 8-series models are summarized as follows:

Prompts/Messages Conversion

» The prompts of upload/download ports are reset to the defaults of the target device. Check it
up on the Startup property page.

- Lkigies .|
=1| Program Settings Default Prompt & Mezzage

E28 Lpload Port Upload data via

[ Download Part
~Toud Fote 1. Cradle-IR.
- Backlight 2 DA
- Data Dieletion 3. Modem
- Entry Option 4. Bluetooth SPP
- View Settings

Nelete Nat j S. Ethernet Cradle

Import Prompts & Messages

Feset Prompts & Messages to default

> For 8500 series, when you select “Convert to 8400”, the prompt “F8:Edit F9:Del” will change
over to 8400’s “F8:Edit Del:Del”.
|

- System Fault ﬂ
- Save Record Default Prompt & Message |
 Delete Record FE:Edit F9:Del I
- futo Delete Det= : |
- Set Password - System Fautt -
- Connection - Save Record Default Prompt & Message
- Modem Caonne
— Delete Record FS:Edit DelDel
~ CITar MEssage - Auto Delete Data
... Set Password [ Enter ] to confirm
- Connection [ESC] to cancel
Import Prompts & Me - Madem Connection 8. Calculator
- Emor Message :
1.Key Click
Reset Prompts & Messag =
= | |2.Barcode Read
3.\Warning Beep
Import Prompts & Messages
Data File
Reset Prompts & Messages to default

» If you convert an 8300 template file to an 8000 template file, the prompts which are
considered too long will be truncated automatically.

Note: For the prompts on Form property page and Menu Caption/lItem Name on Menu

property page, long strings will be truncated when the template file is converted
from 8300 to 8000.
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RECENT FILE LIST

The File menu shows the recently opened templates when it is dropped down. Up to 4
recently opened template files are displayed for your quick access. The most recently
opened one is placed on the top.

Click File from the menu bar to see them.

EB Forge AG 8000 [ D:\AG test|5.AGX |

lgle Tranzfer Toolk Language Help

MNew 3

Open
Save
Save Az

Preference
Convert to 2300

1: DAAG testS AGK
20 DAAG testhd AGK
3 DAAG testd AGK
4 DAAG testh? AGK

Exit

LANGUAGE

When there is any language file (*.Ing) saved into the directory where the Batch AG is
installed, it will be added to the commands in the Language menu and becomes
available. In the menu bar of the Batch AG, select Language and then select the
language you prefer for the Batch AG’s user interface. Refer to Localization.

B8 Forge AG B300 [ New File ]
File Tranzfer Toolz | Language Help

Spanizh ! ‘
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TOOLBAR

The toolbar offers most of the functions provided in the menu bar. An icon is a button
clicked to trigger Batch AG to take an action.

Icons Command Description

6 New Creates a new application template.

,-.'_'.;.L_\ Open Oper_ls_ an existing application template. File path needs to be

" " specified.

E Save Saves the current editing template.

o
Send Sends the currently edited template file to the mobile computer.
Application

Send Lookup | Sends associated lookup file(s) to the mobile computer.

Get File via Fetches data from the mobile computer.

Direct-Link

About Shows the information about the program Batch AG.
Exit Quits the Batch AG.

TREE MENU

In the work area of the Batch AG, a tree menu is featured in the left pane for user’s

navigation through various theme-grouped property pages that enable user’s
configuration for an application template.

» Click on the "+" sign to expand the tree menu or the "-" sign to collapse it.

» Click on an expanded item from the tree menu. The configuration it features will
display on the right pane.
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Chapter 1
FORM

A form means a data collecting form that covers a series of input fields for users to enter
the data. One or more data collecting forms can be arranged in a menu, and multiple
menus are definable for an application template. Forms and menus can be set to connect
to each other for user’s data collecting needs.

Each input field in a data collecting form will occupy one line on the screen of the mobile
computer when the data collecting form is run on the mobile computer. Once all the input
fields on a data collecting form are completed, the input data will be kept as a
transaction record and saved into a “data file” on the mobile computer. The transaction
record can be added to the lookup database that the form refers to, or directly output to
a printer, etc.

The Batch AG enables users to customize their own data collecting forms. To customize
one of your own:

Run the Batch AG on your PC. In the left pane, expand the [Application Template] tree
menu. From the expanded items, select Form. You will see:

» Up to 10 forms definable.

» Maximum eight input fields supported by each form (12 input fields for 8600 due to
the screen size).

In the following content of this chapter, you will be guided to how data collecting forms
are customized by the Form property pages.
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= [E Application Template Form 1
[ Statup
+-[5] Settings Properties 2 Lookup 5 Branch 7
[ Symbology Esc: M ain ~ (&) No Lookup File Function key : Branchto:
#-[E] Menu
#-[5 Lockup Mext: Form 1 v FM +1 Disable v
=[5 Form
= Fecord : Save - FH+2 Disable 3
= 1
Form 2 [[]Enable MSQI .
=l Fom3 FH +3 Dizable e
=
= Form 4 Font Properties Diate & Time stamp i Dot
Form S e * izable 3
= Foms Selected Font File: 3 @) Ma Time Stamp 6
=l Fam7
= roms ) Add to front of record
= F;:; 5 (%) Small [24 characters & 12 lines) [
Reset Current Farm
= Fom10 () Large (20 characters » 12 lines) © fppend to end of record —]

Color Froperties

ackground Color: | [l Black v
4 oreground Colar: ] white v
Mo Data Type Prompt Input Type Min Length Max Length “Yariables More
1 il Eiotif _D_ _ﬂ & ||l
2w 9 10 sl 11 [le | 12 [z 13 [ | 14 [ ]| 15
3 |mi i e [ 24 i
4 il Bioth o 240 il
5 Nl Bioth a 240 il
6 Nl Bioth a 240 il
¥ Nl Both o 240 il
a Nl Bioth a 240 il
g Nl Bioth a 240 il
10 | Mil Both o 240 il
1 | il Bioth a 240 il
12 | Mil Bioth a 240 il
IN THIS CHAPTER
I S Y=Y [ = T ] o o 33
2 o o 1 e o 1= o =T 33
G T o ] 1 41
1.4 Color Properties (8600 0ONlY)..ccoueieiiiiiiiiiiiiiee e 41
1.6 Date & TimMe StamP .. ..o 42
A7 BranCh ... s 43
1.8 Reset CUrrent FOIrM . ... e e e eeees 44
IR B - L = R Y/ o 1= P 45
0t I 10 2 0 o 57
0t 50 O [ o T 5/ T 58
1.12 Minimum Length ... e 58
1.13 Maximum Length ... e 58
1.14 VariableS/Field .. ... 60
I S T 1Y/ o] 63
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1.1 SELECT A FORM

» Ten forms are definable, Form 1 — 10. Select one to start with, usually "Form 1".

» Each Form property page carries a certain amount of group boxes in the upper half
for configuring attributes of a particular data collecting form, including [Properties],
[Font Properties], [Lookup], [Date & Time stamp], [Branch], and a Reset Current
Form button.

» In the bottom half of the Form property page, an eight-row table presents. Such
table is designed for users to configure settings of the eight input fields of a data
collecting form respectively.

1.2 FONT PROPERTIES

[Property] group box covers the configurations labeled with Esc, Next, Record and
Enable MSQI. Together they specify how a data collecting form behaves when it is run
on the mobile computer. The following contents of this section will walk you through
these configurations one by one.

12.1ESC
Click the ESC drop-down item to determine a form/menu to display when the [ESC] key
is pressed to the form running on the mobile computer. Options available are:

> Main Menu
» Form 1 — 10
» Menu 1l - 10

For the “Menu” options, refer to the Menu property page.

Note: Normally, the [ESC] key is used to return to a previous form or menu.

1.2.2 NEXT

Click the Next drop-down item to determine a form/menu to display when the last input
field of the data collecting form is completed. Options available are:

» Main Menu

» Form 1~ 10

> Menul~ 10

For the menu options, refer to the Menu property page.

The mobile computer takes the action of “Next” as soon as the key value of [Enter] is
sent to report the completion of the last input field. However, how [Enter] key value is
produced depends on the input device that does the last data entry. See 1.11 Input Type
for details.

The following table summarizes how the completion of the last input field is reported to
the system when the input devices are different:
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Last Field Input Device

Last Input Field Completion Report

Reader

Keypad

Both of the above
RFID

All

1.2.3 RECORD

The [Auto Enter] item in the More properties of the input field
must be set to "Scan + ENTER". Refer to 1.15 More.

The [Enter] key on 8000/8200/8300/8400/8500/8600/8700
models needs to be pressed.

See the two above.

The [Enter] key on 8300/8500/8600/8700 models needs to be
pressed.

See all of the above mentioned.

Record configures which action to take when all the input fields of a form is completed.

Options

Action...

Save
Update lookup
Save & update

Pass down

Output record

Output screen

Save & output record

Save & output screen

Remove from lookup

Save & remove

Saves the record to a sequential data file.
Updates the lookup file associated with the form.

Saves the record to a sequential data file, and updates the
lookup file.

Passes down the data to the next form or menu without saving.

Outputs the record directly to a printer through COM port
instead of saving it to a file.

Similar to "output record"”. This option outputs what is
displayed on the screen such as the prompts and data
collected.

Saves the record to a sequential data file and outputs it directly
to a printer through COM port.

Saves the record to a sequential data file and outputs what is
displayed on the screen.

Removes the record from the lookup file.

Saves the record to a sequential data file and removes it from
the lookup file.

Note: Instead of saving all the collected data to a single data file, you may select to save
the collected data for each form to separate data files on the Menu property page.

By the Record item on Form property page and the Lookup data can be uploaded
checkbox on Lookup property page, you can select if to upload the data file(s) or lookup
file(s), or both files ("All, one by one"™) to a host computer. You can also select to merge
them to a new file ("All, append™) for the upload. See also 3.3.2 Lookup Data Can Be

Uploaded.
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Note: The uploaded file is a sequential file.

The files retrievable from the mobile computer are:

» Data file:

Such “data file” is generated on the mobile computer only when you have selected
"Save", "Save & update", "Save & output record"”, "Save & output screen”, or “Save &
remove” options from the Record drop-down menu.

> Lookup file:
A lookup file would be available on the mobile computer when you have chosen to use
a lookup file for your data collection and have allowed it to be uploaded.

When there is collected data on the mobile computer to be uploaded to a host computer,
select 2. Upload Data from the user application main menu on the mobile computer
after a connection is established between the mobile computer and your PC to follow
through the uploading.

Warning: If you select "output record" or "output screen" for the Record mode, 2.
Upload Data on the mobile computer will become unavailable.
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1.2.4 ENABLE MSQI

Multiple Scan Quantity Incrementing (MSQI) enables a form to be performed repeatedly,

whereupon the data collected is saved to a data file until the [ESC] key is pressed.

With MSQI selected in a Form property page, the first 2 input fields of the data

collecting form are set to the following status:

» The 1% input field data type is set to “Text”. In the Lookup group box, the available
lookup options rely on how many lookup files you have configured in the Lookup

property page.

The 2™ input field data type is set to “MSQI” by which the input value increases to
the next higher value (normally increases by 1) when the same barcode
continuously scanned.

The initial value/text of a MSQI field is set to “0” by default. Users can click the More
button to bring up the dialog box and then specify a value instead. And if the MSQI

field is set to fetch any lookup value, the lookup value applies.

Farrm 1

With MSQI enabled, if you choose to use a lookup file, the input fields up the 3™ will
become available for you to import more information from the lookup file.
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Ear: I ain

Mest

Record :

[+] Enable MSQI

Fant Froperties
Selected Font File:

(#) Small [24 characters « 12 lines)
() Large [20 characters ¥ 12 lines)

Color Froperties

Lookup
(%) No Lookup File

Date & Time stamp

(%) Mo Time Stamp

() &dd to front of record

() Append to end of record

Branch

Function key : Branch to:

FM +1
FM +2
FM +3

FN + 4

Fezet Current Form

Background Colar: | ] Black v

Fareground Color: [ white v
Mo Data Type Prompt Input Type in Length Mz Length “ariables Mare
1 |Text Buth 0 240 il Fare
2 |Mzal Btk 0 240 il b are
3|kl Btk 0 240 il
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Farrm 1
Properties Lookup Branch
Esc: b ain v () Mo Lookup File Function key : Branch to:
Mest : (3 1st Lookup File FN +1
Record FN +2
+| Enable M50
: FM +3
Fant Froperties Drate & Time stamp
- FM + 4
Selected Font File: ® Mo Time Stamp
() &dd to front of record
(%) Small (24 characters 12 lines)
Fieset Current Form
() Large [20 characters » 12 lines) © Append to end of record
Color Properties
Background Calar: | [ Black v
Foreground Color; [] white "
o Data Type Prompt Input Type Min Length Mazx Lenith Field Mare |I
1 |rex tem: Both 0 240 Field1 [ Moe |
2 |msql Gty Bicth ] 240 il [ Moe ||
3| Nil W Both 1] 240 il
4 |Mil Btk ] 240 il
5 Bioth ] 240 il
B |Mil Bioth ] 240 [l
7o mMil Bioth ] 240 il
g Ml Bioth ] 240 il
9 |l Bioth ] 240 il
10 il Bioth i] 240 il
11 | Wil Bioth i] 240 il
12 | Wil Bioth ] 240 il

By the example of the screenshot above, the data collecting process will repeat as long
as you shall go on scanning barcodes. Such Form 1 also features the following:

» When a barcode is repeatedly scanned, the value in the “Qty” field whose data type is
set to MSQI will increase to the next higher value each time the barcode is scanned.

» When you change over to scanning another barcode, the quantity starts over to
accumulate for the new barcode scanned. Data for the previous barcode scanned will
be saved as a transaction record.

How MSQI works:

3) The input field that is set to “key field” admits a piece of data (line #1 on the screen
of the mobile computer).
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4)

3)

6)

7)
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The succeeding MSQI input field fetches the corresponding lookup value as the initial
quantity value (line #2 on the screen of the mobile computer). If no lookup file is
assigned, the pre-defined initial value will be applied.

The input field set to “key field” admits the same barcode again. The value in the
MSQI input field increases to the next higher value; say increasing by “1”.

The input field set to key field admits a different data. Repeating step 2 and step 3.

Data for the previous item will be saved automatically. Take step 3 for example, data
for the quantity field saved with this transaction record is the value displayed on the
screen, say “3” for this case.

Press [ESC] to quit scanning and exit the MSQIl-enabled data collecting form. Right
before exit, a screen shows up to present a “TRACK” input field for your better
documentation of track number.
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If you don’t feel the need for such “TRACK” input screen, disable it by deselecting
Save Track from the key field’s Properties dialog. Click the More button of the key
field to open its Properties dialog. See the screenshots below:

Form 1
Froperties Lookup Eranch
Esc Main v () No Lookup File Function key : Branchto:
Mext : (&) 15t Lookup File FMN+1
Fiecord : FN+2
v
[¥] Enable M50I e
Font Properties Date & Time stamp
FMN +4
Selected Font File: (3 Mo Time Stamp
() &dd ta front of record
() Small (24 characters x 12 lines)
Reset Current Form
() Large (20 characters % 12 lines) © Append to end of record
Color Properties
Background Color. . Black A4
Foreground Color: [ white w
_ S R ST R e S et 2 20
Key field —l 1 |Ted ttem: Buth 0 240 Filctt boe |lemmmem Click the
2 mzc Gty Bath o 240 il | Mome
3wl Both o 240 il Mo re tzu.tton
4 [wi Both o 240 wi to bri ng up
5 [wi Both i 240 il the
6 [mil Bath o 240 il P rope r-t ies
L Both o 240 il =
8 (Ml Both o 240 il d 1 al og box -
9 [mil Both o 240 il
10 [kl Bath o 240 il
11 [kl Both o 240 il
12 [Mil Both o 240 il
Properties dialog opens.
Properties E\
Farm #1 Line #1
Field data Barcode input

[1Fized data length [ Read partial barcode

Start position

[iritial value or text Masimurn length

[]4dd prefix code [ Check leading cods

[[]Add suitin code [[] Check Digit verification

[ Show input mark.

Deselect to disable =500 |
“TRACK” Input screen

Auto ENTER :
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To get this support, update the mobile computer’'s AG Runtime to the latest release and
update the Batch AG on your PC to the latest release.

Note: If the quantity of a barcode scanned is too large a number to scan, manually input
the quantity. Such input number will override the previous scanned quantity of
this barcode scanned.
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1.3 FONT PROPERTIES

In [Font Properties] group box, select between the small and large font sizes for the data
colleting form. Large font is only applicable to the double-byte languages such as Chinese,
Japanese, etc.

For a data collecting form, configure the font size for various models as tabulated below.
And see also Localization and 2.3 Font .

Mobile Computer Small Font (6x8) Large Font (8x16)
8000 Series 16 characters by 8 lines (default) |12 characters by 8 lines
8300 Series 20 characters by 8 lines (default) | 15 characters by 8 lines
8500 Series N/A 20 characters by 8 lines
Mobile Computer Small Font (10x20) Large Font (12x24)
8600 Series 24 characters by 12 lines (default) 20 characters by 12 lines
Mobile Computer Small Font (8x16) Large Font (12x16)
8.200/8400/8700 Series 20 characters by 8 lines (8x16) 13 characters by 8 lines (12x16)
Single-byte
Mobile Computer | Character Type Small Font (8x16, 16x16) Large Font (10x20, 20x20)
. 20 characters by 8 lines|16 characters by 7 lines
8200/8400/8700 Alphanumeric (8x16) (10x20)
Series
Double-byte Double-byte Language 10 characters by 8 lines 8 characters by 7 lines

Characters (16x16) (20x20)

Note: The [Font Properties] group box isn’t available on the Form/Menu property pages
for 8500 templates which can only display information in small font size.

1.4 COLOR PROPERTIES (8600 ONLY)

This group box is available only for 8600 series. Click the drop-down menus to determine
background & foreground colors of the form for 8600 mobile computer.
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1.5 LOOKUP (FILE)

In [Lookup] group box, select if the data collecting form should refer to a lookup file, i.e.
a database array, so that when that form runs on the mobile computer, it is able to fetch
values from that lookup file. To be able to assign one or more lookup files in the [Lookup]
group box, you need to provide the information about the data structure of the lookup
file(s) that you are going to use in the Lookup property page first. See Chapter 3.
Lookup for details.

A lookup file is a database. Select whether or not a lookup file is associated with the form.
If a lookup file is used, its data format must be defined on the Lookup property page.

Note: The associated lookup file(s) must be duplicated to the mobile computer.

For a data collecting form, as long as a lookup file is assigned in the [Lookup] group box
with the Data Type “Lookup” in the datagrid selected, the “Field” item in the datagrid
will be activated for the input fields. See 1.9.8 Lookup and 1.14.1 Field for more details.

1.6 DATE & TIME STAMP

The [Date & Time Stamp] group box encloses a set of options that control affixing
date/time info to a form’s transaction entry. By and large, the date/time info helps you
with better analysis of the collected data.

Options provided are [No Time Stamp], [Add to front of record], and [Append to end of
record]. [No Time Stamp] is selected by default, which means the software disables the
date/time info if users don’t select an alternative.

Writing date/time info to lookup files relies on the data types [Date] and [Time]. Update
your Batch AG (for the host) and the AG Runtime (for the mobile computer) to the latest
version available to get your hands on the support (except 8500). See 1.9.16 Date and
1.9.17 Time for more details.

» Stamp Position

[Add to front of record] and [Append to end of record] set whether the date/time info
appear to the left or right of a transaction entry. The comma “,” is the default
character that separates the date info and time info.
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> Date & Time Format

When the date/time stamp is enabled, the [Date & Time Format] button becomes
available. Click it to pop up the [Date & Time Stamp settings] window to define the
appearance you want for the date/time info in the data file.

All options on the [Date & Time Stamp settings] window are selected by default.
Deselect one to disable a piece of date/time info element.

Date & Time Stamp sethngs

[#]idd a printable character bebween DATE stamp and TIME starnp
Date Format: v ™™ M /DD Time Format:HH:kM:55
Year 4 Drigitz (7™ L Hour
Month Mifute
Dray Secand
Separator 4 Separatar
Date Siyle : “Year.Maonth.Day w
[ OF. l [ Cancel ]

1.7 BRANCH

On 8-series mobile computers, a data collecting form is usually followed by either
another form or menu. The [Branch] group box features the options required for a data
collecting form that is designed to lead to more than one other form. It also configures
the keypad shortcut for the mobile computer to switch between the forms and menus. Up
to four shortcuts can be configured.

— Branch

Funchion key : Branch to:

FN+1  [Disable  x]
FN+2  [Disable x|
FN+3  [Disable  x]
FN+d4  [Disable x|

Take the following illustration for example.
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Main Menu

Form | Form 2
[ESC] [F2]

Next] [F|:|

tﬁilbij

Note: Data cannot be passed down through branches.

1.8 RESET CURRENT FORM

The “Resent Current Form” button brings the current form back to default state when it is
clicked.

Reszet Current Farm
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1.9 DATA TYPE

A datagrid at the bottom half of a data collecting form that configures the elements of
the input fields in a data collecting form. Every row constitutes an input field while each
column represents an element of an input field that needs your configuration.

Farm 1
Froperties Lookup Branch
Esc: b ain v (%) No Lookup File Function key : Branch to :
Mext - Farm 1 3 ) 13t Lookup File FM +1 Digable hd
Record : Save v FM +2 Disable 3
Enable M5QI
[l FM+3 Disabls v
Font Properties Date & Time stamp
- FM + 4 Disable w
Selected Font File: @ Mo Time Stamp
() Add ta front of recard
(%) Small [24 characters » 12 lines]
Rezet Current Form
() Large [20 characters % 12 lines] © Append to end of record
Color Properties
Background Colar: | [ Black A
Foreground Color: [] white w
Mo | Data Type | Promit Irupast Togpne: Win Length Maiz Lenith “ariables Mare
1| Text Bith ] 240 et v [ Moe |
2 [ Wi 5 Both ] 241) Hi
3 | [integer Buoth 0 240 il
4 | |Real Both 0 240 il
Letter
5 | |aua (+41 Binth 0 240 il
g | |Eoclean Both i 240 il
Lookup
7 | |Fived data Bloth 0 240 il
g | |Fromet Buth o 240 il
Counter
9 | |Passdown Both 0 240 il
10 E:f::'“" Buth o 240 il
11| |Alphamerc Biath 0 240 il
Date -
12 Tirme Both 0 240 il
Serial
Large data
GPS Latitude
GPS Longitude
The available selections for input data type:
Data Type Prompt Input Source | Length Lookup Properties
on-screen | saved in record Min / Max Field More...
Nil
Text v v v v v

45



FORGE Batch Application Generator User Guide

Integer 4 v v v v
Real v v v v v
Letter v v v v v
Auto (+/-) ¥ v v v v
Boolean v 4 4 v
Lookup 4 User-definable 4 v
Fixed data v v v
Prompt v

Counter v

Pass down 4

Extension

Pause 4

Alphameric 4 v v v v
Read from 2D | v v v
Date 4 v
Time v v
Serial v

Large data 4 v 4 v
GPS Latitude |V v

GPS v v

Longitude

The following contents of this section will walk you through all the data types supported
for an input field in a data collecting form.

1.9.1NIL

When “Nil” is set to the data type of an input field, the input field doesn’t accept any data
whatever the format is.

> “Nil” is the default setting. An input field set to “Nil” in a data collecting form would
present a totally blank area (line) on the screen of the mobile computer.
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1.9.2 TEXT

When “Text” is set to the data type of an input field, the input field accepts any ASCII
character. For example, $1a2b3c=-*/..

1.9.3 INTEGER

When “Integer” is set to the data type of an input field, the input field accepts the whole
numbers such as ... -2, -1, 0, 1, 2 .. but not 3.5.

1.9.4 REAL

When “Real” is set to the data type of an input field, the input field accepts any number
that features a decimal whether it is rational or irrational. For example, 4.56.

The following contents of this section will describe how a data collecting form interacts
with the specified lookup file when either “Real” or “Integer” is selected as the “Data
Type” for an input field.

Form 1
Properties Lookup Branch
Esc: Main i )Mo Lookup (3 13t Lookup Function key:  Branchto:
Mext : Form 2 A FH +1 Dizable w
Fecord: | Save & update w
Date & Time stamp Fr + 2 Dizable w

(%) Ma Time Stamp

Fort Properties FM +3 Dizable v

& elected Font File: " Add to front of recaord

FH + 4 i
() &ppend to end of record ¥ Disable b

%) Small [20 characters % & lines]

) Large [13 characters = 8 lines) Feszet Current Form ]
Ncl Data Type Prompt Input Type | Min Length | Max Length Field I hore

1 | Text Biath ] 160 Field1 Mare

2 |Integer Both 0 160 FieldZ

3 | Mil Biath ] 160 il

4 | Mil Bioth ] 160 il

S| Mil Bioth ] 160 il

& | Mil Bath ] 160 il

Ml Biath ] 160 il

g | Mil Biath ] 160 il
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»
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In a data collecting form that refers to a lookup file, when an input field is set to
integer/real and associated with a certain lookup field (by the “Field” element), it
will first fetch the value in the associated lookup file when the data collecting form
runs on the mobile computer. However, you can choose to ignore such fetched value
and input your data into the input field.
In the case you choose to input your own data, if the Record mode of the data
collecting form is set to “Save & Update”, the value you input will trigger different
arithmetic performed to the lookup values depending on the “Field” element setting.
The following table summarizes the arithmetic performed:
Field Setting (Lookup File) | Arithmetic Performed
Field 1 ~ 8 The input value will overwrite the associated lookup value. No
arithmetic would be performed.
+Field 1 ~ 8 The value you input will be added to the value in the associated
lookup field automatically.
- Field 1 ~ 8 The value you input will be deducted from the value in the
associated lookup field automatically.
Hereunder is an example:
Product Code:9950 Product Code:9950
Description:Coke Description:Coke
Bin:A1BO1 Bin:A1BO0O1
Quantity: Quantity:l—l
The input field first fetches the associated You can proceed to input your own

lookup value, say “4000”.

data, say “5”.

By this example, when different “Field” element is set, the arithmetic performed

would be:

“Field” Setting

Arithmetic performed

field (no arithmetic sign)

+field (with a plus sign)

-field (with a minus sign)

If you input “5”, the value “5” will be saved in the transaction
record on the mobile computer and overwrite the value in the
associated field of the specified lookup file. The value saved in the
lookup file will be “5”. You can check the updated lookup file by
selecting 3. Utilities | 2. Browse Data from the user application
main menu.

If you input “5”, the value “5” will be saved in the transaction
record on the mobile computer, and 5 will be added to the
associated lookup value. The value saved into the lookup file will be
4005. You can check the updated lookup file by selecting 3.
Utilities | 2. Browse Data from the user application main menu.

If you input 5, the value “-5” will be saved in the transaction record
on the mobile computer, and 5 will be deducted from the value in
the associated field of the specified lookup file. The value saved into
the lookup file will be 3995. You can check the updated lookup file
by selecting 3. Utilities | 2. Browse Data from the user
application main menu.
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When “Letter” is set to the data type of an input field, the input field accepts any letter,

either upper or lower case (from Aa to Zz).

1.9.6 AUTO (+/-)

When “Auto (+/-)” is set as the data type of an input field, it produces similar
arithmetic as the “Integer” or “Real” does when a lookup file is specified. However,
“Auto (+/-)” distinguishes from “Integer” and “Real” by showing the lookup value
ahead of the input field. Depending on the “Field” element setting, a plus sign (+) or a

minus sign (-) will display ahead of the input field.

Similar as “Integer” and “Real”, for an input field set to “Auto (+/-)”, when you input
your data, the arithmetic performed differs by the “Field” setting. The following example
shows the arithmetic performed when different “Field” element is set:

“Field” Setting Arithmetic Performed

field (no sign) Product Code:9950

Description:Coke

Bin:Al1EO1

Quantity:iEE W
*ield Product Code:9950
Descripticn:Coke
Bin:R1BO1
Quantity: N + N
-field

Product Code:92950
Description:Coke
Bin:A1BO1

Quantity: i -l

If input value is 5, the value saved in
transaction record is 5, and the value
saved to the lookup file is 5 too.

If input value is 5, the value saved in
transaction record is 5, and the value
saved to the lookup file is 1005.

If input value is 5, the value saved in
transaction record is -5, and the value
saved to the lookup file is 995.
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1.9.7 BOOLEAN

When “Boolean” is set to the data type of an input field, the input field accepts only one
of the following sets: "0 or 1", "Y or N" and "T or F".

If you input any value other than the above, a message will display on the mobile
computer indicating "Data type is wrong!"

1.9.8 LOOKUP

When “Lookup” is set to the data type of an input field, the input field doesn’t accept
data input but fetches the associated lookup value. “Lookup” data type is particularly
applicable to the case as exemplified below:

An input field #2 is preceded by an input field #1 that contains the data matching the
"key field", i.e. the “indexed” field, of the associated lookup file. Then the input field #2
will fetch the value in the corresponding field in that lookup file.

Note: By default the fetched lookup value won’t be saved into the transaction record
unless you enable “Save field data” in the advance property page (by clicking the
More button). See 1.15 More for details.

x

Form #1 Line #1

— Field data

[T Eized data length

:

IL-aff't agligned (padded with space) j
[T &dd prefiscode

[ Addsuffis code

Car

I

Note: The lookup value is fetched for reference. No change is allowed.
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1.9.9 FIXED DATA

When “Fixed Data” is set to the data type of an input field, the line it occupies on the
screen of the mobile computer doesn’t accept data input but shows a pre-defined data
string to the data collectors and needs to be included into the data file. Define the data
string in the “Prompt” element setting.

> “Fixed Data” will be saved as part of the transaction record.

1.9.10 PROMPT

When “Prompt” is set to the data type of an input field, the line it occupies on the screen
of the mobile computer doesn’t accept data input but shows a pre-defined prompt string
on the screen of the mobile computer. Define the prompt string in the “Prompt” element
setting.

» It distinguishes “Prompt” from “Fixed Data” that “Prompt” won’t be saved as part
of the transaction record.

1.9.11 COUNTER

When “Counter” is set to the data type of an input field, the line it occupies on the
screen of the mobile computer doesn’t accept data input but registers the count of user’s
data collecting process. It counts each time the “Counter” field is executed.

Normally, the record count starts from 0000000 (7 digits for 8000, 8200, 8300, 8400,
8600, and 8700 but only 5 digits for 8500). However, when a menu is arranged before a
form, and you have configured to save the menu caption, the count will start from “1”
instead of “0”.

To save the count record to the data file, click the “More” button of the input field for the
advanced settings.

You may find the record count in other places:
» The record count also displays at the bottom of user’s application main menu (next to
date and time).

» The record count also displays upon the completion of data input. Refer to 5.1.1 Data
Manipulation for “Entry Options”.

8000

For 8000, when a field (a line on the screen of the mobile computer) is set to show counter, the
current count will be saved and displays in the format of seven digits starting from 0000000.
However, due to the space constraint, the counter displaying in user application main menu would
appear slightly different from the one in a field of a data collecting form and in the data file. The
following example shows what difference it makes:

Record Count Range: Record Count Range: Record Count Range:

0000 — 9999 10000 — 99999 =>0000 ~ (= 100000 ~)
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2.Upload 2.Upload 2.Upload
3.utilities 3.Uutilities 3.Uutilities
APR22 01:55 0000 § APR22 0155 10000 § APR22 0155 >0000 §
8200

For 8200, when a field (a line on the screen of the mobile computer) is set to show counter, the
current count will be saved and displayed in the format of seven digits starting from 0000000. The
counter is displayed on the user application main menu as the picture shown below:

l.Collect Data

.Upload Data

1
2
3.0tilities
4, ETP

APR 13 11:25 0000000
E

(TT

8300

For 8300, when a field (a line on the screen of the mobile computer) is set to show counter, the
current count will be saved and displayed in the format of seven digits starting from 0000000. The
counter is displayed on the user application main menu as the picture shown below:

2.Upload Data [
3.utilities

F
MAR 22 18:52 0000000 M

8400

For 8400, when a field (a line on the screen of the mobile computer) is set to show counter, the
current record count will be saved and displayed in the form in five digits, starting from 0000000.
The counter is displayed on the user application main menu as the picture shown below:

l.Collect Data
2.Upload Data
3.0tilities

APR 13 11:25 0000000
E @
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8500

For 8500, when a field (a line on the screen of the mobile computer) is set to show counter, the
current record count will be saved and displayed in the form in five digits, starting from 00000. The
counter is displayed on the user application main menu as the picture shown below:

T —
2.upload_bata
3.utilities

APR 21, 16:40 00000
E @

8600

For 8600, when a field (a line on the screen of the mobile computer) is set to show counter, the
record count is saved and displayed by seven digits, starting from 0000000. The counter is
displayed on the user application main menu as the picture shown below:

8700

For 8700, when a field (a line on the screen of the mobile computer) is set to show counter, the
record count is saved and displayed by seven digits, starting from 0000000. The counter is
displayed on the user application main menu as the picture shown below:

2.Upload Data
3.utilities
4.FTP

APR 21 16:40 0000000
@
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1.9.12 PASSDOWN

When “Pass down” is set to the data type of an input field, the input field doesn’t admit
manual data input but imports the data collected by the previous form that is set to “Pass
down” for the Record mode.

» When one line isn’t enough to display the imported data, the input field needs one or
more input fields succeeding it set to "Extension".

» A “Pass down” input field also imports the data from a menu. See also 2.5.3 Pass
Down.

Note: An input field set to “Pass down” is able to combine the data collected by multiple
preceding forms to one record.

1.9.13 EXTENSION

When “Extension” is set to the data type of an input field, the input field doesn’t accept
data input but reserves field space for an input field above it that is so extended as to
require additional field space of a second input field to completely display on the screen
of the mobile computer.

Note: How many extension fields are required depends on the maximum length of your
data and the screen size of the mobile computer.

Taking a mobile computer with the screen that allows 20 small-font characters per line
for example:

Mo |  Data Type Provmpt Impt Type [ Min Length | Max Lenoth Field Maore

1 | Mil Both 1] 160 il

2 | Teut De=cription_ Bioth 0 15 Field1 [ More |
3 |Extension Both 1] 160 il

13 characters 15 characters

»
»

- Xep

[Description_} 1234567
BUU/-\‘ CbE

sau17 g8

P
<

Max. 20 Characters
» When the prompt string ("Description_:" in line 2) takes up the space of 13
characters, and the data length is maximum 15 characters...

» Together they make the length reaching 28 characters, which requires the field space
of more than one line.

» As a result, the data type of line 3 needs to be set to "Extension" if you want to fully
display the input data.

54



Chapter 1 Form

1.9.14 PAUSE

When “Pause” is set to the data type of an input field, the line it occupies on the screen
of the mobile computer doesn’t accept data input but shows an alert string to call the
attention of the data collectors to something. Define the alert string in the “Prompt”
element setting.

» The prompt string will not be saved. However, it will be highlighted and blink
constantly on the mobile computer.

1.9.15 ALPHAMERIC

When “Alphameric” is set to the data type of an input field, the input field accepts any
alphabetic, numeric, or alphanumeric characters. For example, ABC123xyz.

1.9.16 DATE

The “Data Type” starts to support date info. Update both the Batch AG on your PC and
the AG Runtime on the mobile computer to the latest version available to have this new
feature — the data type “Date”. Note 8500 isn’t supported presently.

The data type “Date” depends on the mercy of the “Date & Time stamp” settings.
Disable the “Date & Time stamp” to have the “Date” listed in the “Data Type”
selections. Likewise, selecting “Date” data type leaves the “Date & Time stamp”
settings unavailable.

When “Date” is set to the data type of an input field, the line it occupies on the mobile
computer’s screen doesn’t accept data input but imports date info. The date info is saved
into a form’s transaction entry and stored in the data file.

To further write the date info into lookup files, set the Record mode of a form to “Save &
update”. (See also 1.2.3 Record.) Note a corresponding field must be assigned for the
lookup file to admit the time info.

A More button is available to set whether the date info shows on the mobile computer’s
screen and how it manifests itself (the output format).

1.9.17 TIME

The “Data Type” starts to support time info. Update both the Batch AG on your PC and
the AG Runtime on the mobile computer to the latest version available to have this new
feature — the data type “Time”. Note 8500 isn’'t supported presently.

The data type “Time” depends on the mercy of the “Date & Time stamp” settings.
Disable the “Date & Time stamp” to have the “Time” listed in the “Data Type”
selections. Likewise, selecting “Time” data type leaves the “Date & Time stamp”
settings unavailable.
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When “Time” is set to the data type of an input field, the line it occupies on the mobile
computer’s screen doesn’t accept data input but imports time info, with time resolution
configurable down to seconds granularity. The time info is saved into a form’s transaction
entry and stored in the data file.

To further write the time info into lookup files, set the Record mode of a form to “Save &
update” (See also 1.2.3 Record.). Note a corresponding field must be assigned for the
lookup file to admit the time info.

A More button is available to set whether the time info shows on the mobile computer’s
screen and how it manifests itself (its output format).

1.9.18 SERIAL

This data type is used to keep information with the serial number of a particular terminal,
indicating the data record was created by some terminal according to the serial number.

1.9.19 LARGE DATA

When an input field is set to “Large Data”, it accepts data of maximum 2048 characters
collected by 2D scan engines.

This data type is only available when the reader type is set to 2D reader for 8200, 8400,
8500 and 8700 mobile computers by the “Initial” page under “Setting” property page.
Refer to 5.1.4 Reader Option.

» Each form can have one input field set to read large data.

» The maximum field length is set to 160 characters by default. To extend the field
length up to 2048 characters, you need to manually configure the “Max. Length”
setting.

» Note, for “Large Data”, the “Read partial barcode” is enabled by default whereby
only a short piece of the scanned barcode will be read, from the 1% character to the
20™ character by default. If you need the whole extended data to be read, be sure to
disable “Read partial barcode” in the advanced setting of the input field. Click the
“More” button of an input field to pop up a [Properties] dialogue box. See 1.15.2

Barcode Input.

Mo | Data Type Prowmpt Imput Type | Min Length | Max Length Variahles Mote
1||Large data || Data: Reader 0 | [2045 il

2 [Mil Buth 1] 160 il

= Il Firth m 1FRN kil | |

Note: The setting of “Variable” / “Field” element isn’t available when both of the
conditions are met: (1) More than 160 characters are set for the maximum field
length, and (2) the “Read partial barcode” is disabled.

56



Chapter 1 Form

1.9.20 READ FROM 2D

“Read from 2D” data type is available only when the following conditions are met: (1)
2D scan engine is selected for 8200/8400/8700 mobile computers, and (2) one of the
preceding input fields is set to “Large data”.

When “Read from 2D” is set to the data type of an input field, the line it occupies on the
screen of the mobile computer doesn’t accept data input but displays a short piece
extracted from the preceding “Large Data” field.

» Any data collecting form having one input field set to “Large Data” can have as
many input fields set to “Read from 2D” succeeding the “Large Data” input field.

> “Read from 2D” supports to extract a partial piece that reaching up to 160
characters from the extended data in the preceding “Large Data” field. Refer to
1.15.2 Barcode Input.

1.9.21 GPS LATITUDE (8600 ONLY)

When “GPS Latitude” is set to the data type of an input field, the line it occupies on the
mobile computer’s screen doesn’t accept data input but gets the latitude coordinates
where the mobile computer is. The latitude info is saved into a form’s transaction entry
and stored in the data file.

1.9.22 GPS LONGITUDE (8600 ONLY)

When “GPS Longitude” is set to the data type of an input field, the line it occupies on
the mobile computer’s screen doesn’t accept data input but gets the longitude
coordinates where the mobile computer is. The longitude info is saved into a form’s
transaction entry and stored in the data file.

1.10 PROMPT

“Prompt” is the label or the name of an input field. Specify a prompt string for an input
field, if necessary.

Note: Prompt strings won't be saved in a transaction record except for "Fixed Data".
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1.11 INPUT TYPE

The “Input Type” configures the source that data is collected from.

Depending on the models of the mobile computer, the options available are:

» Reader

» Keypad

» Both

» RFID (only applicable to 8300, 8500, 8600, 8700 Series)
> All (only applicable to 8300, 8500, 8600, 8700 Series)

After the required information is entered into one input field, it takes to press the [Enter]
key on the mobile computer to complete the input field. Then the cursor will move either
to the next input field, or to the next form or menu.

When "Reader" is selected for the “Input Type”, you need to enable "Auto Enter" in
the input field property by clicking the More button. See 1.15 More.

Note: When "RFID" is selected, you may still press the [ESC] or [Enter] key on the
mobile computer to cancel or confirm a task. However, the other keys on the
keypad won’t work.

1.12 MINIMUM LENGTH

The “Min Length” specifies the minimum length of the input data.

» If the input data is shorter than specified, it is considered unacceptable. A warning
message will display indicating "Data is too short!"

1.13 MAXIMUM LENGTH

The “Max Length” specifies the maximum length of the data input. 8000/8300 allow
maximum 80 characters, 8200/8400/8500/8700 up to 160 while 8600 up to 240.

You can facilitate data input by showing input marks in the input field. Click the More
button to pop up the [Properties] dialog box. In [Field data] group box, tick the “Show
input mark” checkbox and assign a mark or symbol. The input field will be highlighted
by a succession of the assigned input mark that is equally long as the maximum length
specified.

» If the input data is longer than specified maximum, it is considered unacceptable.
1.13.1 INPUT VIA BARCODE/RFID READER

For the data input from the barcode or RFID reader, a warning message will display when
the data is too long.
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As long as the length falls within the scope specified, a data input by the keypad is
always acceptable even if it is longer than the screen can display.

Taking the scenario below for example, when:

» the screen of the mobile computer displays 20 characters per line for small font, and

» the prompt string configured takes up 12 characters.

Mo |  Data Type Prormt Imput Type | Min Length | Ma L encth Wariables More
1 | Text De=cription: Bath 1 10 il tore
2 | Mil Buath 0 el il fore
3 | Text De=cription: Bath 1 10 il tore
4 |Extenszion Btk 0 a0 il fore
5 | Text De=cription: Bath 1 15 il tore
B |Extenzion Btk 0 a0 il fore
7 | Text De=cription: Bath 1 30 il tore
8 |Extenzion Btk 0 an il fore

The transaction between the data input, the on-screen indication and the record saved
would be in the relationship as tabulated below:

Line |Input from Keypad

Screen Reading

Transaction Record

#1 12345678
1234567890
1234567890ABCDE
#3, 4 1234567890A
#5, 6 | 1234567890LEMONADE
#7, 8 12345678900RANGE_JUICE

12345678

34567890

3456789E

123456789A
1234567890LEMOE
12345678900RANGE_JUICE

12345678

1234567890

123456789E

123456789A
1234567890LEMOE
12345678900RANGE_JUICE
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1.14 VARIABLES/FIELD

“Variables” / “Field” are both the elements of an input field that decides whether the
input field should admit a data read or import some other data. “Variables” and “Field”
are exclusive against each other. When a data collecting form refers to a lookup file, the

element available is “Field” while otherwise “Variables”.

Refer to 1.5 Lookup (File).

Mo Data Type Prompt Input Type | Min Length | Max Length Field hare

1 |Text ICx: Bioth ] 160 il More
2 |counter Courter Bath 0 160 il [ More |
3 (Ml Bioth ] 160 il
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1.14.1 FIELD

“Field” element is only available when the data collecting form is set to refer to a lookup
file. For “Field” element, you set an input field to either admit the data read or fetch
lookup value.

A lookup file usually contains a list of key fields (i.e. the indexed fields) and other
associated fields. Normally, the "key field" is kept as Field #1. When an input field refers
to the key field and finds its data matching, the following input fields will proceed to
import the data from the remaining associated fields of that lookup file.

The following screenshots show you the “Field” options available when the input data
type is selected as Integer/Real/Auto(+/-), or otherwise:

» For the input data types other than Integer, Real, and Auto (+/-), see left below.
» For the input data types of Integer, Real, and Auto (+/-), see right below.

Note: For the field options with a prefixed arithmetic sign (+, -), the input data will be

added or deducted from the lookup value.
field 1 k

field 2
field 3
field 4
field 5
field 6
field 7
field 8
Lookup Field for data type Hield 1

other than jgg Lookup Field for data type:

integer, sigdl Integer,
real, field| real,

auto (+/-) ﬁﬂg auto (+/-)
(1=
Field's

ield 1 +field 1
ield 2 +figld 2
ield 2 +figld 3
ield 4 +ield 4
ield & +figld B
ield & +field 6
ield 7 +field 7
ield & #field 8
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1.14.2 VARIABLES

“Variables” element is only available when the data collecting form isn’t referring to any
lookup file. For “Variables” element, you set an input field to either admit the data read
or fetch some other data collected by the proceeding form.

The following describes how “Variables” function:

» When an input field is set to “set V1”, the data admitted can be fetched by an input
field set to “get V1” in the succeeding form.

» When an input field is set to “get V17, it fetches the value in the input field set to
“set V1” in the direct preceding form.

» When an input field is set to “get&set V1", it fetches the value from an input field
set to “set V1” in the preceding form and sets the fetched value to the new variable
that is to be fetched by the succeeding from. This selection is applicable when a data
needs to pass down to an over next form.

Examples:

» Select “set v1” for input field #1 of form 1, and its input data will be saved in the
first character array.

> Select “get v1” for input field #3 of form 2, it will fetch the data in field #1 of form 1
automatically.

> Select “get&set v1” for input field #3 of form 2, it will fetch the data in field #1 of
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1.15 MORE

To every data collecting form, every input field features a “More” button by which the
advance settings of the input field is possible.

Click the “More” button of an input field to pop up a [Properties] dialogue box as below:

Properties [‘$_<|

Faorm #1

Field data Barcode input

[ ] Fixed data length [ | Riead partial barcode
Start pozitiorn :

[ Initial walue or text b axirmumn length

L

[ ] Add prefix code [ ] Check leading code

[ Add suffix code [] Check Digit verification

[ Show input mark,

oot

Decimal places : wariable  w
Ao EMTER - Scan+EMTER b
Decimal symbal :
[] Compare
k. l [ Cancel ]
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1.15.1 FIELD DATA
The [Field Data] group box features the following configuration:

Fixed Data Length

Select this item and enter a value to confine the data length within the specified value.

» If the input data is longer than specified, it will be truncated and saved to transaction record.
When the data is browsed on the mobile computer, it would display in a truncated manner.

> If the input data is shorter than specified, "space” or "0" can be selected to add ahead or after
the data based on either "Left" or "Right" alignment.

Below are some examples:

Fixed data length Alignment Input data Transaction record
4 Left aligned / space 123456789 1234

4 Right aligned / space 123456789 6789

10 Left aligned / O 7654321 7654321000

10 Right aligned / O 7654321 0007654321

Initial Value or Text

Select this item and enter a value or text that is up to 9 characters to have it show in the input
field on the screen of the mobile computer. Such value or text will be replaced by the data input. It
functions to provide the prompt of an initial value of quantity for example.

Note: When an input data is set to a “variable” for the following data collecting form to
fetch, the Initial Value/Text won’t be available.

Add Prefix Code

Select this item to prefix the input data with a code. Click the text box to pop up a [Grid Control]
dialogue box. Select one or more codes from the ASCII codes presented. For example, a dollar sign
("$") can be added ahead of the data input for price.

Add Suffix Code

Select this item to suffix the input data with a code. Click the text box to pop up a [Grid Control]
dialogue box. Select one or more codes from the ASCII codes presented. Next to delimiters
(section 6.4 Data Field Properties), prefix and/or suffix codes can also function to separate each
data piece.

Note: You may use prefix/suffix code to enclose the input data.

Show Input Mark

Select this item and enter a specific mark or symbol, such as underline () or asterisk (*), into the
text box. Such mark or symbol will show in a succession to highlight the input field. However as
soon as any data is input, such mark/symbol succession will be replaced by the data. The number
of input marks shown on the screen equals to the maximum length of data specified in 1.13
Maximum Length.
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Decimal Places

This drop-down menu is available only when the Data Type field is set to Real. “Decimal places”
defines how many decimal digits after the decimal point.

> The “Decimal places” is set to variable by default meaning any real numbers are acceptable.

When “Decimal places” is set to ‘4’, for example, and the data input has only 2 decimal places like
"8.12", the system will save the input data as "8.1200". If you try to input a number "8.12345" via
the keypad, the fifth decimal digit will be discarded. Only "8.1234" is considered acceptable and
saved to file.

If the barcode "8.12345" is scanned via the barcode reader, a warning message “Incorrect decimal
input” will display on the screen of the mobile computer, and the system will automatically clear
the input data and wait for new entry.

Decimal Symbol

This drop-down menu is available only when the Data Type field is set to Real. “Decimal symbol”
allows users to designate *,” or ‘. as the decimal point symbol.

» The “Decimal symbol” is set to ‘.’ by default.

Compare

This function is available only when the Data Type field is set to Integer or Real. Tick the
“Compare” checkbox to enable the “Comparison Operators Settings” button and then click the
button to bring up the settings window. With this comparison function enabled, the field value will
be compared with the comparison condition. You can determine the behaviour in reaction to results
not matched, by selecting the radio buttons as follows:

Fart Size = X .
® Comparison Operators settings

Comparizon Operators; BETWEEM w

0 < Integer/Real figld < 1
Mo Data Type Prompt AR S
1 (It Irit Real field .

Faer Fgerimea Iei 0 ¢ Integer/Fleal field < 10
2 [Mil
3 (il Action where input data no match
4 | (%) Show warning mezsage
S [Mil
Inzert data
g [Mil O
7 |ni (") Show warning message & Inzert data
2 [Mil
] l [ Cancel ]

» Show warning message: Show message for notification. The scanned data will be discarded.
> Insert data: The scanned data will be inserted.

> Show warning message & Insert data: Show message for notification and the scanned data will
also be inserted.
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1.15.2 BARCODE INPUT

The [Barcode Input] group box features the following configuration:

Read Partial Barcode

To collect only a short piece of the barcode scanned, select this item and configure which character
to start with and how long the data should be.

An example:

Start position Max. length Barcode scanned Transaction record
2 10 9876543210 876543210
2 3 9876543210 876

Check Leading Code

Select this item to enable the check against the very first character of a barcode scanned. When
the leading character doesn’t match the configured code, the barcode will be rejected.

An example:

Leading code Barcode scanned Transaction record
9 9876543210 9876543210
2 9876543210 (Error message: Wrong leading code!)

When “Read partial code” and “Check leading code” are both enabled:

Start position | Max. length | Leading Code |Barcode scanned Transaction record

2 7 8 9876543210 8765432
2 7 9 9876543210 (Error message: Wrong leading
code!)
Check Digit Verification

The “check digit” refers to the digit at the end of a barcode derived from a simple formula to
validate the barcode scanned. Select this item to enable the check against the barcode’s check
digit. From the drop-down menu, select one formula for the checksum examination. Modulus 10
and 11 are available. When the check digit isn’t validated, the barcode scanned will be rejected.

MOD 10 D ouble-ddd-Double [next high)
MOD 10 Add-Double-Add [nest high) k
FOD 10 Trple-bdd-Triple [next high)

FMOD 11 Fepeat Arithmetic (et high]

P00 10 Double-ddd-Double [nest low)
MOD 10 Add-Daouble-Add [nest low]

MO0 10 Triple-Add-Triple [nest low]

MOD 11 FRepeat Arthmetic [nest low)]
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Auto ENTER

Normally, [Enter] key needs to be pressed on the mobile computer to complete one input field, so
that the on-screen cursor will proceed to the next input field, or the next form/menu configured.

From the drop-down menu, select if to trigger a carriage return before or after the barcode is
scanned.

» For barcode scanning, it proves to save time when Scan+ENTER is enabled.

» For a typical application of continuous scanning, it is efficient by making use of ENTER+Scan.
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Chapter 2
MENU

A menu is a list of commands for users to access various forms defined for the mobile
computer to collect data. With Batch AG, up to ten menus are definable. Forms and
menus can be set to connect to each other for user’s data collecting needs.

A “Menu” property page covers the settings as the picture shown below:

=l [F Application Template Meru 1
[ Startup 7 8
+-[E] Settings Propetties
[ Symbalogy [ Menu caption : 2 Mo tem Mame Mest
= Menu 1 Main
= 1 2 bicin
=
i= Menu2 3 Viain
=] Meru 3
= e Esc: Main - 4 Main
= Menu 4 - o
= Merus :
= Menuk Font Froperties 5 Main
Z Menu 7 Selected Font Fils 7 Main
i= Menu 8 3 a Main
=
= Menu 3 a Main
=
= Menu 10 -
%[5 Lookup (%) Small [24 characters » 12 lines) 10 hiin
= 11 Itain
* Form () Large [20 characters = 12 lines] 2 o
Colar Properties
4 Background Calor: I Giack v
Foreground Colar: [ ] wihite “
Data
[] §ave Caption
5 [ 5ave Selected Item 9 Feset Cunent benu

6 []5eparate each data file and edit Form name

In the following contents of this chapter, you will be guided to how menus can be defined
through the Menu property pages.

IN THIS CHAPTER

2.1 SeleCt @ MENU ... 70
2.2 PrOP IS ..t 70
2. 3 FONt e 70
2.4 Color Properties (8600 ONIY) ...ooeiiiiiiiiiiiiiiiee e 71
A T B T L - P 71
2.6 Separate Each Data File and Edit Form Name................. 71
2.7 HEeM NaAME ..ttt eaas 72
D220 S T 1N 72
2.9 Reset CUIrenNt MENU ......eiiiiiiii e 73
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2.1 SELECT A MENU

» Menu 1—10 are available. Select one to start with, usually "Menu 1".

» Each Menu carries these group boxes: the [Properties], [Font Properties], [Color
Properties] (8600 only), [Data], a command name editing table, a checkbox to enable
the Edit Form Name button, and a Reset Current Menu button.

2.2 PROPERTIES

[Property] group box features the settings of Menu caption and Esc. The former
specifies the title of the menu while Esc configures the data collecting form or any other
menu to succeed the menu.

In the following content of this section, you will be walked through said settings one by
one.

2.2.1 MENU CAPTION

Select “Menu Caption” to be able to specify a title for the menu if necessary.

2.2.2ESC
Select a form or menu to display when the [ESC] key is pressed to the menu. Options
available are:

> Main Menu
» Form 1 — 10
» Menu 1l — 10

Note: Normally, the [ESC] key is used to return to a previous form or menu.

2.3 FONT PROPERTIES

Large font is only applicable to the double-byte languages such as Chinese, Japanese, etc.
For a menu, font size needs to be configured according to the font in use on the mobile
computer.

Refer to Localization and 1.3 Font .
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2.4 COLOR PROPERTIES (8600 ONLY)

Click the drop-down menus to determine background & foreground colors of the menu for

8600 mobile computer.

2.5 DATA

[Data] group box features a few actions for the mobile computer to take when the menu
is selected on the mobile computer

2.5.1 SAVE CAPTION

Select “Save Caption” to save the menu caption to the transaction record as long as the
menu is selected and run.

2.5.2 SAVE SELECTED ITEM

Select “Save Selected Item” to save the name of the selected item to the transaction
record.

2.5.3 PASS DOWN

As long as either of the aforesaid items is selected, the option “Pass Down” would
become available. Select if to pass the enabled information to the next form or to affix
the enabled information to a transaction record entry.

By the options in the [Data] group box, the combinations available are:

» Save caption & pass down
» Save selected item & pass down
» Save both & pass down

Note: The selected data will be passed down to an associated form or menu.

2.6 SEPARATE EACH DATA FILE AND EDIT FORM NAME

When a menu leads to more than one form, select this item to save the data collected
from each form to individual data files.

As soon as this item is selected, the "Pass down" in [Data] group box is selected

automatically, which means the menu caption and/or the selected item name will be
affixed to each transaction data entry and saved into the data file of the due form.

71



FORGE Batch Application Generator User Guide

2.7 ITEM NAME

In the upper right of the Menu property page, there is a table that can configure up to
ten items for a menu. Each row in this table sets up a menu item that will occupy one
line on the screen of the mobile computer while each column configures an element of a
menu item.

For the “lItem Name” setting, specify the names of the items to be featured by the
menu.

For example, you may specify "1. Goods In" or simply "Goods In" as the first item name
(See below).

Caption

Item Name

Note: Whether you have included a number in an item or not, you can press [1] on the
mobile computer to enter the first menu item, say the "Goods In" menu as
exemplified by the screenshot above.

2.8 NEXT

For the “Next” setting, sets a menu or a form for the menu item to lead to when the
menu item is selected. Options available are:

» Main Menu

» Form 1~ 10

» Menul~ 10

The selection of an item is executed by one of the following operations performed on the
mobile computer -

» Press the shortcut key (Item No.) of a menu item, e.g. press [2] to select the second
menu item. The form or menu you specified here in the “Next” element column will
display.

» Press the navigation keys [Up/Down] to move between the menu items, and press
[Enter] to select it.
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2.9 RESET CURRENT MENU

Click the “Reset Current Menu” button to load the default settings.

Note: The settings of current menu will be cleared.
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Chapter 3
LOOKUP

A lookup file is a database created for information reference. Up to three lookup files are
supported by the mobile computer and definable with the Batch AG. If the settings on a
Lookup property page are improperly made, it may go wrong when an input field of a
form refers to a lookup field.

The Lookup property page makes it possible for users to provide information about data
structure of the lookup file(s) they are going to use and to configure the related
parameters.

=l [Z Application Template 1t Lookup File 5 6 7
Star
= ar.up Field property 2 =
- Settings X = Mo Offzet Length Key Field
g Symbology Number of fields : |1 - PR p ®
* Meri (%) Fixed len
gth ER 1
=& Lookup 1
=
7 © Delimiter : !
L2 2nd Lookup File 4 1 1
Ii-z 3id Lookup File DBF file location: (%) SRAM ()50 Card 5 1 1
[ Form g |1 1
Lookup data T 1
g 1 1
3 [] Only read data ohce
ER 1
10 (1 1
Lookup data can be uplaaded o 1
12 11 1

Action when input data na match Action when recard farmat is wiong

4 (%) Continue (%) Stop the download process 8
() Shaw waning message (O Truncate/Reformat the record
) Insert to lookup file () Skip the record

() Shaw waning message & ingert

() Clear the screen

9 Fieset Curent Lookup File

() Shaw warning & clear screen

Therefore, to collect data with the help of lookup file(s), the following settings are needed
in addition to the “Lookup” property page:

» The [Lookup] group box featured on the Form property page. See 1.5 Lookup (File).

» The setting of “Data Type” of an input field on the Form property page. See 1.9.8
Lookup (Data Type).

» The setting of the “Field” element of an input field on the Form property page. See
1.14.1 Field.

Users need to apply an application template that refers to lookup files to be able to send
the lookup files to the mobile computer; otherwise the command 3. Utilities | 8. Load
Lookup File will be absent from the user application main menu.
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3.1 SELECT A LOOKUP FILE

Up to 3 lookup files are definable. Select one to start with, usually the “1st Lookup File”.

Each Lookup property page carries these elements: the group boxes [Field property],
[Lookup data], [Action when input data no match], [Action when record format is wrong]
and a table that enables users to provide the data structure of their lookup file(s).

In the following contents of this chapter, you will be walked through the said elements
one by one:

3.2 FIELD PROPERTY

[Field property] group box features the settings of “Number of fields”, “Fixed length”,
“Delimiter” and “DBF file location”. Together with the data structure table, users are
able to provide the information about the data structure of their lookup file(s) at hand.

3.2.1 NUMBER OF FIELDS

In the “Number of fields” box, configure the number of fields in the lookup file you are
using. Set a number up to eight (up to 12 for 8600) that is no smaller than the lookup
file’s actual field amount. Refer to 1.14.1 Field.

3.2.2 FIXED LENGTH

Fixed Length is the default setting. When Fixed Length is selected, users are able to
define the length of the information pieces in a lookup file, so that a data collecting form
is able to look up in a database that has no express matrix or grid structure.

The following settings are necessary:

» Number of fields
) Offset
> Length

3.2.3 DELIMITER

“Delimiter” setting lets users to define an ASCII character to separate the data fields.
Proceed to define related settings as follows:

» Number of fields
» Max. Length

If the maximum length of each field is set improperly, you will receive a warning
message when the mobile computer is downloading the lookup file. Whether the
download will fail or not depends on the action you want the mobile computer to take
when the data format is wrong. Refer to the settings of 3.8 Action When Record Format

Is Wrong.
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3.2.4 DBF FILE LOCATION (8200/8400/8600/8700 ONLY)

The setting of “DBF file location” is only available for 8200, 8400, 8600 and 8700 since
currently only these models support the memory extension with an SD card.

By the setting of “DBF file location”, you may specify where the lookup file is located.
The options are:

> SRAM
» SD Card

Normally, the lookup files are stored in the SRAM of the mobile computer. The original
lookup files (.TXT) will be automatically saved to DBF format when being sent to the
mobile computer.

8200/8400/8600/8700 support to save files to the SRAM, to the SD card or to the SRAM
through the SD card.

Before the lookup files are sent to the SD card of the mobile computer, they need to be
converted to DBF format (.DBO) by the DBF converter tool. You must save the lookup
files (.TXT) to DBF format first. Refer to 7.3 SD DBF Converter (8200/8400/8600/8700

Only).

The following table details how a DBF file can be sent to the mobile computer when the
destined locations are different:

File Location Sending Method

SRAM (1) Send the lookup file to 8200/8400/8700 SRAM.

» The sending is carried out by the lookup sending utility
featured by the Batch AG. Click Transfer | Send Lookup on
the menu bar of the Batch AG to run the utility.

(2) Send the lookup file to 8200/8400/8600/8700 SRAM through the
SD card.

» The sending is carried out by the DBF converter featured by
the Batch AG. Click Tools | DBF Converter from the menu
bar of the Batch AG to run the utility. In the DBF tool
window, be sure to enable Distribute.

> Note the mobile computer’s application template must have
the Lookup property’s DBF file location set to “SRAM”.

SD Card Send the DBF file to the SD card in 8200/8400/8600/8700.

» Such sending is only feasible when the mobile computer installed
with the SD card runs as a removable disk. It requires the mobile
computer with SD card connected to a host computer with a USB
cable.

» Such sending is carried out by the DBF converter featured by the
Batch AG. Click Tools | DBF Converter from the menu bar of
the Batch AG to run the utility. In the DBF tool window, be sure
to enable Distribute.

> Note the mobile computer’s application template must have the
Lookup property’s DBF file location set to “SD Card”.
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Note: It takes less time to send lookup files to SRAM via SD card than send to SRAM
directly.
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3.3 LOOKUP DATA

[Lookup data] group box features the settings about how the data in the lookup file
should be handled.

3.3.1 ONLY READ DATA ONCE

When this checkbox is not ticked, each time the key value of an incoming data will be
compared with entries read from the referenced lookup file. And the matched value will
be brought up.

If you tick the checkbox, the following details how a data collecting form deals with the
incoming data:

Lookup data found matching...

An input field value will be rejected when it can be found matching an entry in the lookup file. The
input field will then be cleared automatically by default.

> For the event of rejecting an input field value, you can decide to show a warning message
before the input field is cleared by ticking the Show message when the data is matched
checkbox. In this case, press any key on the mobile computer to clear the input field.

No lookup data found matching...

As long as the Only read data once checkbox is ticked, the action for a data collecting form to
take would be set to Insert to lookup file automatically (see 3.4 Action When the Input Data
Has No Match). Then the incoming data will be written into the lookup file when no data in the
lookup file is found matching the incoming data, i.e. new data.

» Another action available for the data collecting form to take is Show Warning Message &

Insert. It supports to show a warning message before the incoming data is accepted into the
lookup file.

3.3.2 LOOKUP DATA CAN BE UPLOADED

This is the default setting. It enables the exchange of a lookup file between the mobile
computer and a host computer (such as your PC). On the mobile computer, select 2.
Upload Data from the user application main menu after you have the data collected and
have the connection established between your PC and the mobile computer.

Refer to 1.2.3 Record.

3.3.3 TRIM SPACE WHEN LOOKUP DATA CAN BE UPLOADED

This option is only available when the Delimiter option is selected in the [Field property]
group box. Select this option to remove the spaces in a lookup file that has delimiters to
separate the data fields when it is uploaded to your PC.
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3.4 ACTION WHEN THE INPUT DATA HAS NO MATCH

The [Action when input data no match] group box features a few actions for the data
collecting form to take when the incoming data finds no match in the key fields of the
lookup file. See 3.7 Key Field for reference.

3.4.1 CONTINUE

When “Continue” is selected, the data collecting form goes on and allows the incoming
data to input into its field when the incoming data finds no match in the key fields of the
lookup file. No message will display.

» With “Continue” selected, if the “Record” mode of the data collecting form is set to
"Save", "Save & update", "Save & output record"”, "Save & output screen” or “Save &
remove” on the Form property page, data can only be saved in a data file. See 1.2.3
Record for reference.

3.4.2 SHOW WARNING MESSAGE
When Show warning message is selected, a warning message "Data not found!" would
display when the incoming data finds no match in the key fields of the lookup file.

» The cursor shows at the end of the data input to prompt you to input other data. (By
the example below, you need to replace “9990” with other data.)

Product Code:9990
pDescription:

Bin:

Quantity:

pata not found!

Press any key...

3.4.3 INSERT TO LOOKUP FILE

When “Insert to lookup file” is selected, the data collecting form proceeds to accept
the incoming data without showing any message even when the incoming data finds no
match in the key fields of the lookup file.

The incoming data will be written into the target lookup file if the Record mode of the

data collecting form is set to "Update lookup"”, "Save & update", “Remove from lookup”,
or “Save & remove”. See 1.2.3 Record for details.
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3.4.4 SHOW WARNING MESSAGE & INSERT

When “Showing warning message & insert” is selected, the data collecting form
shows a warning message “Data not found!” before accepting the incoming data into the
target lookup file even if the incoming data finds no match in the lookup file.

The incoming data will be written into the target lookup file if the Record mode of the
data collecting form is set to "Update lookup", "Save & update”, “Remove from lookup”,
or “Save & remove”. See 1.2.3 Record for reference.

3.4.5 CLEAR THE SCREEN

When “Clear the screen” is selected, the data collecting form automatically clears the
incoming data when it finds no match in the lookup file. The incoming data isn’t accepted
into the lookup file. The input field awaits new entry.

3.4.6 SHOW WARNING & CLEAR SCREEN

When “Show warning & clear screen” is selected, the data collecting form shows a
warning message “Data not found!” when the incoming data finds no match in the lookup
file. The incoming data will be cleared and the input field awaits new entry.

Product Code:9990 Product Code:
pDescription: Description:
Bin: Bin:
Quantity: — Quantity:

pata not found!

Press any key...
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3.5 OFFSET

This applies to Fixed Length. Specify the start position for each referred data field.

3.6 LENGTH

» When the field property is set Fixed Length, specify the length for each referred
data field. The value can be 255 at most.

» When the field property is set Delimiter, specify the maximum length for each
referred data field. The value can be 255 at most.

Note: If a delimiter is used to separate data fields, any improper value would cause
wrong data format.

3.7 KEY FIELD

The import of data depends on the key field. Select your key field so that an index file
can be created for the database (lookup file).

» When a form makes reference to a lookup file, there must be one input field
associated with the key field of the database (lookup file).

When its input data is found matching with that of the key field, data of other input
fields, if referring to a lookup field, will be imported accordingly.

If no matching, see 3.4 Action When the Input Data Has No Match.

Note: If offset and length of each field are specified improperly, it may go wrong with
data import.
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3.8 ACTION WHEN RECORD FORMAT IS WRONG

The [Action when the format of record is wrong] group box features a few actions for the
application template to take when a lookup file of wrong data format is sent to the mobile
computer. The crucial factors for a lookup file’s data format are usually the separation of
data fields, i.e. fixed length and delimiter.

3.8.1 STOP THE DOWNLOAD PROCESS

When “Stop the download process” is selected, if a lookup file of wrong format is
being sent in, the application template first displays a warning message on the screen of
the mobile computer to notice the format mismatching line found, and then stops the
downloading.

Then you need to correct the data format, for example, remove a blank line at the end of
the lookup file. Then try again.

Format mismatch!!

The first error was

B the line €. L The preceding records (line 1~5 for example)
1 heck 1ook .
e At can still be downloaded.

The following table lists the actions taken by the application template when the incoming
lookup file’s format is wrong:
(Note: An application template is marked as “.AGX”.)

Fixed Length

Conditions Action

Record length in source file is greater than that specified in .AGX Stop download
Record length in source file is less than that specified in .AGX Stop download
Delimiter

Cause of Failure Action

The number of fields in the source lookup file is more than that specified Stop download
in .AGX

The number of fields in the source lookup file is less than that specified Stop download
in .AGX

The field length in the source lookup file is more than that specified Stop download

in .AGX

The field length in the source lookup file is less than that specified Allow download“°*
in .AGX
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Note: In the case delimiters are used for the separator of data pieces in the source
lookup file, if the max data length specified in the application template is more
than the field length in the source lookup file, the data field in the lookup file will
be padded with blank space when it is sent to the mobile computer.
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3.8.2 TRUNCATE / REFORMAT THE RECORD

When “Truncate/Reformat the Record” is selected, if a lookup file of wrong format is
sent in, the application template first displays a message on the mobile computer to
notify the mismatching part fixed, automatically truncated, or reformatted during
downloading.

For example, the additional fields of a record will be left out. However, you may need to
reload the lookup file after the data format has been corrected.

Format mismatch!! ; : )
- el The downloading of lookup file will be completed
p f th d . . : =
B b en Fefor ool with a successful fix ta the mismatching line(s).
Please check lookup
data and reload.

The following table lists the actions taken by the application template when the incoming
lookup file’s format is wrong:
(Note: An application template is marked as “.AGX”.)

Fixed Length

Conditions Action
Record length in source file is greater than that specified in .AGX Truncate
Record length in source file is less than that specified in .AGX ReformatN°®

Note: Each field of that specific record will be padded with additional space.

Delimiter

Conditions Action

The number of fields in the source lookup file is more than that specified Truncate
in .AGX

The number of fields in the source lookup file is less than that specified Reformat™ot!
in .AGX

The field length in the source lookup file is more than that specified Truncate

in .AGX

The field length in the source lookup file is less than that specified Allow downloadN°*?
in .AGX

Note: (1) Additional fields will be appended with additional delimiter and space.
(2) The data field concerned will be padded with additional blank space.
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3.8.3 SKIP THE RECORD

When “Skip the record” is selected, if a lookup file of wrong format is set in, the
application template first displays a message on the mobile computer to indicate the

mismatching part discarded. Then you may need to reload the lookup file after the data
format has been corrected.

Format mismatch!!

e of the recorcll” The downloading of lookup file will be completed
e i A without the mismatching line(s).
data and reload.

Fixed Length

Conditions Action

Record length in the source lookup file is more than that specified in .AGX Skip

Record length in the source lookup file is less than that specified in .AGX  Skip

Delimiter

Conditions Action

The number of fields in the source lookup file is more than that specified  Skip
in .AGX

The number of fields in the source lookup file is less than that specified Skip
in .AGX

The field length in the source lookup file is more than that specified Skip

in .AGX

The field length in the source lookup file is less than that specified Allow download“°*
in .AGX

Note: That specific field will be padded with additional blank space.

3.9 RESET CURRENT LOOKUP FILE

Click the “Reset Current Lookup File” button to load the default settings.

Note: The settings for the current lookup file will be cleared.
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SYMBOLOGY

Chapter 4

A symbology means a type of barcode that is coded by its own rule. An 8-series mobile
computer’s barcode support depends on the scan engine equipped.

According to application requirement, users may need to enable or disable certain
symbologies, and the configuration should be included in the application template on the
mobile computer. The Batch AG’s Symbology property page is the access to achieve the

such configuration.

The Symbology property page covers the group boxes of [Reader Settings] and
[Barcode & Parameters]. In the following contents of this chapter, you will be guided

though these group

boxes one by one.

= [E Application Template
""" [ Startup
o= Settings
Surnbology
- Menu
Elﬁ Lookup
1?; 1st Lookup File
-EZ 2nd Lackup File
£ 2d Lookup File
=] Farm

= Fam 1

I

Form 10

IN THIS CHAPTER

4.1 Reader Settings

4.2 Barcode & Parameters

CCD/Laser |

— Reader Settings —

Scan Mode : Laszer Time aut :

Read Redundancy : INone vI

Aimnirig duration :

3 _:I zec
I3 sen
Reset

Code ID

Barcode & Parameters
¥ Code 39

[~ ltalian Pharmacode M
[~ French Pharmacode M
IV Industrial 25 M

v LPCE
[~ UPCE Addon 2

mare. ..

[~ UPCE Addan 5
[¥ E&MB

¥ Interleaved 25 [~ E&MB Addon 2

mare. .. |

mare. .. |

[~ Telepen mare. .

[T GS1Databar-14/Expandec  more,.,

[~ GS51 Databar Lirnited ==
[¥ Code128

more. ..

¥ G51-128(EANT2E

[ Makix 25 M [~ EANBAddon 5 [¥ ISBT 128

[ Codabar moe.. | | @ EaNt3gUPCA  more. || T Coop2s more...
[~ s ﬂl ™ EAN13 Addon 2

[~ Plessey M [~ EAM13 Addon 5

¥ Code 93 ¥ Megative Barcods

L A EIE B
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4.1 READER SETTINGS

The [Reader Settings] group box features a set of options regarding how the scan engine
should scan and read. Refer to the following appendices for information on barcode
reader settings —

» Appendix Il - CCD/Laser Scan Engine for details.

» Appendix Il - LR/ELR Laser Scan Engine for details.

» Appendix IV - 2D Scan Engine for details.

4.1.1 CODE ID

The “Code ID” means the characters prefixed to a barcode scanned to identify the
barcode’s symbology. Click the Code ID button to pop up a [Code ID] dialogue box that
features the settings of barcode ID. When “Code ID” is enabled, a Code ID will be
prefixed to the decoding result of a barcode.

» Click on the text box next to a barcode name, and select one code from the pop-up
[Grid Control] (ASCII codes) dialogue box.

Alternatively, you may click Set 1 — 5 buttons to assign code ID for all text boxes.

Note: The Code ID settings for GS1 Databar-14/Expanded, GS1 Databar Limited, and
GS1-128 are detailed in 4.2 Barcode & Parameters.

4.1.2 RESET

Click the [Reset] button to load the default settings. The resetting applies to the following

» The settings in [Reader Settings] group box. See 4.1 Reader Settings.

» The settings in [Barcode & Parameters] group box. See 4.2 Barcode & Parameters.

Note: The current settings will be cleared.

4.2 BARCODE & PARAMETERS

The [Barcode & Parameters] group box features the advance settings of various barcode
symbologies supported.

Refer to the following appendices for information on symbology settings —

» Appendix Il - CCD/Laser Scan Engine for details.
» Appendix Il - LR/ELR Laser Scan Engine for details.

» Appendix IV - 2D Scan Engine for details.

Note: Code ID settings for GS1 Databar-14/Expanded, GS1 Databar Limited, and
GS1-128 are provided in this group box.
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SETTINGS

The Settings property page features the basic settings for the application template.
These basic settings are divided into three themes: “Initial”’, “Function Key” and
“Security”. Each is presented on a single tabbed page of the Settings.

= [ Application Template intial |
El Starfup r~ Data Manipulation r~ Reader Option
EE Eﬂ 1 Data Deletion IManuaI vl Reader Type ICC D/Laser 'l
R Initial
g Function Key— 2 Entry Options IShow count 'I St FAFID |
~|5& Securi
- IB . | n r~ Upload Method
= S‘,"I'I'Ib0|l:|g:r\ v Stay On the LCD =1 (17~ 59)x 100 ms Interface |R5232 ,l
= Menu 3
-] Lookup " Press any key to cortinue 1USE HID |
E Form
~Keypad & LCD Dial Fumter I
R [Tone2 I | - Download Wethod
Backlight ITum e vI DW Application Intedace |R5232 Yl
Tum backlight off i idle |2 3; (1~ 9)x 10sec Dia Mumter |
DW Lookup Interface |R5232 'l
[~ Notfication Dial Fumter I
Waming Beep ITWD beeps 'I
Good Read Beep IOne beep 'I - Baud Rate & Modem Speed
Baud Rate I 115200 bps = l
Vibrator Duration IOH vI
tadem Spesd |1152::bps vl
Buzzer Volume ILARGE_\-"OL 'I
Reset Settings |
IN THIS CHAPTER
5.l Initial SettingsS. . oo e 92
5.2 Function Key Setting ....ccvveiiiiiiiiiiiii i e 101
5.3 Security Setting.....ccouii e 102
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5.1 INITIAL SETTINGS

The Initial property page features the following settings:

Settings Default Value Remarks

Data Deletion Manual

Entry Options Show count Stay on the LCD for 600 ms

Key Click Tone 2

Backlight Turn off

Warning Beep Two beeps

Good Read Beep One beep

Vibrator Duration Off

Buzzer Volume LARGE_VOL Only for 8200/8400/8600

Reader Option CCD/Laser

Upload Method Cradle-IRN°®® Bluetooth SPP is not available on the mobile
bownload Method Cradle-IRNe® g%rgf’u;%%gl.’lless selected for downloading to
Baud Rate & Modem Speed 115200 bps

Note: For 8200/8400/8600/8700, the default upload/download port is RS-232.

5.1.1 DATA MANIPULATION

The [Data Manipulation] group box covers settings of “Data Deletion” and “Entry
Options” which are detailed in the following:

Data Deletion

Configures if the data/lookup files should be automatically deleted from the mobile computer after
it is uploaded to a host computer.

It is set to “Manual” by default, which means the application template won’t delete the data/lookup
files from the mobile computer after uploading but leaves it to your decision if to delete the data
right after the uploading completes. When the upload completes, you will be prompted if to delete
the data. If you decide not to delete the data right at the moment, you can always delete the data
later by selecting 3. Utilities | 3. Delete Data from the application main menu on the mobile
computer.

Select “Automatic” to have the data files automatically deleted from the mobile computer upon
upload completion. The data on the mobile computer is no longer available as soon as it is
uploaded to a host computer. You won't see any data by using 3. Utilities | 2. Browse Data in
the user application main menu of the mobile computer; however, the data won’t be deleted if the
uploaded data type are lookup files.

If “No” is selected, the application template will skip the data deletion prompt upon completion of
upload. The data file(s) and lookup file(s) will remain on the mobile computer after they are
uploaded to a host computer. However, you can always select 3. Utilities | 3. Delete Data to
delete them later.
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Entry Options

By Entry Options, you can specify what kind of information the mobile computer will show on the
screen after the entry of a data is completed and before the next data entry is proceeded with.
Options available are the count (option “Show count”) and the data preview (option “Show
record”). By default, the count will display on the mobile computer screen for 600 milliseconds as
soon as an entry is completed. Refer to 1.9.11 Counter.

When selecting either "Show count” or "Show record", the options of Stay on the LCD and Press
any key to continue are available for you to either specify the time the data preview / count
displaying on the screen of the mobile computer or simply choose to show the data review / count
before a key is pressed on the mobile computer. Time-out is configured within the range of 1~99
times 100 milliseconds.

5.1.2 KEYPAD & LCD

The [Keypad & LCD] group box features the option in regard to the tone of the key click
and the LCD/keypad backlight behaviour.

The [Keypad & LCD] group box covers the options of Key Click and Backlight which are
detailed in the following:

Key Click

"Tone 2" is the default for the key click. You may select a desired tone or mute it.

Backlight

The LCD/keypad backlight is off by default. When the backlight is turned on, you may specify the
idle duration for turning off backlight. Such time-out is configured within the range of 1-9 times 10
seconds. The default time-out is 20 seconds.

5.1.3 NOTIFICATION

The [Notification] group box features the options regarding the status feedback of the
mobile computer that are detailed in the following:

Warning Beep

By this option, you can specify if to have the application template make a warning beep when a
specific event occurs. By default, the mobile computer outputs two beeps to warn you of a specific
event.

Good Read Beep

By this option, you can specify if to have a beep when a barcode is decoded successfully. By
default, the mobile computer produces one beep to inform you of a successful reading.

Vibration Duration

This option is only available for 8200/8300/8400/8500/8600/8700. You can specify if to enable the
vibrator to warn you of a specific event. The vibrator is off by default. You may turn it on for a
preset period of time.
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Buzzer Volume

This option is available for 8200/8400/8600 only. You may change the buzzer volume by this
option.

5.1.4 READER OPTION

The [Reader Option] group box sets the barcode reader and RFID reader on the mobile
computer. Refer to Appendix | - Scan Engine Settings for more information.

Reader Type (for barcode scan engine)

By this option, select a reader type according to the hardware configuration of your mobile
computer. The associated barcode parameters will display in the Symbology property page
accordingly. If there is a More button next to the barcode symbology listed, advanced settings are
available.

Note: In order to initialize the barcode reader, you must select the correct reader type
when you first configure an application template. Otherwise, a message will be
displayed on the mobile computer to indicate "Wrong reader type!" after you
download the application template file.

Set RFID

The RFID reader is automatically enabled after initialization. Advanced settings are provided as the
picture shown below. RFID tags in proximity will be read automatically by 8300/8500/8600/8700
when RFID reader is enabled. You may limit the 1.11 Input Type options in Form to prevent from
misreading RFID data.

x

[v Read LID

[~ Read Data
Start Fazition : I:—
bl awirnunn Lenath . (127

[T Use Defimiter I—
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Read UID

By default, the RFID reader is set to read UID (Unique ldentification).

Read Data
» Select the check box so that RFID data can be read.

» If only partial data is required, specify the start position and maximum length.

Use Delimiter

Select the check box and specify a delimiter to separate UID from data.
5.1.5 UPLOAD METHOD

The [Upload Method] group box sets the interface for the host computer to receive data
file(s) and lookup files(s) from the mobile computer. Refer to 7.2.1 Data_Read on how to
set the host computer to auto-receive files from the mobile computer.

Here shows the review of the “upload interfaces” supported on the 8-series mobile
computers:

Upload Interface Remarks

AG8000 Update the AG Runtime to the latest release for your 8000 mobile

computer, and update the Batch AG to the latest release on the PC.
Normally the interface options on the mobile computer are

» Cradle-IR

> IrDA

» Modem

» Ethernet Cradle

Note when your mobile computer is a model of 806x, setting the
“Upload Method” to either “Bluetooth SPP_Master” or “Bluetooth
SPP_Slave” in the application template will delete “Modem” from
the “Upload Port” submenu on the mobile computer and replace it
with either of “Bluetooth SPP_Master” or “Bluetooth SPP_Slave”.

Check out the mobile computer’s “Upload Interface” submenu at:

3. Utilities | 1. Settings | 1. Upload Port
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AG8200

AG8300

Update the AG Runtime to the latest release for your 8200 mobile
computer, and update the Batch AG to the latest release on the PC.

Since part of the 8200 lineup comes with Bluetooth integrated, the
interface options on the mobile computer are:

4

Vv v v VvV VvV v v Vv

RS232

Bluetooth SPP_Master
Bluetooth SPP_Slave
USB VCOM

USB VCOM_CDC
Modem

Ethernet Cradle

USB HID

SD Card"°*®

Update the AG Runtime to the latest release for your 8300 mobile
computer, and update the Batch AG to the latest release on the PC.

Normally the interface options on the mobile computer are:

v v v Vv v Vv

Direct RS-232
Cradle-IR

IrDA

Keyboard Wedge™°*®
Modem

Ethernet Cradle

Note when your mobile computer is a model of 836x, setting the
“Upload Method” to either “Bluetooth SPP__Master” or “Bluetooth
SPP_Slave” in the application template will delete “Modem” from
the “Upload Interface” submenu on the mobile computer and replace
it with either of “Bluetooth SPP_Master” or “Bluetooth
SPP_Slave”.

Check out the mobile computer’s “Upload Interface” submenu at:

4

3. Utilities | 1. Settings | 1. Upload Interface

Note: Keyboard Wedge option is provided with the 8300 Series mobile computers, and
therefore, the settings are available in AG8300 program only.
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Remarks

Update the AG Runtime to the latest release for your 8400 mobile

computer, and update the Batch AG to the latest release on the PC.

Since the whole 8400 lineup comes with Bluetooth integrated, the
interface options on the mobile computer are:

RS232

Bluetooth SPP_Master
Bluetooth SPP_Slave
USB VCOM

Modem

Ethernet Cradle

USB HID

SD Card"°*®

As the whole 8500 lineup comes with Bluetooth integrated, the

interface options on the mobile computer are:

AG8400
4
»
4
»
4
»
4
»
AG8500
»
4
»
4
»
AG8600
4
»
4
»
4
»
4
AG8700

Cradle-IR

IrDA

Modem
Bluetooth SPP
Ethernet Cradle

With Bluetooth integrated, the upload interfaces available are:

RS232

Bluetooth SPP_Master
Bluetooth SPP_Slave
USB VCOM

USB VCOM_CDC

USB HID

SD Card"°*®

Since the whole 8700 lineup come with Bluetooth integrated, the

upload interfaces available are:

v v v VvV v v Vv

RS232

Bluetooth SPP_Master
Bluetooth SPP_Slave
USB VCOM

USB VCOM_CDC

USB HID

SD Card"**®

Note: SD Card is provided for 8200/8400/8600/8700 to store DAT files and DBF files.
The files will be saved to the default working directory “\AG\EXPORT”, which will
be created on SD card automatically.
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5.1.6 DOWNLOAD METHOD

The [Download Method] group box sets the interface for the mobile computer to
download application templates and lookup file(s) from the host computer. Here is an
overview of the “download interfaces” supported on the 8-series mobile computers:

Download Interface Remarks

AG8000 Update the AG Runtime to the latest available version for your 8000
mobile computer, and update the Batch AG to the latest available
version on the host computer.

Normally the interface options on the mobile computer are:
» Cradle-IR

> IrDA

» Modem

Note when your mobile computer is an 806x model, set the
“Download Method” to either Bluetooth SPP_Master or Bluetooth
SPP_Slave in the application template to be able to have either of
them replace the “Modem” in the “Download Port” submenu on the
mobile computer at:

3. Utilities | 1. Settings | 2. Download Port

AG8200 Update the AG Runtime to the latest available version for your 8200
mobile computer, and update the Batch AG to the latest available
version on the host computer.

Since part of the 8200 lineup comes with Bluetooth integrated, the
interface options on the mobile computer are:

> RS232

> Bluetooth SPP_Master
» Bluetooth SPP_Slave
> USBVCOM
» USBVCOM_CDC
» Modem

» SD Card

AG8300 Update the AG Runtime to the latest available version for your 8300
mobile computer, and update the Batch AG to the latest available
version on the host computer. Normally the interface options on the
mobile computer are:

» Direct RS-232
» Cradle-IR
> IrDA

» Modem

Note when your mobile computer is an 836x model, set the
“Download Method” to either Bluetooth SPP_Master or Bluetooth
SPP_Slave in the application template to be able to have either of
them replace the “Modem” in the “Download Interface” submenu on
the mobile computer at:

» 3. Utilities | 1. Settings | 2. Download Interface
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Update the AG Runtime to the latest available version for your 8400

mobile computer, and update the Batch AG to the latest available
version on the host computer.

Since the whole 8400 lineup comes with Bluetooth integrated, the
interface options on the mobile computer are:

AG8400
4
»
4
»
4
»
AG8500
»
»
4
»
AG8600
»
4
»
4
4
»
AG8700

»
4
»
4
»
4

RS232

Bluetooth SPP_Master
Bluetooth SPP_Slave
USB VCOM

Modem

SD Card

With Bluetooth integrated, the download interface options are:

Cradle-IR
IrDA

Modem
Bluetooth SPP

With Bluetooth integrated, the download interfaces available are:

RS232

Bluetooth SPP_Master
Bluetooth SPP_Slave
USB VCOM

USB VCOM_CDC

SD Card

With Bluetooth integrated, the download interfaces available are:

RS232

Bluetooth SPP_Master
Bluetooth SPP_Slave
USB VCOM

USB VCOM_CDC

SD Card

Note: (1) SD Card is made available for 8200/8400/8600/8700 to store the template file
(. AGX) and lookup files. The default working directories are “\AG\IMPORT” for
template file and “\AG\DBF” for lookup files, which will be created on SD card
automatically. Different download interfaces are supported for different file types.
(2) Before the lookup files are sent to the mobile computers, they needs to be
converted from text files (.TXT) to DBF format (.DBO) with a DBF converter tool.
This tool will automatically copy the DBF file(s) to the import directory “\AG\DBF”
on either the SD card or SRAM.
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5.1.7 BAUD RATE & MODEM SPEED

The [Baud Rate & Modem Speed] group box features speed options of the mobile
computer’s data transmission.

Baud Rate

By default, the baud rate is set to 115200 bps for communications via any interface other than
Modem.

Modem Speed

Only when the modem is selected for upload or download interface, this option will become
available.

> For 8000/8300/8500, the data transmission speed depends on the IR control board of the
modem cradle which is set to 57600 bps by default. If you select any value other than 57600
bps, you need to adjust the DIP switch of the control board accordingly.

» For 8200/8400, the modem cradle is capable of detecting baud rate.

Note: For the 8000/8300 Series, the version of IR control board on the modem cradle
must be greater than SV3.01.

5.1.8 RESET SETTINGS

Click this button to load the default settings. This button applies to all the three tabbed
pages of the Settings property:

» The Initial property page. (See 5.1 Initial Setting)
» The Function Key property page. (See 5.2 Function Key Setting)
» The Security property page. (See 5.3 Security Setting)

Note: The current settings will be cleared.
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5.2 FUNCTION KEY SETTING

The Function Key property page enables users’ definition of one or more keypad
shortcuts to quick-access user application main menu items or submenus thereunder. By

default no keypad shortcut is defined.

Chapter 5 Settings

Note the data collecting forms you create are not supported by these keypad shortcuts.

= [ Application Template
E Startup
=[5 Settings
E Initial
: N Function Key
: E Security
E| Symbology
H- [ Menu
H-[E Lookup
== Fom

Function Key |

Function 1 (FN+1) :
Function 2 (FN+2) :
Function 3 (FN+3) :
Function 4 (FN+4) :
Function 5 (FN+5) :
Function & (FN+6) :
Function 7 (FN+7) :
Function 8 (FN+8) :

Function 9 (FN+5) :

[~ Enable Function Key Mappings

Ini

i

Ini

i

Ini

i

Ini

i

ni

IKH 88 K I K K K K K K

Note: For 8400/8600, key combination FN+9 on 29-key requires pressing the orange
modifier key and the “-” key.
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5.3 SECURITY SETTING

The Security property page enables the authentication that restricts the access to
various resources on the mobile computer. No security is set up by default.

= [Z Application Template Security
[ Startup
=[] Settings Security Checking Upload AGH
5 Initial . Y
JE Function Key ey (D el - [ &llows upload AGX
. Security
[= Symbology [ 5ettings [ Upload Interface PreedlB el
E3 M
i E L:or::;p [CIEditData [ Download &pplication Interface
+ (5 Fom [ Delete Data [ Download Lookup Interface
[]5et Date/Time [ Transmizsion Speed
[ Laad Application [ Backlight
[ Load Lookup File [[]5et Data Deletion
[ Key Click [Jwaming Beep
[ Barcode Good Read CIFTP Settings

[ Entry Options

[CIFTP Communication

5.3.1 SECURITY CHECKING

The [Security Checking] group box features the following:

You may specify a password and select one or more items to be protected to apply the
security authentication. By default, no action needs password to be taken.

If any action is selected and a password is assigned, you won’'t be able to cause the
action to be taken on the mobile computer without the password.

» A password permits up to 10 alphanumeric characters.

Note: The password is case-sensitive.

Options provided in the [Security Checking] box correspond to the submenus tabulated
as below:
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Security Options Remarks

Settings 3. Utilities | 1. Program Settings

Edit Data 3. Utilities | 2. Browse Data

Delete Data 3. Utilities | 3. Delete Data

Set Date/Time 3. Utilities | 5. Set Date/Time

Load Application 3. Utilities | 6. Load Application

Load Lookup File 3. Utilities | 8. Load Lookup File

Key Click 3. Utilities | 1. Program Settings | 8. Buzzer | 1. Key Click
Barcode Good Read 3. Utilities | 1. Program Settings | 8. Buzzer | 2. Barcode Read
WLAN Setting 3. Utilities | 1. Program Settings | (2" page) 2. WLAN Settings

Upload Port » 3. Utilities | 1. Program Settings | 1. Upload Interface
Download Application Port | 3. Utilities | 1. Program Settings | 2. DL Program Interface
Baud Rate 3. Utilities | 1. Program Settings | 4. Transmission speed
Backlight 3. Utilities | 1. Program Settings | 5. Backlight

Data Deletion 3. Utilities | 1. Program Settings | 6. Set Data Delete

Entry Options 3. Utilities | 1. Program Settings | 7. Entry Options

Warning Beep 3. Utilities | 1. Program Settings | 8. Buzzer | 3. Warning Beep
Download Lookup Port 3. Utilities | 1. Program Settings | 3. DL Lookup Interface
FTP Setting 3. Utilities | 1. Program Settings | (2" page) 1. FTP Settings
Security 3. Utilities | 1. Program Settings | (2" page) 3. Security

FTP Communication 4. FTP

Note: 8200, 8400, 8600 and 8700 allow different download interfaces for template file
(.AGX) and lookup files.
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5.3.2 UPLOAD .AGX

If your Batch AG is a version of 1.00.0005 or later, a password to protect the application
template from any external access by any other computer is configurable by the [Upload
AGX] group box. See Upload Application Template for reference.

Select “Allow upload .AGX” to enable the authentication of any external access to
the .AGX file. Upon selecting “Allow upload .AGX”, you are asked to specify a
password.

» The password allows up to 5 alphanumeric characters.

Note: The password is case-sensitive.
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Chapter 6

On this property page, Startup settings for the application program can be customized.

= [ Application Template | | Startup |
= Application start from [rata Field Properties
g gemggls 1 ®Fam1 O Menu1 Number of Drelimiter ASCI Text:
ymbology
= Meny | | Fart Properties J |44 :| ‘ |
g :;EIDF:UD 2 Font File: |Eng|ish - 4
(=) Smalll10 % 20) () Large[12 » 24) | | ‘ |
Ciolor Properties Browse Data Font Size  (3) Small[10 = 20] () Large[12 » 24)
3 Bockground Color ‘ I c v ‘ DAT File Location (%) SRAM () 5D Card
Faregraund Color: ‘ [ white b ‘
= Prompt Items Defaut Prompt & Message Usger Define Prompt & Message
=) Main benu
Upload
5 Utiities
Miscellaneous
— 6
[ Import Prompts & Messages ]
7 Feset Prompts & Messages to default ]
IN THIS CHAPTER
6.1 Application Start FrOmM .......oooiiiiiiii i 106
6.2 FONT Properties ... ..o 107
6.3 COolor Properties ... ..ot e 108
6.4 Data Field Properties ......cooveeiiiiiiii i 108
6.5 Redefine Prompts & MeSSages ....cvvvviiiiiiiiiiiiiiieeeiaannnn, 109
6.6 Import Prompts & MeSSagesS .....vvvvviiiiiieeiiiiiiaaaaaaeeeas 109
6.7 Reset Prompts & Messages to Default .......................... 109
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6.1 APPLICATION START FROM

By [Application start from] group box, you can proceed to make the following settings:

Decide where the application program starts as soon as the menu item 1. Collect data
is selected on the mobile computer.

> Form 1
> Menu 1
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6.2 FONT PROPERTIES

The Font File drop-down menu that allows users to select a language is available in
AG8200, AG8400, AG8600, and AG8700.

The table below lists the font files supported. Once the font file is determined here, the
Selected Font File item on Form/Menu property pages will be changed accordingly.

Font File Language Double-byte Single-byte

Traditional Chinese

<

Simplified Chinese

AN

Korean

AN

Japanese

English (Default)
Canadian French
Hebrew

Latin (Slovak)

Nordic

Portuguese

Cyrillic (Russian) (CP-1251)
Turkish

Windows 1250

Greek (CP-737)

Greek (Windows-1253)

NN N N N N VRN VN

With the Font File item set to a single-byte language, when the small/large font size
radio button is toggled, the Font Size Warning dialog box will show up. Users can
determine whether to change font size for browser data, forms and menus.

Font Size Warning §|

The Font size can also be changed in Browser Data, Forms and
Menus,

Select the Font Size
Browser Data:

(%) 5mall (8 = 163 (CiLarge (12 % 16)
Menu

(%) 5mall (8 = 163 (CiLarge (12 % 16)

Farm
(%) Small (& x 16) CiLarge (12 x 16)

Ok ] [ Zancel
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With the Font File item set to a double-byte language, when the small/large font size
radio button is toggled, a message box will pop up warning that font properties will be
applied to forms, menus, and browsing data.

Warring

] Al of Font properties will be applied ko Farms, Menus and Data Erowsing!
. The excessive prompts will be truncated!

With the Large radio button selected, when the Font File item is changed from
double-byte languages to single-byte languages, a message box will pop up warning that
a single line on the screen can display only 13 characters and the excessive prompt will
be truncated.

Warring

] one line on the screen can display only 13 charackers,
. The excessive prompt is truncated,

6.3 COLOR PROPERTIES (8600 ONLY)

Click the drop-down menus to determine background & foreground colors of the startup
for the 8600 mobile computer.

6.4 DATA FIELD PROPERTIES

6.4.1 NUMBER OF DELIMITER

The input data will be saved as transaction records. Specify the delimiters used to
separate data fields, either in ASCII code or text. It allows using up to two different
delimiters. Type the ASCII code for a delimiter and its corresponding character will be
shown automatically, and vice versa.

6.4.2 BROWSE DATA FONT SIZE

You may select to use small/large font for data browsing when the Font File item is set
to single-byte languages.

Note: This selection is not available for 8500 model.

6.4.3 DAT FILE LOCATION

You may specify the location to store the DAT files. The options are as follows:
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> SRAM
» SD Card

Note: This selection is not available for 8000/8300/8500 models.

6.5 REDEFINE PROMPTS & MESSAGES

For non-English environment, all the prompts and messages need to be re-defined in
your local language. In addition, the appropriate font file has to be downloaded to the
mobile computer so that it can display the prompts and messages correctly. Refer to
Localization.

6.6 IMPORT PROMPTS & MESSAGES

If the prompts and messages have already been re-defined with an existing template file,
simply click this button to import the template file.

6.7 RESET PROMPTS & MESSAGES TO DEFAULT

Click this button to load the default prompts and messages settings.

Note: The current settings will be cleared.
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UTILITIES

Chapter 7

These utilities are available in the Tools menu inside the 8 Series Batch AG program, or
can be accessed via Start | All Programs | CipherLab | Forge | Batch | Utilities. For
experienced programmers to issue a command or run a script, refer to Appendix V

Command Line Syntax.

Shortcut Name of Utility | Program Name Usage

AG_Load AG_Load.exe To download the current application template to the
mobile computer.

AGX_Read AGX_Read.exe To upload the current application template from the
mobile computer.

Data_Read Data_Read.exe To receive data via Data_Read utility. It also
synchronizes date/time on every host connection.

DLookup DLookup.exe To download associated lookup file(s) to the mobile
computer

Prog_Load ProgLoad.exe To download the AG runtime or font file (.SHX) to
the mobile computer.

Simulator Simulator.exe To launch the simulator.

DBF_Converter DBF_Converter.exe To convert text file into DBF file.

IN THIS CHAPTER

7.1 Download UtIHTIeS ..o 112

7.2 Upload UtIlIties ..o 120

7.3 SD DBF CONVEITer. ... 126

7.4 Program Simulation..........cccoiiiiiii i 128
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7.1 DOWNLOAD UTILITIES

7.1.1 AG LOAD

Without the need to run the Batch or WLAN Application Generator programs, you can use
AG_Load.exe to download a template file to your mobile computer.

& Download AG v2.07 x|

File Type :

|
File name : Browse... | 2

C:\Documents and Settings\8400_AGX

Download via : IRSEBE,.-‘IrDA,.-’USB ‘-.-'CGMj 3
COM port : ICGM24 j
Refresh |
Baud rate : |1152IIIIZI bps j
Comfigures., |

0K Cancel
4 |
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Run AG_Load.exe
1. In the File Type box, select the file type of the target AG template file.

File Type Description
The AGX format is used by the template file of Forge Batch AG
ATX filas program for 8000/8200/8300/8400/8500/8600/8700 Series Mobile
ATF files Computers.
AGH files The ATX format is used by the template file of Batch AG program
AG711*.exe for 711 Mobile Computer.
ATF files
AGKfiles The ATF format is used by the template file of WLAN AG programs for
AT files 8000/8200/8300/8400/8500/8600/8700 Series Mobile computers.

2. In the File name box, type the file path where the AG template file is located.

Otherwise, click Browse to locate the AG template file you want to download. Click Open in
the dialog box as shown below.

open 21 x|
|Lﬂuk in: I@;’-‘-.GSamples j = I'fF *

31 Default_Chinese. AGX
31 Default_Simplified_Chinese, AGY

File name: 8000Default AGX | Open

Files of type: AGX files (" AGX) | Cancal “‘L
74
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3.

4.

114

In the Download via box, select the download interface.

Download via Description

RS232/IrDA/USB VCOM N
Cradle-IR
MODEM

RS-232/1rDA/USB VCOM is available on 711/8000/8200/8300/8400/
8500/8600/8700 Series Mobile Computers.

» Proceed to configure COM port (1~255) and baud rate settings.

RS232/IrDA/USB VCOM Cradle-IR interface is available on 711/8000/8300/8500 Series
Mobile Computers. Cradles or IR-Transceivers are required.
MODEM

» Proceed to configure COM port (1~255) and baud rate settings.

RS232/IrDA/USE VCOM Modem interface is available on 8000/8200/8300/8400/8500 Series
Cradle-IR Mobile Computers. Modem Cradles are required.

» Proceed to configure modem if necessary.

% Download AG v2.07

File Type : IAGX files j

File name : Browse... |

C:\Documents and Settings\8400_ AGX

Download via : MODEM -

COM part |coma4 =

Fefrest |

Baud rate | | 115200 bps B

Configure... [}J

oK Cancel |

Click OK to start the download process.



7.1.2 DLOOKUP

Chapter 7  Utilities

Without the need to run the Batch Application Generator programs, you can use

DLookup.exe to download a lookup file to your mobile computer.

& Download Lookup: v2.04

File name :

nd Settings\carmie\Deskto

Download via :

Browse... |

\Float-Point by

|Rs2320rDA x|

COM port: 24 . (17~255)
Baud rate | 115200 bps |
Configure... |

OK Cancel

Note: (1) For 8200/8400/8600/8700, USB Virtual COM shares the interface option of

RS-232/1rDA.

(2) Cradle-IR is not supported on 8200/8400/8600/8700.
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Run DLookup.exe

1.

In the File name box, type the file path where the lookup file is located.

Otherwise, click Browse to locate the lookup file you want to download. Click Open in the
dialog box as shown below.

2.

116

open 2| x|

Look in: IB Lookup files j = ¥ B3~

E] Lookup_1.txt
E] Lookup_2. txt
E] Lookup_3.txt
. Lookup_Demo. TXT

File name: ILDDI-:up_DemD.'I'}ﬂ' Cpen

L] Lo

Files of type: ILD:::kup data files = TXT} Cancel

In the Download via box, select the download interface.

Download via Description

RS232 or IrDA k RS-232 or IrDA interface is available on 711/8000/8200/8300/8400/
Cradle-IR 8500/8600/8700 Series Mobile Computers.

MODEM » Proceed to configure COM port (1—255) and baud rate settings.
RS232 arlrDA Cradle-IR interface is available on 711/8000/8300/8500 Series Mobile
Cradle-IR k Computers. Cradles or IR-Transceivers are required.

MODEM » Proceed to configure COM port (1—255) and baud rate settings.
RS232 arfDA Modem interface is available on 8000/8200/8300/8400/8500 Series
Cradle-R Mobile Computers. Modem Cradles are required.

» Proceed to configure modem if necessary.




3.

& Download Lookup: v2.02

Chapter 7  Utilities

x|

File name :

Erowse... |

Utilities\Lookup files\Lookup_Demo TAT

COfA o

Baud rate

MREYI -
[ (e

Download via

[ 115200 bps

M

Canfigure... \J
|

)

OK

Cancel

Click OK to start the download process.

117



FORGE Batch Application Generator User Guide

7.1.3 PROGLOAD

Without the need to run the Batch or WLAN Application Generator programs, you can use
ProgLoad.exe to download a program (*.SHX, *.SYN or *.BIN) to your mobile

computer.
Program download (Ver. 1.23) X|

~Comm settings
Comm type : HS—232 { IrDA 'l 1
COM port : |1 3: [17255]

Baud rate : [115200 bps =
—File option
File type : |.sHX file |

File name : Browse |

IC:\Ducuments and Settings\carrie.CIPH

OK Exit

Note: (1) For 8200/8400/8600/8700, USB Virtual COM shares the interface option of
RS-232/1rDA.
(2) Cradle-IR is not supported on 8200/8400/8600/8700.
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Run ProglLoad.exe

1. Inthe Comm type box, select the download interface.

Comm Type Description

RS-232/1rDA Connection via direct RS-232 cable, IrDA port, or Bluetooth SPP
Cradle-IR Connection via cradle

TCP/IP Connection over networks

2. Click the File type drop-down menu to determine the file format. Then in the File name box,
type the file path where the program file is located.

Otherwise, click Browse to locate the program file you want to download. Click Open in the
dialog box as shown below.

File Type Description
.SHX file Any C program, such as AG Runtime, BASIC Runtime, font file, etc.
.SYN file Any BASIC program after BASIC Runtime has been installed on the

mobile computer.
.BIN file Any C program

> Use PC utility “SHX2Bin.exe” to convert the program (.shx
> .bin).

3. Click OK to start the download process.
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7.2 UPLOAD UTILITIES

7.2.1 DATA_READ

Data_Read.exe enables users to receive the data file(s) from the mobile computer
without running the Batch AG. However, if you want to upload data files over the network
via Ethernet Cradles, use the Remote Console utility instead.

With the upload interface properly configured among Cradle-IR, RS-232 or USB VCOM,
the Data_Read.exe supports automatic data uploading to a host computer. Once the
mobile computer is seated in the cradle or connected via the RS-232 or USB Virtual COM
cable, there will be a running dot or hourglass icon displaying on the upper-right corner
of the screen indicating the mobile computer’s readiness for auto upload. Make sure the
interface on the mobile computer is matching.

Auto Upload Support 8000 8200 8300 8400 8500 8700

Interface Required | Cradle-IR RS-232 Cradle-IR RS-232 Cradle-IR RS-232
UsB RS-232 usB usB
VCOM VCOM VCOM

% Data read Ver 1.29

Fropertiez Communication Parameters
1 I Display data via keyboard erulation Interface : RS232A0ASE YEOM L] 3
[¥ Save datatafile e
Savemode ;| Ovenarite j
[v Wiew the received data. SRl A J hsens
v &dd Line-Feed character ta each record. Blaud rate - lm

lv &dd Carriage return to each record.

=

[~ Keep online for receiving data automatically.

Corwert Test file bo Excel format

File Mame rule [7.tat]

* Generated Automatically Pralling time z il (17333 sec)

(" Generated according to the first record

" Customized

Browse

Optionz v Auto upload and delete Data and Lookup files
¥ Upload Data files 4
Fram |Dala file1 Li To |Data file10 ﬂ

- Create a log file when mistakes accured during transsmission data W' Upload Lookup files
between COM port and file. From |Lockupfiel = | To |Lookupfled |

[~ Delete all Data files

Diirectory :

v Abwaps show thiz dialog box.

™ Delete all Lookup files

5 ok | Cancel
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Run Data_Read.exe

1. In [Properties] dialog box, decide whether to display data via keyboard emulation or save data
to file. Options available are:

> Display data via keyboard emulation:

> Data is emulated as typed text and sent to the active window on the host. Open a text editor
on the host to receive the data. In the Inter-character delay spin box inside the
[Communication Parameters] group box, type or select a value that matches the computer
response time of the keyboard interface. Such delay time is inserted between every two
characters being transmitted. The longer the delay time is, the slower the transmission speed
will be.

) Save data to file:

> Select this item to save the received data to the host computer’s storage. The received data
are saved to text files (.txt). Two saving modes are provided:

Save Mode Description

Overwrite Overwrite: If the file name you give is the same as of an existing file,
the uploaded data will overwrite the original data. Otherwise, it will
create a new file.

Append Append: If the file name you give is the same as of an existing file,
the uploaded data will be appended to the original data. Otherwise, it
will create a new file.

> To append data to file automatically, the best practice requires
specifying reasonable polling time with Keep online for
receiving data automatically enabled.

> A [Convert text file to Excel format] button is featured with “Save data to file” to facilitate
the conversion of the received data to an Excel file. Click this button to access the data
conversion setting.

) “Save data to file” involves the setting of “File Name rule”. The “File Name rule” setting
features the following options:

Option Function

Generated The uploaded data will be saved to the specified directory with a file

automatically name that is automatically generated based on the system date and
time.

> The best practice requires specifying reasonable polling time with
Keep online for receiving data automatically enabled.

Generated The received data will be saved to a file named by its first record.
according to the N

first record For example, in Batch Application Generator you may design Form

1 to allow only one line for a specific file name and proceed to
other forms for collecting data. Thus, the first record will be used
to keep its file name. Depending on Save mode, if the file name
you give is the same as of an existing file, the uploaded data will
overwrite or append to the original data.

Customized If you select to customize own rule, type the file path where the data
file will be saved to. Otherwise, click Browse to select which directory
the data file is saved to.

» Add Line-Feed character to each record:
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Adds a line-feed character to each transaction entry. Disable/enable it if necessary.
Add Carriage return to each record:

» Adds a carriage return control character to each transaction entry. Disable/enable it if
necessary.

2. The [Options] group box encloses the settings how the Data_Read.exe acts each time it is used
and what it responds to a data transmission error that comes up.

The options available are:

Option Description

Always show this dialog box | Sets the Data_Read.exe to show its window each time it is run.

Users are able to access the settings to receive data prior to the
act.

Deselecting it to have the Data_Read.exe directly receive data
from the mobile computer without showing its window. Note the
window won’t be able to recur unless the software’s .ini file is
deleted from the directory where the Data_Read.exe is
installed. And once the .ini file is deleted, the software’s
configuration is gone.

> This is selected by default.

Create a log file when Select it to set the Data_Read.exe to create a log file when one
mistakes occur during of the following comes up:

transmission da}ta between » The Batch AG fails to write data to the assigned file.

COM port and file

» The Batch AG fails to open the COM port.
» Data receiving time out.

Normally the log file is accessible at the directory where the
Data_Read.exe is installed.

3. In the Interface box under Communication Parameters, select the upload interface.

Interface Description
52"DMUSE VCOM k RS-232/1rDA/USB VCOM is available on 711/8000/8200/8300/8400/
Moden - TAP| 8500/8700 Series Mobile Computers.
Madsm - COM

— » Proceed to configure COM port (1—-255) and baud rate settings.
R5232/rDA/USE VCOM Cradle-IR interface is available on 711/8000/8300/8500 Series Mobile
Madam - TAPI Computers. Cradles or IR-Transceivers are required.
Modem - COM

> Proceed to configure COM port (1—-255) and baud rate settings.
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R5232/rDA/USE VCOM Modem interface is available on 8000/8200/8300/8400/8500 Series
Cradle-IR . .
Mobile Computers. Modem Cradles are required.
Modsm - COM
oo > Select Modem-TAPI when using TAPI-compliant communication
application on the host computer. Proceed to configure modem if
necessary.
— Communication Parameters
Interfase Modem - TAPI
Modem corfigure
(I | Y e |1 _I: [ = 255]
Blaud rate 115200 bps -
Inter-characten delay’: Ié _I: [0 = 255 ms|
[~ Keep online for receiving data automatically.
Palling time : |2 _I: (175599 sec)
R5232/IrDA/USE VCOM Modem interface is available on 8000/8200/8300/8400/8500 Series
Cradle-IR . .
Madsm - TAPI Mobile Computers. Modem Cradles are required.

> Select Modem-COM when using COM port based modem, and
proceed to configure COM port and baud rate settings.

r—Communication Parameters

Interface : Modem - COM

Madem canfigure |
COM port : |1 _I: (1~ 255)
Baud rate : |1152DD bps vl

Inter-characten delay’: Ié _I: [0 = 255 ms|

[~ Keep online for receiving data automatically.

Palling time : |2 _I: (175599 sec)

4. Tick [Auto upload and delete Data and Lookup files] to configure whether to upload/delete

data and lookup files.

Option

Description

Upload Data files/lookup
files

Tick the upload checkboxes to enable the associated pull-down

menus to automatically upload the data files and lookup files to
the host computer especially when working with a Charging and
Communication Cradle. Click the pull-down menus to designate
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data files to be uploaded. Please note that the index of the last
file can’t be higher than the first one.

Delete all Data/Lookup files Tick the checkboxes to delete all Data/Lookup files

5. Click OK to start the upload process.
7.2.2 AGX_READ

When using the Forge Batch AG version 1.00.0005 or later to create and download a
template file, it may be configured to allow uploading the template file from the mobile
computer at a later time.

Without the need to run the Batch Application Generator programs, you can use
AGX_Read.exe to receive a template file (*.AGX) from your mobile computer.

- AGX Read »1.00.0005 ﬂ
File Properties
1 Cirecton: CACIPHERLABWFORGEBATCH! J
File name:
> Fazzward: (5 digitz)
T
— Communication Parameters
3 Interface: ICradIe—IH j
COM port: |1 :I (1 ~ 255)
Baud rate: I‘I 15200 bps j
Cancel |
4 i

Note: Cradle-IR is not supported on 8200/8400/8600/8700.
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Run AGX_Read.exe

1. In the Directory text field, type the file path where the .AGX file is to be saved.

Otherwise, click J to locate where to save the file. You may change the file name as well
2. In the Password field, enter the correct password for access to the template file.

3. Click the Interface drop-down menu to select the upload interface.

Interface Description

RS-232/1rDA/USB Connection via direct RS-232 cable, IrDA port, or USB Virtual COM
VCOM

Cradle-IR Connection via cradle

4. Click OK to start the download process
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7.3 SD DBF CONVERTER (8200/8400/8600/8700 ONLY)

8200, 8400, 8600 and 8700 supports accessing template files (.AGX) and lookup files
from the SD card installed in the mobile computer.

The DBF Converter serves to convert a .txt lookup file to DBF format (.DBO, .DB1) and in
the meanwhile duplicates the lookup file to the SD card installed in the mobile computer.

Tick the “Distribute” checkbox to duplicate the lookup file (DBF format) to the SD card.

Note: The default working directory is “\AG\DBF”, which will be created on SD card
automatically.

%% 5D DBF Converter V1.00.0001 |

B Source lookup file

1 File name : I Browse... |

— Lookup properties

[™ Getting lookup properties from AGX file Field Offset Length Key field

| Erowvee .., | L I I E

2 |0 [ | j 72 I I E

#3 | | c

#4 | | c

Mumber of fields : ID_:I' =5 I I e

¥ Fixed length 26 | | I

" Delimiter [44 =5 | . | =

#8 | | C

Qutput DBF file
’_ v Convert

3 File narme : I Browse... |

4 |V Distribute

DBF file : Ilst DBF fila v|

I) For the source lookup file, click the [Browse] button to locate a text file (.TXT).

2) For the lookup properties, specify from scratch or select a template file ((AGX) and
the target lookup file. For the latter, the properties will be loaded automatically.

3) For the output DBF file, make sure to select the check box of [Convert] and
[Distribute].
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» Specify a file name or locate an existing DBF file to save the result files on your
PC.

4) On 8200/8400/8600/8700, select 3. Utilities | 8. Load Lookup File and identify the
lookup file.

Note: The download interface must be set to “SD”. Refer to 5.1.6 Download Method.

5) Click [Go].
» It will convert the source file to DBF format and save the result files on PC side.

» If you have selected the check box of [Distribute], it will automatically copy the
result files to the import directory “\AG\DBF” on SD card.

6) On 8200/8400/8600/8700, press [Enter] to confirm copying files to SD card and
checking DBF format.

» Depending on the DBF location specified in the template file, it will either (1) load
the associated lookup file(s) to SRAM via SD card, or (2) keep the files on SD card
for direct access. Refer to 3.2.4 DBF File Location (8200/8400/8600/8700 Only).

Note: It is suggested that you check DBF format upon completion of downloading lookup
files.
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7.4 PROGRAM SIMULATION

When you have completed the entire configuration, you may click Tools | Simulator to

run the program simulator and verify whether these program sequences meet your
requirements.

BB Forge AG B300 [ New File ]

File Tranzfer | Toole Language Help

DBF Cunveg |

Collect Data

Main Menu

1 .Collect

‘ Startup \ Settings Symbology Menu Lookup Form

Startup Settings Symbology ‘ Mernu \ Lookup ‘ Form \
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Upload Data

No simulation.

» Refer to 1.2.3 Record and 3.3.2 Lookup Data Can Be Uploaded. Normally, it will proceed to
connect via the selected upload port.

» Refer to 5.1.1 Data Manipulation for “Data Deletion” upon completion of uploading data.

E |IE|E EH [E|E
Startup Symbology Menu
Utilities

Only partial simulation is allowed.

2.Upload

E E E | E E H

Startup Settings Syrmbalogy Menu Lookup Farri

Note: If a lookup file is specified in use on the Lookup property page, 3. Utilities | 8.
Calculator will be replaced by 3. Utilities | 8. Load Lookup File after you have
downloaded the template file to the real mobile computer.
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Appendix |
SCAN ENGINE SETTINGS

The FORGE Batch Application Generator allows configuring the following reader types,
depending on the module equipped on your mobile computer:

8000 | 8200 | 8300 | 8400 | 8500 | 8600 | 8700
Barcode Reader
1D CCD Scan Engine v v v
1D Laser Scan Engine v v v v v v v
1D Long Range Laser Scan Engine (LR) | * x v x v x v
1D Extra Long Range Laser Scan x x x x v x x
Engine (ELR)
2D Scan Engine x v x v v v v
RFID Reader
ACG_RFID Module v0.9 x x x x v x x
ACG_RFID Module v1.0 x x 4 x x x
HF RFID Multi-1SO v1.2.2 x x x x x v v

Options of different reader combination are allowed, such as 1D+RFID and 2D+RFID. For
each combination, both readers can be initialized and ready for scanning at the same
time (dual mode operation). For example, if you press the [Scan] button while running
the AG run-time program on the mobile computer, it will read a barcode in position or an
RFID tag in proximity depending on which one comes first.

Note: You cannot have 1D+2D scan engines installed on the mobile computer because
they are both barcode readers!
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SYMBOLOGIES SUPPORTED

Varying by the scan engine installed, the supported symbologies or tag types are listed
below. For details on configuring associated settings, please refer to each Appendix

separately.

CCD, Laser |LR, ELR 2D
Codabar v v
Code 11 x (v)Note

Note: Code 11 supported on LR, ELR scan engine is for 8300 only.

Code 93 v v

Composite Code x x

MSI v v

Plessey v x x

Postal Codes x x v

Telepen v x x

Code 128 Code 128 v 4 v
GS1-128 (EAN-128) v v v
ISBT 128 v v v

Code 2 of 5 Industrial 25 (Discrete 25) v v v
Interleaved 25 v v v
Matrix 25 4 x (v)Nete
Chinese 25 x x (v)Nete
Coop 25 (v)Note x x

Note: (1) ISBT 128 is not supported for 8600.

(2) Matrix 25 and Chinese 25 are supported on 2D scan engine for
8200/8400/8600/8700 only.

3 Coop 25 is supported on CCD/Laser scan engine for
8000/8200/8300/8400/8600/8700 only.
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Code 3 of 9 Code 39 v v v
Trioptic Code 39 x v v
Italian Pharmacode (Code 32) 4 v v
French Pharmacode v x x
EAN/UPC EAN-8 v v v
EAN-13 4 v v
Bookland EAN (ISBN) v v v
UPC-EO v v v
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Scan Engine Sett

ings

UPC-E1

UPC-A

GS1 DataBar
(RSS)

GS1 DataBar Omnidirectional (RSS-14)

GS1 DataBar Truncated

GS1 DataBar Stacked

GS1 DataBar Stacked Omnidirectional

GS1 DataBar Limited (RSS Limited)

GS1 DataBar Expanded (RSS Expanded)

GS1 DataBar Expanded Stacked

NINERNERBERERERRER

NINERNERBERERERERER

2D Symbologies

PDF417

x

x

MicroPDF417

Data Matrix

Maxicode

NIIENIEN RN RN RN RN RN RN IRV RN RN RN

QR Code

MicroQR

(‘/) Note

Aztec

(‘/) Note

Note: MicroQR and Aztec are supported on 2D scan engine for 8200/8400/8600/8700

only.
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RFID TAGS SUPPORTED

The RFID reader supports read/write operations depending on the tags. The supported
labels include ISO 15693, Icode®, I1SO 14443A, and ISO 14443B. Currently, the
performance of some tags has been confirmed, and the results are listed below for your
reference. The results found with RFID module version 1.0 are different from those found
with version 0.9 or older versions.

Note: You should study the specifications of RFID tags before use. The "Write Page"
functionality may not be supported.

HF RFID Multi-ISO Version 1.2.2 UID Only Read Page Write Page*

1SO 14443A Mifare Standard 1K (Mifare 4 v v
S50)

Mifare Standard 4K (Mifare v v v
S70)

AN
AN
<

Jcop 41 only the (Mifare 1K &
4K compatible)

Mifare Ultralight

Mifare Ultralight C

Mifare ProX

Mifare DESFire

Mifare Plus

Mifare Mini (Mifare S20)
SLE66CLX320P
SLE55R04 / 08

Smart MX

Jewel

Topaz

1SO 14443B SLE6666CL160S
SR176
SRIX4K

SLIX 4K

Dual 1SO 14443A compliant

1SO 14443B compliant

1SO 15693 EM4135

ICode SLI

LRI12

LRIG4

NIIEN RN RN RN RN RN RN RN RN RN RN IRV RN RN RN ERNY RN IRNY RN IRV IR

LRI128
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Scan Engine Settings

LRI2k

SRF55VXxP

SRF55VxxS

Tag-it HF-1 Std

S SN X

AN N NI RN

TempSense

ICODE1 with EAS&AFI

Icode

NINERNEBNEERER

ACG_RFID Module

Version 1.0

=
O
o
>
<

Read Page

Write Page*

1SO 14443A

Mifare Standard 1K

v

v

Mifare Standard 4K

v

Mifare Ultralight

v

Mifare DESFire

Mifare S50

SLE44R35

SLEG66R35

1SO 14443B

SRIX 4K

SR176

1SO 15693

ICODE SLI

SRF55V02P

SRF55V02S

SRF55V10P

TI Tag-it HF-1

ICODE®
(Phillips)

ICODE

NIRRT

ACG_RFID Module

Version 0.9

UID Only

Read Page

Write Page*

1SO 14443A

Mifare Standard 1K

Mifare Standard 4K

Mifare DESFire

Mifare S50

SLE44R35

SLEG66R35

NINERRE
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1SO 15693

ICODE SLI

SRF55V02P

SRF55V02S

SRF55V10P

Tl Tag-it HF-I

ST LRIG4

ST LRI512

Tagit®

Tagit

ICODE®
(Phillips)

ICODE

NERNEBNERERRERERR

DN I N N I N N RN

AN N I N B NI EANE
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CCD/LASER SCAN ENGINE

The tables below list reader settings as well as symbology settings for the CCD or Laser

scan engine.

READER SETTINGS TABLE

CCD/Laser Engine

Description Default

Scan Mode

Laser mode

Continuous Mode

Non-stop scanning

> To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode

Non-stop scanning

» Capable of decoding the same barcode repeatedly

Repeat Mode

Non-stop scanning

> Capable of re-transmitting barcode data if triggering within one second
after a successful decoding

Momentary Mode

Hold down the scan trigger to start with scanning.

» The scanning won't stop until you release the trigger.

Alternate Mode

Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.
» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.
Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode

Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Auto Power Off Mode

Press the scan trigger to start with scanning.

» The scanning won't stop until the preset timeout expires, and, the
preset timeout period re-counts after each successful decoding.
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Read Redundancy

None

None

No redundancy means one successful decoding will make the reading valid
and induce the "READER Event".

One time, Two times,
or Three times

The higher the reading security is (that is, the more redundancy the user
selects), the slower the reading speed gets.

> If "Three Times" is selected, it will take a total of four consecutive
successful decodings of the same barcode to make the reading valid.

Time-out

3 sec.

0~255 (second)

Set the maximum time for decoding to continue during a scan attempt. It
applies to the following scan modes only —

» Aiming mode

> Laser mode

» Auto Off mode

» Auto Power Off mode

Aiming Duration

3 sec.

1—~255 (second)

Set the maximum time for decoding to continue during a scan attempt.

> It applies to Aiming mode only.

Note: Aiming Duration is supported on CCD/Laser scan engine for
8000/8200/8300/8400/8500/8600/8700 only.
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CCD/Laser Scan Engine

SYMBOLOGY SETTINGS TABLE

CCD/Laser Engine Description Default
Codabar Enable
Transmit Start/Stop Decide whether to include the start/stop characters in the |No
Character data being transmitted.
If "Transmit Start/Stop Characters" is desired, select one
set:
» abcd / abcd
» abcd / tn*e
» ABCD / ABCD
» ABCD / TN*E
Code 128 Enable
GS1-128 Enable
Transmit Code ID (for |[Decide whether to include Code ID (*]C1”) will be included |No
GS1-128) in the data being transmitted.
Replace Field Decide whether to replace the field separator. If the No
Separator barcode contains Field Separator “Ox1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“Ox1D”, it will be changed to “;”.
ISBT 128 Enable
Industrial 25 (Discrete 25) Enable
Start/Stop Selection This decides the readability of all 2 of 5 symbology Industrial 25
variants. For example, flight tickets actually use an
Industrial 2 of 5 barcode but with Interleaved 2 of 5
start/stop pattern. In order to read this barcode, the
start/stop pattern selection parameter of Industrial 2 of 5
should set to "Interleaved 25".
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Select Length » One or two fixed lengths 1-127
> Range
Interleaved 25 Enable
Start/Stop Selection Refer to Industrial 25. Interleaved
25
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes

transmitted.
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Select Length » One or two fixed lengths 1~-127
» Range
Matrix 25 Disable
Start/Stop Selection Refer to Industrial 25. Matrix 25
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Select Length > One or two fixed lengths 1-127
» Range
Coop 25 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Note: Coop 25 is supported on CCD/Laser scan engine for
8000/8200/8300/8400/8600/8700 only.
French Pharmacode Disable
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Italian Pharmacode (Code 32) Disable
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.

Note: For French/Italian Pharmacode, “Transmit Start/Stop Character” is not provided in
Ul but it is controlled by the same setting of Code 39.

Code 39 Enable

Transmit Start/Stop Decide whether to include the start/stop characters "*" in | No

Character the data being transmitted.

Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.

Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and No
special characters.

Code 93 Enable
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CCD/Laser Scan Engine

MSI

Disable

Verify Check Digit

Select one of the three calculation formulas to verify the
check digit. If the check digit is incorrect, the barcode will
not be accepted.

» Single Modulo 10
» Double Modulo 10
» Modulo 11 & 10

Single Modulo
10

Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

> Last digit not transmitted

Both digits
transmitted

» Both digits transmitted
» Both digits not transmitted
Select Length » One or two fixed lengths 1-127
» Range
Negative Barcode Enable
Plessey Disable
Convert to UK Plessey |When applied, each occurrence of the character "A" in the [No
barcode data will be replaced by the character "X".
Transmit Check Digit Decide whether to include the two check digits in the data |Yes
being transmitted.
Telepen Disable
Original Telepen The original Telepen includes numeric characters. No
(Numeric)
AIM Telepen (Full AIM Telepen (Full ASCII) includes all the alphanumeric and | Yes
ASCII) special characters.
GS1 Databar-14/Expanded Disable
GS1 Transmit |Decide whether to include Code ID ("]e0™) will be included |Yes
Databar-14 |Code ID in the data being transmitted.
GS1 DataBar-14 is short for GS1 DataBar Omnidirectional.
This group consists of (1) GS1 DataBar Omnidirectional,
(2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and
(4) GS1 DataBar Stacked Omnidirectional.
GS1 Transmit |Decide whether to include Code ID (*]e0") will be included
Databar Code ID in the data being transmitted.
E . .
xpanded This group consists of (1) GS1 DataBar Expanded, and (2)
GS1 DataBar Expanded Stacked.
Transmit Application Decide whether to include the Application ID ("01") in the |Yes
ID data being transmitted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes

transmitted.
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GS1 Databar Limited Disable
Transmit Code ID Decide whether to include Code ID (*]e0") will be included |Yes
in the data being transmitted.
Transmit Application Decide whether to include the Application ID ("01") in the |Yes
ID data being transmitted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the |No
next processing will follow the settings configured for
EAN-13.
» After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Addon 2 / Addon 5 Decide whether to decode EAN-8 with supplementals. No
EAN-13 & UPC-A Enable
ISBN Conversion The EAN-13 barcode starting with 978 and 979 will be No
converted to ISBN.
ISSN Conversion The EAN-13 barcode starting with 977 will be converted to |No
ISSN.
GTIN for EAN-13 The EAN-13 barcode will be expanded into 14-digit Global |No
Trade Item Number (GTIN).
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Addon 2 / Addon 5 Decide whether to decode EAN-13/UPC-A with No
supplementals.
(UPC-A) Convert to The UPC-A barcode will be expanded into EAN-13, and the |Yes
EAN-13 next processing will follow the settings configured for
EAN-13.
» After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
(UPC-A) Transmit Decide whether to include the UPC-A check digit in the Yes
Check Digit data being transmitted.
(UPC-A) Transmit Decide whether to include the UPC-A System Number in Yes
System Number the data being transmitted.
UPC-E (= UPC-EO) Enable
Convert to UPC-A The UPC-E barcode will be expanded into UPC-A, and the No

next processing will follow the settings configured for
UPC-A.

) After conversion, the data follows UPC-A format and is
affected by UPC-A programming selections (e.g.
System Number, Check Digit).
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Transmit Check Digit Decide whether to include the UPC-E check digit in the Yes
data being transmitted.

Transmit System Decide whether to include the UPC-E System Number in No

Number the data being transmitted.

Addon 2 / Addon 5 Decide whether to decode UPC-E with supplementals. No

UPC-E1 Disable

UPC-E1 Triple Check Decide whether to apply read redundancy to the UPC-E1 No
barcode. If true, the same UPC-E1 barcode has to be read
three times to make a valid reading.

» This is helpful when the barcode is defaced and
requires more attempts to read it successfully.
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LR/ELR LASER SCAN ENGINE

The tables below list reader settings as well as symbology settings for the Long Range
Laser (LR) or Extra Long Range Laser (ELR) scan engine.

READER SETTINGS TABLE

LR/ELR Engine

Description Default

Scan Mode

Laser mode

Continuous Mode

Non-stop scanning

> To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode

Non-stop scanning

» Capable of decoding the same barcode repeatedly

Alternate Mode

Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.
» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.
Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode

Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Time-out

3 sec.

0~255 (second)

Set the maximum time for decoding to continue during a scan attempt.
It applies to the following scan modes only —

» Aiming mode

> Laser mode

> Auto Off mode

Aiming Duration

3 sec.

1~255 (second)

Set the maximum time for decoding to continue during a scan attempt.

> It applies to Aiming mode only.

Note: Scan Mode options and Aiming Duration are supported on Long Range Laser scan
engine for 8300/8700.
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SYMBOLOGY SETTINGS TABLE (8300/8500)

LR/ELR Engine Description Default
Codabar Enable
Transmit Start/Stop Decide whether to include the start/stop characters in the |No
Character data being transmitted.
Select Length » Any Length Any Length
» One or two fixed lengths
» Range (1-55)
Code 128 Enable
GS1-128 Enable
Replace Field Decide whether to replace the field separator. If the No
Separator barcode contains Field Separator “0x1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“Ox1D”, it will be changed to “;”.
ISBT 128 Enable
Industrial 25 (Discrete 25) Enable
Select Length » Any Length Any Length
» One or two fixed lengths
» Range (1-55)
Interleaved 25 Enable
Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the No
following requirements are met:
» The barcode must have a leading 0 and a valid EAN-13
check digit.
Verify Check Digit Decide whether to verify the check digit. If desired, select |No
one of the algorithms below. If the check digit is incorrect,
the barcode will not be accepted.
> No
> USS algorithm
» OPCC algorithm
Transmit Check Digit Decide whether to include the check digit in the data being |No
transmitted.
Select Length > Any Length Any Length
> One or two fixed lengths
» Range (1—-55)
Code 39 Enable
Convert to Code 32 Convert to Italian Pharmacode. No
Verify Check Digit Decide whether to verify the check digit. If the check digit |No

is incorrect, the barcode will not be accepted.
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LR/ELR Laser Scan Engine

Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

» "Verify Check Digit" must be enabled so that the check
digit can be left out (= "Transmit Check Digit"
disabled).

No

Code 39 Full ASCII

Code 39 Full ASCII includes all the alphanumeric and
special characters.

Disable

Trioptic Code 39

Decide whether to decode Trioptic Code 39.

» Trioptic Code 39 is a variant of Code 39 used in the
marking of computer tape cartridges. It always
contains six characters.

Disable

Select Length

Any Length
One or two fixed lengths
» Range (1—-55)

Any Length

Code 93

Enable

Select Length

Any Length
One or two fixed lengths
» Range (1-55)

Any Length

MSI

Enable

Verify Check Digit

If Two Check Digits option is selected, an additional
verification is required to ensure integrity. Select one of
the algorithms below. If the check digit is incorrect, the
barcode will not be accepted.

Check Digit
One Check Digit
Two Check Digits

Algorithm

Single Modulo 10

» Mod 10/Mod 11
> Mod 10/Mod 10

Single Modulo
10

Transmit Check Digit Decide whether to include the check digit in the data being |No
transmitted.
Select Length > Any Length Any Length
> One or two fixed lengths
» Range (1—55)
GS1 Databar -—-
GS1 Databar-14 GS1 DataBar-14 is short for GS1 DataBar Omnidirectional. |Enable
This group consists of (1) GS1 DataBar Omnidirectional,
(2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and
(4) GS1 DataBar Stacked Omnidirectional.
GS1 Databar Limited Enable
GS1 Databar Expanded | This group consists of (1) GS1 DataBar Expanded, and (2) [Enable

GS1 DataBar Expanded Stacked.
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Convert RSS to "Convert to UPC/EAN" only applies to GS1 Databar-14 and [No
UPC/EAN GS1 Databar Limited barcodes not decoded as part of a
Composite barcode.
Convert to EAN-13
Strip the leading "010" from barcodes.
> "01" is the Application ID and must be followed by a
single zero (the first digit encoded)
Convert to UPC-A
Strip the leading "0100" from barcodes.
> "01" is the Application ID and must be followed by
two or more zeros (but not six zeros)
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the |No
next processing will follow the settings configured for
EAN-13.
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
EAN-13 Enable
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Bookland EAN The EAN-13 barcode starting with 978 will be converted to |No
(= Bookland ISBN-10) ISBN.
» Data starting with 979 is not considered Bookland in
this mode.
UPC-A Enable
Transmit Check Digit Decide whether to include the UPC-A check digit in the Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-A preamble System System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
UPC-E (= UPC-EO) Enable
Transmit Check Digit Decide whether to include the UPC-EO check digit in the Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-EO preamble System System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-EO barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
UPC-E1 Disable
Transmit Check Digit Decide whether to include the UPC-E1 check digit in the Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-E1 preamble System System
Number (and Country Code) in the data being transmitted. | Number
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LR/ELR Laser Scan Engine

Addon 2 / Addon 5

Refer to UPC/EAN Addon setting.

Convert to UPC-A

The UPC-E1 barcode will be expanded into UPC-A, and the |No

next processing will follow the settings configured for

UPC-A.

UCC Coupon Extended Code

Disable

Read UPC-A barcodes starting with digit "5", EAN-13 barcodes starting with digits "99", and
UPC-A/GS1-128 Coupon Codes.

» UPC-A, EAN-13, and GS1-128 must be enabled first!

UPC/EAN Addon

Addon 2 / Addon 5

Decide whether to decode EAN-8, EAN-13, UPC-EO, Ignore...
UPC-E1, UPC-A with addons.

4

» Decode Only With Addons
» Decode With Addons (= Auto-discriminate)

Ignore Addons

Code 11

Enable

Verify Check Digit

Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.

»

No verification
One Check Digit
Two Check Digits

Select Length

»
4
4
4
4

Any Length
One or two fixed lengths
Range (1—55)

Any Length

Note: Code 11 is supported on Long Range Laser scan engine for 8300 only.
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SYMBOLOGY SETTINGS TABLE (8700)

LR/ELR Engine Description Default
Codabar Enable
Transmit Start/Stop Decide whether to include the start/stop characters in the |No
Character data being transmitted.

If "Transmit Start/Stop Characters" is desired, select one

set:

» abcd / abcd

» abcd / tn*e

» ABCD / ABCD

» ABCD / TN*E
Code 128 Enable
GS1-128 Enable
Transmit Code ID (for |[Decide whether to include Code ID (*]JC1”) in the data No
GS1-128) being transmitted.
Field Separator Decide whether to replace the field separator. If the No
Replacement barcode contains Field Separator “Ox1D”, it will be

changed to the desired Field Separator. For example, type

the desired character “;” (semicolon) as the new field

separator. Then if the barcode contains Field Separator

“Ox1D”, it will be changed to “;”.
ISBT 128 Enable
Industrial 25 (= Discrete 25) Enable
Start/Stop Selection This decides the readability of all 2 of 5 symbology Industrial 25

variants. For example, flight tickets actually use an

Industrial 2 of 5 barcode but with Interleaved 2 of 5

start/stop pattern. In order to read this barcode, the

start/stop pattern selection parameter of Industrial 2 of 5

should be set to "Interleaved 25".
Verify Check Digit Decide whether to verify the check digit. If the check digit |No

is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes

transmitted.
Select Length » One or two fixed lengths 1-127

> Range
Interleaved 25 Enable
Start/Stop Selection Refer to Industrial 25. Interleaved

25

Verify Check Digit Decide whether to verify the check digit. If the check digit |No

is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes

transmitted.
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LR/ELR Laser Scan Engine

Select Length > One or two fixed lengths 1-126
» Range
Matrix 25 Disable
Start/Stop Selection Refer to Industrial 25. Matrix 25
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Select Length > One or two fixed lengths 1-127
» Range
Coop 25 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
French Pharmacode Disable
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Italian Pharmacode (= Code 32) Disable
Transmit Check Digit Decide whether to include the check digit in the data being | Yes

transmitted.

Note: For French/Italian Pharmacode, “Transmit Start/Stop Character” is not provided in
Ul but it is controlled by the same setting of Code 39.

Code 39 Enable
Transmit Start/Stop Decide whether to include the start/stop characters "*" in | No
Character the data being transmitted.
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and Disable
special characters.
Code 93 Enable
MSI Disable

Verify Check Digit

Select one of the three calculation formulas to verify the
check digit. If the check digit is incorrect, the barcode will
not be accepted.

» Single Modulo 10
» Double Modulo 10
» Modulo 11 & 10

Single Modulo
10
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Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

> Last digit not transmitted

Both digits
transmitted

» Both digits transmitted
» Both digits not transmitted
Select Length » One or two fixed lengths 1-127
> Range
Plessey Disable
Convert to UK Plessey |When applied, each occurrence of the character "A" in the [No
barcode data will be replaced by the character "X".
Transmit Check Digit Decide whether to include the two check digits in the data |Yes
being transmitted.
Telepen Disable
Original Telepen The original Telepen includes numeric characters. No
(Numeric)
AIM Telepen (Full AIM Telepen (Full ASCII) includes all the alphanumeric and | Yes
ASCII) special characters.
GS1 Databar Disable

GS1 DataBar is short for GS1 DataBar Omnidirectional. This group consists of (1) GS1 DataBar
Omnidirectional, (2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and (4) GS1 DataBar
Stacked Omnidirectional.

Transmit Code ID Decide whether to include Code ID (*]e0") will be included |Yes
in the data being transmitted.
Transmit Application Decide whether to include the Application ID ("01") in the |Yes
ID data being transmitted.
Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
GS1 Databar Limited Disable
Transmit Code ID Refer to GS1 Databar. Yes
Transmit Application Refer to GS1 Databar. Yes
ID
Transmit Check Digit Refer to GS1 Databar. Yes
GS1 Databar Expanded Disable

This group consists of (1) GS1 DataBar Expanded, and (2) GS1 DataBar Expanded Stacked.

Transmit Code ID Refer to GS1 Databar. Yes
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the |No

next processing will follow the settings configured for
EAN-13.

> After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
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Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.

Addon 2 / Addon 5 Decide whether to decode EAN-8 with addons. No

EAN-13 /7 UPC-A Enable

ISBN Conversion The EAN-13 barcode starting with 978 and 979 will be No
converted to ISBN.

ISSN Conversion The EAN-13 barcode starting with 977 will be converted to |No

ISSN.

Transmit Check Digit Decide whether to include the check digit in the data being | Yes
transmitted.
(UPC-A) Transmit Decide whether to include the UPC-A System Number in Yes
System Number the data being transmitted.
(UPC-A) Transmit Decide whether to include the UPC-A check digit in the Yes
Check Digit data being transmitted.
(UPC-A) Convert to The UPC-A barcode will be expanded into EAN-13, and the |Yes
EAN-13 next processing will follow the settings configured for
EAN-13.

> After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).

GTIN for EAN-13 The EAN-13 barcode will be expanded into 14-digit Global |No
Trade Item Number (GTIN).
Addon 2 / Addon 5 Decide whether to decode EAN-13/UPC-A with addons. No
UPC-E Enable
Convert to UPC-A The UPC-E barcode will be expanded into UPC-A, and the No
next processing will follow the settings configured for
UPC-A.

> After conversion, the data follows UPC-A format and is
affected by UPC-A programming selections (e.g.
System Number, Check Digit).

Transmit System Decide whether to include the UPC-E System Number in No

Number the data being transmitted.

Transmit Check Digit Decide whether to include the UPC-E check digit in the Yes
data being transmitted.

Enable UPC-E1 Decide whether to decode both UPC-EO and UPC-E1 No
barcodes.

» By default, it decodes the UPC-EO barcodes only.

Enable UPC-E1 Triple Decide whether to apply read redundancy to the UPC-E1 No
Check barcode.

» When applied, the same UPC-E1 barcode has to be
read three times to make a valid reading. This is
helpful when the barcode is defaced and requires more
attempts to read it successfully.

Addon 2 / Addon 5 Decide whether to decode UPC-E with addons. No
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Appendix IV
2D SCAN ENGINE

The tables below list reader settings as well as symbology settings for the 2D scan
engine.

READER SETTINGS TABLE

2D Engine Description Default
Scan Mode Laser mode
Continuous Mode Non-stop scanning

> To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode Non-stop scanning

» Capable of decoding the same barcode repeatedly

Alternate Mode Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.

» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.

Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Decode Illlumination [Decide whether to flash illumination on every barcode Oon
capture to aid decoding.

» Turn On (Internal LED)
» Turn Off

Aiming Pattern Decide whether to project the aiming pattern during Oon
barcode capture.

» Turn On
>  Turn Off
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Time-out 3 sec.

0~255 (second) Set the maximum time for decoding to continue during a scan attempt.
It applies to the following scan modes only —

» Aiming mode

» Laser mode

» Auto Off mode

Aiming Duration 3 sec.

1—-255 (second) Set the maximum time for decoding to continue during a scan attempt.

> It applies to Aiming mode only.

Picklist Mode Picklist mode enables the decoder to decode only barcodes | Disable
aligned under the center of the laser aiming pattern.
> Enable
> Disable

1D Inverse Decode 1D Inverse Decoder: Decode

regular 1D

» Decode regular 1D barcode only barcode only

» Decode inverse 1D barcode only

» Decode both regular and inverse

Note: Scan Mode options, Decode Illumination, Aiming Pattern, Aiming Duration, Picklist
Mode and 1D Inverse Decoding are supported on 2D scan engine for
8200/8400/8600/8700 only.
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SYMBOLOGY SETTINGS TABLE

1D SYMBOLOGIES
2D Engine Description Default
Codabar Enable
Transmit Start/Stop Decide whether to include the start/stop characters in the |No
Character data being transmitted.
Select Length > Any Length Any Length
> One or two fixed lengths
» Range (1—-55)
Code 128 Enable
GS1-128 Enable
Replace Field Decide whether to replace the field separator. If the No
Separator barcode contains Field Separator “0x1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“0Ox1D”, it will be changed to “;”.
ISBT 128 Enable
Industrial 25 (Discrete 25) Enable
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1—-55)
Interleaved 25 Enable
Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the No
following requirements are met:
» The barcode must have a leading 0 and a valid EAN-13
check digit.
Verify Check Digit Decide whether to verify the check digit. If desired, select |No
one of the algorithms below. If the check digit is incorrect,
the barcode will not be accepted.
> No
P USS algorithm
» OPCC algorithm
Transmit Check Digit Decide whether to include the check digit in the data being | No
transmitted.
Select Length > Any Length Any Length

» One or two fixed lengths
» Range (1-55)
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Matrix 25 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | No
transmitted.
Select Length » Any Length Any Length
» One or two fixed lengths
> Range (1-55)
Chinese 25 Disable

Note: Matrix 25 and Chinese 25 are supported on 2D scan

engine for

8200/8400/8600/8700.
Code 39 Enable
Convert to Code 32 Convert to Italian Pharmacode. No
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being | No
transmitted.
» "Verify Check Digit" must be enabled so that the check
digit can be left out (= "Transmit Check Digit"
disabled).
Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and Disable
special characters.
Trioptic Code 39 Decide whether to decode Trioptic Code 39. Disable
» Trioptic Code 39 is a variant of Code 39 used in the
marking of computer tape cartridges. It always
contains six characters.
Select Length > Any Length Any Length
One or two fixed lengths
Range (1—55)
Code 93 Enable
Select Length Any Length Any Length
One or two fixed lengths
» Range (1-55)
MSI Disable

Verify Check Digit

If Two Check Digits option is selected, an additional
verification is required to ensure integrity. Select one of
the algorithms below. If the check digit is incorrect, the
barcode will not be accepted.

Single Modulo
10
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Check Digit Algorithm
One Check Digit Single Modulo 10
Two Check Digits » Mod 10/Mod 11
» Mod 10/Mod 10
Transmit Check Digit Decide whether to include the check digit in the data being | No
transmitted.
Select Length » Any Length Any Length
» One or two fixed lengths
» Range (1-55)
GS1 Databar -
GS1 Databar-14 GS1 DataBar-14 is short for GS1 DataBar Omnidirectional. |Enable
This group consists of (1) GS1 DataBar Omnidirectional,
(2) GS1 DataBar Truncated, (3) GS1 DataBar Stacked, and
(4) GS1 DataBar Stacked Omnidirectional.
GS1 Databar Limited Enable
GS1 Databar Expanded | This group consists of (1) GS1 DataBar Expanded, and (2) [Enable
GS1 DataBar Expanded Stacked.
Convert RSS to "Convert to UPC/EAN" only applies to GS1 Databar-14 and [No
UPC/EAN GS1 Databar Limited barcodes not decoded as part of a
Composite barcode.
Convert to EAN-13
Strip the leading "010" from barcodes.
» "01" is the Application ID and must be followed by a
single zero (the first digit encoded)
Convert to UPC-A
Strip the leading "0100" from barcodes.
> "01" is the Application ID and must be followed by
two or more zeros (but not six zeros)
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the [No
next processing will follow the settings configured for
EAN-13.
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
EAN-13 Enable
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Bookland EAN The EAN-13 barcode starting with 978 will be converted to |No
(= Bookland ISBN-10) ISBN.
> Data starting with 979 is not considered Bookland in
this mode.
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Bookland ISBN-13

Barcode data, starting with either 978 or 979, will be
reported in 13-digit format to meet the 2007 ISBN-13
protocol.

No

Note: Bookland ISBN-13 is supported on 2D scan engine for 8200/8400/8600/8700.

UPC-A Enable
Transmit Check Digit Decide whether to include the UPC-A check digit in the Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-A preamble System System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to EAN-13 The UPC-A barcode will be expanded into EAN-13, and the [No
next processing will follow the settings configured for
EAN-13.
» After conversion, the data follows EAN-13 format and
is affected by EAN-13 programming selections (e.g.
Check Digit).
UPC-E (= UPC-EO) Enable
Transmit Check Digit Decide whether to include the UPC-EO check digit in the Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-EO preamble System System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-EO barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
UPC-E1 Disable
Transmit Check Digit Decide whether to include the UPC-E1 check digit in the Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-E1 preamble System System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the |No
next processing will follow the settings configured for
UPC-A.
UCC Coupon Extended Code Disable

Read UPC-A barcodes starting with digit "5", EAN-13 barcodes starting with digits "99", and
UPC-A/GS1-128 Coupon Codes.

) UPC-A, EAN-13, and GS1-128 must be enabled first!

UPC/EAN Addon
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Addon 2 / Addon 5 Decide whether to decode EAN-8, EAN-13, UPC-EO, Ignore...

UPC-E1, UPC-A with addons.

» Ignore Addons

» Decode Only With Addons

> Decode With Addons (= Auto-discriminate)
Code 11 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit |No

is incorrect, the barcode will not be accepted.

» No verification

> One Check Digit

» Two Check Digits
Select Length » Any Length Any Length

» One or two fixed lengths

> Range (1-55)
Postal Codes -—-
US Postnet Enable
US Planet Enable
Transmit US Postal US Postnet or US Planet must be enabled first! Enable
Check Digit
UK Postal Enable
Transmit UK Postal UK Postal must be enabled first! Enable
Check Digit
Japan Postal Enable
Australian Postal Enable
Dutch Postal Enable
UPU FICS Postal Disable
USPS 4CB/One Code/ Disable

Intelligent Mail

Note: UPU FICS Postal and USPS 4CB/One Code/Intelligent Mail are supported on 2D
scan engine for 8200/8400/8600/8700 only.

Composite Codes

Composite CC-C Disable
Composite CC-A/B Disable
Composite TLC-39 Enable
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GS1-128 Emulation Transmit UCC/EAN Composite Code data as if it was Disable
Mode for UCC/EAN encoded in GS1-128 barcodes.
Composite Codes
UPC Composite Mode UPC barcodes can be "linked" with a 2D barcode during UPC Always

transmission as if they were one barcode. Linked

UPC Never Linked

Transmit UPC barcodes regardless of whether a 2D

barcode is detected.

UPC Always Linked

Transmit UPC barcodes and the 2D portion. If the 2D

portion is not detected, the UPC barcode will not be

transmitted.

) CC-A/B or CC-C must be enabled!

Auto-discriminate UPC Composites

Transmit UPC barcodes as well as the 2D portion if

present.
2D SYMBOLOGIES
2D Engine Description Default
2D Symbologies -
PDF417 Enable
MicroPDF417 Enable
Data Matrix Enable
Data Matrix Inverse Decide whether to decode Data Matrix Inverse. Regular Only

Regular Only

Decode regular Data Matrix barcodes only.

Inverse Only

Decode inverse Data Matrix barcodes only.

Inverse Autodetect

Decode both regular and inverse Data Matrix barcodes.
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Mirror Image (for Data |Decide whether to decode mirror image Data Matrix Never
Matrix) barcodes.

Never

Do not decode Data Matrix barcodes that are mirror

images.

Always

Decode only Data Matrix barcodes that are mirror

images.

Auto

Decode both mirrored and unmirrored Data Matrix

barcodes.
Maxicode Enable
QR Code Enable
QR Code Inverse Decide whether to decode QR Code Inverse. Regular Only

Regular Only

Decode regular QR Code only.

Inverse Only

Decode inverse QR Code only.

Inverse Autodetect

Decode both regular and inverse QR Code.
MicroQR Enable
Aztec Enable
Aztec Inverse Decide whether to decode Aztec Inverse. Regular Only

Regular Only

Decode regular Aztec barcodes only.

Inverse Only

Decode inverse Aztec barcodes only.

Inverse Autodetect

Decode both regular and inverse Aztec barcodes.

Note: Data Matrix Mirror, MicroQR, Aztec, and 2D Inverse are supported on 2D scan
engine for 8200/8400/8600/8700 only.
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2D Symbologies - Macro PDF —

Macro PDF is a special feature for concatenating multiple PDF barcodes into one file, known as
Macro PDF417 or Macro MicroPDF417.

Transmit/Decode Mode | Decide how to handle Macro PDF decoding. Passthrough
All Symbols

Buffer All Symbols / Transmit Macro PDF When Complete

Transmit all decoded data from an entire Macro PDF
sequence only when the entire sequence is scanned and
decoded. If the decoded data exceeds the limit of 50
symbols, no transmission because the entire sequence
was not scanned!

Transmit Any Symbol in Set / No Particular Order

Transmit data from each Macro PDF symbol as decoded,
regardless of the sequence.

Passthrough All Symbols

Transmit and decode all Macro PDF symbols and
perform no processing. In this mode, the host is
responsible for detecting and parsing the Macro PDF
sequences.

ESC Characters When enabled, it uses the backslash "\" as an Escape None
character for systems that can process transmissions
containing special data sequences. It will format special
data according to the Global Label Identifier (GLI)
protocol, which only affects the data portion of a Macro
PDF symbol transmission. The Control Header, if enabled,
is always sent with GLI formatting.

Note: When printing barcodes, keep each Macro PDF sequence separate, as each has a
unique identifier. Do not mix barcodes from several Macro PDF sequences, even if
they encode the same data. When you scan Macro PDF sequences, scan the entire
Macro PDF sequence without interruption!
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Appendix V

This is intended for users who are experienced in command line use. You may issue a
command or run a script for executing any of the following utilities:

Shortcut Name of Utility = Program Name

Usage

DLookup

Prog_Load

AG_Load

Data_Read

DLookup.exe

ProgLoad.exe

AG_Load.exe

Data_Read.exe

To download associated lookup file(s) to the mobile
computer

To download the AG runtime or font file (.SHX) to
the mobile computer.

To download the current application template to the
mobile computer.

To receive data via Data_Read utility. It also
synchronizes date/time on every host connection.
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DOWNLOAD UTILITIES

DLOOKUP

Command Line Syntax

You can use the command line to download the lookup file as well. At the command line prompt,
use the following command line arguments:

DLookup <File name>,<COM port>,<Baud rate>,<Download via>,<Show message box>

Argument

Each argument is explained in the table below. If command line arguments are not given, you may
select the appropriate parameters from the dialog box that pops up.

Argument Description

File name Max length: 256 bytes
Full-path file name is required when file is not in the current working
directory.

COM port Range: 1-255
It is set to 1 by default in the utility program.

Baud rate Range: 1-5

Download via

Show message box

Example

It is set to 1 by default in the utility program.
P 1: 115200  bps

> 2: 57600 bps

> 3: 38400 bps

> 4: 19200 bps

» 5: 9600 bps
Range: 1-3

It is set to 1 by default in the utility program.
» 1: RS-232or IrDA
> 2: Cradle-IR
» 3: Modem

Range: 0—~1

It is set to 1 by default in the utility program.
» 0: Disable
» 1: Enable

DLookup DEMO_LOOKUP.TXT,1,1,1,0
// COM 1, 115200 bps, RS-232/1rDA, Do not show message
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PROGLOAD

Command Line Syntax

You can use the command line to download a program file as well. At the command line prompt,
use the following command line arguments:

ProgLoad <File name>,<Download via>,<COM port>,<Baud rate>,<File type>,

<Operation mode>

Argument

Each argument is explained in the table below. If command line arguments are not given, you may
select the appropriate parameters from the dialog box that pops up.

Argument Description

File name Max length: 256 bytes
Full-path file name is required when file is not in the current working
directory.

Download via Range: 1-3

It is set to 1 by default in the utility program.
» 1: RS-232or IrDA
» 2: Cradle-IR
> 3: TCP/IP
COM port COM port: 1—-255
It is set to 1 by default in the utility program.
TCP port: 1~65535
It is set to 3000 by default in the utility program.
Baud rate Range: 1-5
It is set to 1 by default in the utility program.
P 1: 115200 bps

> 2: 57600 bps

> 3: 38400 bps

> 4: 19200 bps

> 5: 9600 bps
File type Range: 0—2

It is set to O by default in the utility program.
P 0O: .SHXfile
P 1: _.SYNfile
> 2: _.BINfile
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Operation mode Range: 0—~1
It is set to O by default in the utility program.
» 0: Show property settings for confirmation before download

P 1: Auto download file

Example

ProgLoad C:\U8400.shx,1,1,1,0,1
// RS-232/1rDA, COM 1, 115200 bps, .SHX, Auto download file

AG_LOAD

Command Line Syntax

You can use the command line to download the current application template to the mobile
computer. At the command line prompt, use the following command line arguments:

AG_Load <File name>,<COM port>,<Baud rate>,<Download via>,<File Type>,<Show
dialog>,<Show Progress dialog>

Argument
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Each argument is explained in the table below. If command line arguments are not given, you may
select the appropriate parameters from the dialog box that pops up.

Argument Description

File name Max length: 256 bytes
Full-path file name is required when file is not in the current working
directory.

COM port Range: 1-255
It is set to 1 by default in the utility program.

Baud rate Range: 1-5

Download via

File Type

Show dialog

Show progress dialog

Example

It is set to 1 by default in the utility program.
P 1: 115200 bps

> 2: 57600 bps

> 3: 38400 bps

> 4: 19200 bps

> 5: 9600 bps
Range: 1-3

It is set to 1 by default in the utility program.
> 1: RS-232/IrDA/USB VCOM
» 2: Cradle-IR
> 3: Modem

Range: 1-3

It is set to 1 by default in the utility program.

P 1: AGKX file

P 2:  ATXfile

P 3: ATFfile
Range: 0—1

It is set to 1 by default in the utility program.

» 0: Disable
» 1: Enable

Range: 0—~1

It is set to 1 by default in the utility program.

» 0: Disable
» 1: Enable

AG_Load AT8600.AGX,1,1,1,1,0

// COM 1, 115200 bps, RS-232/1rDA/USB VCOM, .AGX, Display the dialog box, Do not display
the progress dialog box
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UPLOAD UTILITIES

DATA_READ

Command Line Syntax

Upload the lookup file on the mobile computer to PC. At the command line prompt, use the
following command line arguments:

Data_Read <File name>,<Upload via>,<COM Port>,<Baud rate>,<Save mode>,
<Add CR character>,<Add LF character>,<Write Log>,<Show data>,
<Show dialog>,<Keep online>,<Polling time>,<Inter-Char delay>,
<Auto transfer data>,<Auto upload data file>,<Auto upload lookup file>,
<Auto delete data file>,<Auto delete lookup file>,<File rule>,
<Auto upload data from>,<Auto upload data to>,<Auto upload lookup from>,

<Auto upload lookup to>,<Show Progress dialog>
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Each argument is explained in the table below. If command line arguments are not given, you may
select the appropriate parameters from the dialog box that pops up.

Argument Description
File name Max length: 256 bytes
Full-path file name is required when file is not in the current working
directory.
Upload via Range: 1—4
It is set to 1 by default in the utility program.
» 1 (R) : RS-232/IrDA/USB VCOM
» 2 () : Cradle-IR
» 3 (T) : Modem-TAPI
> 4 (M) : Modem-COM
COM port Range: 1-255

It is set to 1 by default in the utility program.

Baud rate Range: 1-5

It is set to 1 by default in the utility program.

4

v v Vv Wwv

Save mode Range

(115200) : 115200 bps

(57600) : 57600 bps

(38400) : 38400  bps

(19200) : 19200 bps

( 9600) : 9600  bps
:1-5

It is set to 1 by default in the utility program.

> 1: Overwrite
> 2: Append
> 3: Keyboard emulation
> 4: Auto file name
> 5: Auto append
Add CR character Range: 0~1

It is set to 1 by default in the utility program.
» 0O: Disable
» 1: Enable
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Add LF character Range: 0~1
It is set to 1 by default in the utility program.
» 0O: Disable
» 1: Enable
Write log Range: 0—~1
It is set to O by default in the utility program.
» O: Error message displayed in the dialog

> 1: Create a log file to write error message

Show data Range: 0—~1
It is set to 1 by default in the utility program.
» 0: Disable

» 1: Display the received data after transmission

Show dialog Range: 0~1
It is set to 1 by default in the utility program.
» O: Disable
» 1: Display the main form
Keep online Range: 0~1
It is set to 1 by default in the utility program.
» 0: Break the connection after transmission

» 1: Enable

Polling time Range: 1—999 sec (It is set to 2 by default in the utility program.)
Inter-Char delay Range: 0—255 ms (It is set to 2 by default in the utility program.)
Auto transfer data Range: 0~1

It is set to O by default in the utility program.
» 0O: Disable

» 1: Enable auto transfer data. When enabled, at least
one argument (Auto upload data file, Auto upload
lookup file, Auto delete data file, or Auto delete
lookup file) has to be set to 1.

Auto upload data file Range: 0—~1
It is set to O by default in the utility program.
» 0O: Disable
» 1: Enable
Auto upload lookup file Range: 0—~1
It is set to O by default in the utility program.
» 0: Disable
» 1: Enable
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Auto delete data file

Auto delete lookup file

File rule

Auto upload data from

Auto upload data to

Auto upload lookup

from

Auto upload lookup to

Show Progress Dialog

Example

Appendix V. Command Line Syntax

Range: 0—1

It is set to O by default in the utility program.
» 0: Disable
» 1: Enable

Range: 0—~1

It is set to O by default in the utility program.
» 0: Disable
> 1: Enable

Range: 1-3

It is set to 1 by default in the utility program. When this value is set to
1 or 2, the <File Name=> value will be ignored.

P 1: Generated automatically
P 2: Generated according to the first record
» 3: Customized

Range: 0—9

Set to O by default. This value must be less than <Auto upload data
to>.

Range: 0—9

Set to 9 by default. This value must be larger than <Auto upload data
from>. If not, this value will be set to <Auto upload data from=.

Range: 0—2

Set to 0 by default. This value must be less than <Auto upload lookup
to>.

Range: 0—~2

Set to 2 by default. This value must be larger than <Auto upload
lookup from=>. If not, this value will be set to <Auto upload lookup
from>.

Range: 0—~1
It is set to 1 by default in the utility program.
» 0: Disable (<Keep online> will also be disabled)

» 1: Enable to show the progress dialog box

Data_Read DataFile_1.TXT,1,1,1,1,1,1,1,1,0,1,2,0,1,1,1,1,1,1,0,9,0,2,1

// RS-232/1rDA, COM 1, 115200 bps, Overwrite, Add CR, Add LF, Create a log file to write
error message, Showdata, Hidedialogbox, Keeponline, Polling time 2 seconds, No Inter-Char
delay, Auto transfer data, Auto upload data files, Auto upload lookup files, Auto delete
data files, Auto delete lookup files, Auto generate file name rule, Auto upload data
from data file 1, Auto upload data to data file 10, Auto upload lookup file from lookup
file 1, Auto upload lookup file to lookup file 3, Display the progress dialog box
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Appendix VI
CREATING A SCRIPT FILE

If connection arguments (ServerlP, TCPport, Username, and Password) are passed to the DoFTP
function (please refer to the C Programming Guide Part Il for further details about DoFTP), the
script file is run with the received arguments to establish an FTP session and then send/receive
files.

If no arguments received, the DoFTP function will run the script file accordingly to establish an FTP
session and transfer files.

The script must be saved to the file FTP.dat in the following format.

File Name

FTP.dat J*
** The file name “FTP.dat” is reserved for the
** script file. Do not use it with “rFile=" or
** “tFile=". Because it is hard-coded, the file
** name must be uppercase while the file
** extension must be lowercase.
*/

Format

ServerlP=

TCPport=

Username=

Password=

UpdateScript,<Version control>,<Mandatory>
rFile=<Local file namel>,<Remote file name>,<Version control>,<Mandatory>
rFile=<Local file name2>,<Remote file name>,<Version control>,<Mandatory>

rFile=<Local file name3>,<Remote file name>,<Version control>,<Mandatory>

tFile=<Local file nameX>,<Remote file name>,0,<Mandatory>

rFile=<Local file namelO>,<Remote file name>,<Version control>,<Mandatory>

Line Default ' Description

ServerlP= Null IP address of FTP server
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TCPport=

Username=
Password=

UpdateScript, ...

rFile=

176

Null

Null
Null
Null

Null

Remote port number

»

By default, TCP port 21 is used on the server for the
control connection.

User name for logging onto FTP server

Password for logging onto FTP server

“UpdateScript, (1/0)” is required for checking updates to
the script file, with given version control. This line must be
run before transmitting or receiving files.

»

If a different server is specified, it will connect to the
new server in the next connection.

If you need to switch to a different server immediately,
use the SWITCH command.

Receive a specific file with given version control

4

Local file name: It's case-sensitive. File extension
omitted is allowed.

Remote file name: It must follow the rules of the file
system used by FTP server. Wild card is supported.

User program update is allowed when the file name is
prefixed with the character “~”. Also, version control
will be ignored.




tFile=

Example

Appendix VI Command Line Syntax

Null Transmit a specific file with version control set off

» local file name: > Whether including file
extension or not, a local
file name must not
exceed 8 characters and
must be case-sensitive.

> remote file » Such name must follow
name: the remote FTP server’s
file system’s rules. Wild

card is supported.

» Version control must be set to O.

Delete a specific file from the FTP server

» The first parameter must be ignored.

> remote file » Such name must follow
name: the FTP server's file
system’s rule. Wild card is

supported.

» Version control must be set to -1.

Rename a specific file on the FTP server

> new file » The file name to replace the
name: old one.
» old file name » The file name to be replaced

by the new one.

» Version control must be set to -2.
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ServerlP=192.168.17.6
TCPport=21

Username=test4669

Password=1234 - - - -
Check whether new script file is available.

UpdateScript,1,M €———— When there is no script file on the server, stop
running script.

rFile=Rcvl.txt,Lookupl.txt,0,

rFile=Rcv2.txt,Lookup2.txt,1,

rFile=Rcv3.txt,Lookup3.txt,1,

tFile=A:/TestFile,Txac,O,

tFile=Sendl,Txac_test,O,
rFile=Sendl,Txac_test,-1,

/* Upload and delete the file. Remote file name is ignored */

tFile=,Lookup4.txt,-1,
/* deletes the Lookup4.txt from the FTP server */

tFile=Lookup6,Lookup5,-2,
/* renames the Lookup5 on the FTP server to ‘“Lookup6” */

Note: Access to SD card is allowed; however, file name is not case-sensitive. Although
file name may be case-sensitive on remote host, for use with SD card, it is
suggested to avoid using letter case for identifying two files with identical file
name, such as “AAA.txt” and “aaa.txt”.

REMOTE FILE INFORMATION
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Upon completion of executing DoFTP() but before closing the connection, it will
automatically save remote file information to the file DIRList on the mobile computer.
Such up-to-date information lists file entries in the default working directory.

File Entry Format

Each entry is saved in the following format: YYYYMMDDhhmmss<file name>(0x0d)
It consists of
14 digits for the time when each file is created on the server.

A file name, which is case-sensitive and can be made up of 8 characters at most, with or without
file extension included. For example, “TestFile” and “Svrl.txt” are considered acceptable.

You may use FTPRecv() to save the remote file information to another file, whose file
entry format depends on where it is saved to. For example,

FTPRecv((S8 *)"FileList”, (S8 *)", (S8 *)");
/* Save to SRAM, file name is case-sensitive */
FTPRecv((char *)"A:\\FileList", (88 *)"", (88 *)™");

/* access to SD is allowed, file name is NOT case-sensitive */

LOCAL FILE INFORMATION

Upon completion of downloading a file via DoFTP(), it will automatically add or update
the entry to the file RCVList on the mobile computer.

File Entry Format

Each entry is saved in the following format:
YYYYMMDDhhmmss<file name>YYYYMMDDhhmmss(0x0d)

It consists of
14 digits for the time when each file is created on the server.

A file name, which is case-sensitive and can be made up of 8 characters at most, with or without
file extension included. For example, “TestFile” and “Rcvl.txt” are considered acceptable.

14 digits for the time when each file is downloaded to the mobile computer.

Access to SD card is allowed. The entry in the file RCVList is in full path. For example,
YYYYMMDDhhmmssA:/FTP/Test/8X00.TXTYYYYMMDDhhmmss (0x0d)

YYYYMMDDhhmmssA:/FTP/Test/8X00.TXT00000000000000(0x0d)

VERSION CONTROL
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Version control only takes effect when the following two conditions are satisfied:

» The mobile compueter has started an FTP session via DoFTP() over network.
» The script line must start with “rFile=" or “UpdateScript”.

Version Control Description

0 Disable version control

For the lines starting with “tFile=", version control must be set to O.
1 Enable version control

Checks the local file information against the remote file information.

For the lines starting with “rFile=", if no existing file is found or the file is
not recorded in the file RCVList on the mobile computer, the version control
is ignored and the specified files are received.

For the lines starting with “UpdateScript”, if no existing script file is found
on the mobile computer, version control is ignored and the specified files
are received.

-1 rFile:
Deletes files from the mobile computer

For the lines starting with “rFile=" only. Any specified remote file name
will be ignored.

The entry saved in the file RCVList will be modified:
from YYYYMMDDhhmmss<file name>YYYYMMDDhhmmss(0x0d)
to YYYYMMDDhhmmss<file name>00000000000000(0x0d)
tFile:
Deletes files from the FTP server
any specified local file name will be ignored.

-2 Renames the files on the FTP server

For the lines starting with “tFile=" only.

MANDATORY FLAG

The flag is used to set a breakpoint. While running script, it may stop at a line with such
flag if it fails to transmit or receive the file. For example,

UpdateScript,1,M
tFile=Test.txt,SvrTest.txt,0,M

UPDATE SCRIPT FILE
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“UpdateScript, (1/0)” is required for checking any update to the script file. This line
must be run before transmitting or receiving files.

Format
The line must be “UpdateScript, (1/0),<Mandatory>".

When new script file is available, it will first update the script file, and then run the lines
in the new script file to transmit or receive files, as shown below.

Current Script MNew Script

1 ServerIP=192.163.17.6 ServerIP=192.163.1.1
TCPport=21 TCPport=21
Uaername=test4446% Uaername=test4469
Pagaword=1234 Pagaword=1234

—
( 2 rpdateﬂcript,l,h'l x UpdateScript, 1,

SWITCH rFile=Rcvd.txt,Svrd.txt, 0,
rFile=Rcvl.txt,5vrl.txc, 0, O rFile=Rcv3.txt,Svr5.txt, 1,
rFile=Rcvié.txt,Svré.txt, 1, rFile=Rcvé.txt,Svre.txt, 1,

rFile=Rcv3.txt,Svr3.txt,1,
tFile=TeatFile, Svr50.txt, 0,
tFile=TestFile,SvrZl.txt, 0, rFile=TeatFile, Svreld.txt,-1,

rFile=TestFile,Svrii.txt,-1,

Note: If a different server is specified in the new script, it will connect to the new server
in the next connection. If you need to switch to a different server immediately, use
the SWITCH command.

UPDATE USER PROGRAM
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Program update is allowed via DoFTP() when a user program (.bin) is properly specified
in the script file. Upon completion of executing DoFTP(), it will automatically update the
program.

Format

The line must be as shown below:

rFile=~<Local file name>,<Remote file name>,<version control>,<Mandatory>

For example,
rFile=~CipherAP,NewAP,0,

/* Save to SRAM, local file name is case-sensitive */
rFile=~A:/FTP/user.bin,NewAP,O,

/* Local file name is NOT case-sensitive */

On the right of the equal sign, it consists of
The character “~”.

A file name, which is case-sensitive and can be made up of 8 characters at most, with file
extension included. For example, “CipherAP” and “User.bin” are considered acceptable.

Version control; however, it will be ignored.

SWITCH TO A DIFFERENT SERVER

The “SWITCH” command is supported for immediate switching to a different server
specified in the new script file. This line must be run after the connection settings and
“UpdateScript”.

Format

The line must be “SWITCH”, all in uppercase.

When new script file is available, it will first update the script file, and then compare
whether the connection settings between the original script and the update are the same.

» When server IP or username is found different, it will disconnect the current

connection immediately, and use the updated connection settings to establish a new
connection.

» In the new connection, the “UpdateScript” line will not be executed until it connects
to the new server in the next connection.

» If it fails to execute the “SWITCH” command, it will stop executing the rest of lines
after “SWITCH”.

» If there is more than one “SWITCH” line, only the first one will be executed.
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Current Script

ServerIP=192.163.17.6
TCPport=21
Username=testdgea9

Pasaword=1234

SWITCH
rFile=Rcvl.txt,Svrl.txt, 0,
rFile=RcvZ.txt,Svri.txt, 1,

rFile=Rcv3.txt,Svr3.txt, 1,

tFile=TestFile,Svril.txt,0,

rFile=TestFile,SvriZ.txt,-1,

rFile=TestFile,Svreld.txt,-1,

Appendix VI Command Line Syntax
MNew Script
ServerIP=192.163.1.1 €
TCPport=21 5
Username=test4669 L!)
Pagaword=1234 >
\ UpdateScript, 1,

rFile=Rcvd.txt,Svrd.txt, 0,

@ rFile=Rcv5.txt, SvrS.txt, 1,
rFile=Rcvé.txt,Svre.txt, 1,

V-

(4 i SWITCH -

tFile=TestFile, Svr50.txt, 0, -;’

WILDCARDS FOR REMOTE FILE NAME

Wildcard characters are supported for distinguishing the files transmitted from the mobile
computer to the FTP server.

v v Vv Vv

does not exceed 256 characters.

Only valid for remote file names
Can be inserted to any place in the file name

Can be applied multiple times and in combinations, as long as the actual file name
If the file name becomes too long, it will be

Start with a “%” character, followed by a capital letter: %T, %N or %l

truncated automatically. If it comes with a file extension, this will result in leaving it

out.

Three wildcards are supported for remote file names:

%T

Use “%T” to insert device system time (14 characters) to file name of the files transmitted to the

server.

%N

Use “%N” to insert device serial number (9 characters by factory default) to file name of the files

transmitted to the server.

%l
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Use “%l1” to insert user-specified string (max. 16 characters) to file name of the files transmitted
to the server.

Example

tFile=test, test®%T.txt,0,M /* Remote file name, ex. test20000111061852.txt */
tFile=test, test%l .txt,0,M /* Remote file name, ex. testCipherlab.txt */
tFile=test, test%N.txt,0,M /* Remote file name, ex. testDB9001999.txt */

tFile=test, testyN+%I1+%T.txt,0, /* Ex. testDB9001999+Cipherlab+20000111061905.txt */
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